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About This Guide

The OpenText Vibe 4 Installation Guide covers the installation and configuration of OpenText Vibe. 
The guide is divided into the following sections:

 Part I, “Overview of Vibe,” on page 13
 Part II, “System Requirements and Support,” on page 21
 Part III, “Single-server (Basic) Installation,” on page 33
 Part IV, “Advanced Installation and Reconfiguration,” on page 97
 Part V, “Multi-Server Configurations and Clustering,” on page 133
 Part VI, “Upgrade,” on page 175
 Part VII, “Migrate,” on page 213
 Part VIII, “Appendixes,” on page 225

Audience
This guide is intended for OpenText Vibe administrators.

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the comment on this topic feature at the bottom of each page 
of the online documentation.

Documentation Updates
For the most recent version of this manual, visit the OpenText Vibe 4 Documentation website (http:/
/www.novell.com/documentation/vibe4). 

Additional Documentation
You can find more information in the OpenText Vibe 4 Documentation, which is accessible from the 
Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4). 

To access the OpenText Vibe User Guide from within Vibe, click the Settings icon, then click Help.
About This Guide 11
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I IOverview of Vibe

OpenText Vibe is an enterprise collaboration tool designed to increase individual productivity, team 
effectiveness, and organizational success by providing the right set of tools to the right people.

 Chapter 1, “Vibe’s User Types,” on page 15
 Chapter 2, “Vibe’s Service Components,” on page 17
 Chapter 3, “Topology of Vibe Deployment Options,” on page 19
Overview of Vibe 13
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1 1Vibe’s User Types

OpenText Vibe users fall into three basic groups:

Content Consumers
Content consumers use OpenText Vibe to work with important information that pertains to them. 
Content consumers:

 Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files, 
Guestbook, Photo Album, and Tasks folder

 Participate in team workspaces set up for content providers, in order to better collaborate with 
colleagues and facilitate their work assignments

 Search the Vibe site for people, places, and other information that pertains to their personal 
work assignments

 Identify subject-matter experts to assist them in their personal work assignments 

The typical tasks performed by content consumers are covered in the OpenText Vibe 4.0.8 User 
Guide.

In many cases, content consumers quickly become content providers.

Content Providers
Content providers use OpenText Vibe to create and manage teams, customize the Vibe environment, 
and import data into the Vibe site for use by other Vibe users. Content providers:

 Create and manage team workspaces and folders
 Control user access to their team workspaces
 Establish unique branding for workspaces and folders to clearly differentiate them from other 

places on the Vibe site
 Create landing pages for workspaces that consolidate the most necessary workspace 

information into a single page
 Customize data entry forms for gathering information from users
 Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the OpenText Vibe 4.0.8 User Guide.

Administrators
A OpenText Vibe administrator is responsible for installing the Vibe software and setting up the Vibe 
site. This OpenText Vibe Installation Guide provides instructions for Vibe software installation. After 
installation, the Vibe site administrator can:

 Set up user access to the Vibe site
 Create initial workspaces and populate them with information that is of interest to Vibe users
Vibe’s User Types 15
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 Control user access to workspaces and folders
 Configure email integration, so that Vibe users can receive notifications of updated information 

on the Vibe site and post to the Vibe site by using email messages
 Set up mirrored folders to make large sets of data that are already available on disk more easily 

available through the Vibe site
 Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site
 Set up remote applications that deliver data from a remote location, such as a remote database, 

for easy access on your Vibe site
 Manage users, workspaces, and folders as the Vibe site grows and evolves
 Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the  OpenText Vibe 4.0.8 
Administration Guide.
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2 2Vibe’s Service Components

A OpenText Vibe site consists of four major components:

Vibe Software
The Vibe software is a customized version of Apache Tomcat. This software provides the web-based 
functionality you use as you access the Vibe site through your web browser.

SQL Database
Vibe uses an SQL-based database for storing the following information about the Vibe site and its 
users:

 Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)

 Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)

 User profile information (for example, full name, phone number, and email address)

The Vibe database disk space requirements are relatively modest, because the database is not used 
for storing files.

File Repository
The Vibe file repository holds all files that are imported into Vibe, information related to the 
imported files (such as thumbnails and HTML renderings), and the search engine index.

The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe 
site, disk space requirements can be substantial. 

Lucene Search Index
The Lucene Index Server is a high-performance Java search engine. The Lucene index contains 
pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search 
engine to perform very fast searches through large quantities of Vibe data.
Vibe’s Service Components 17
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3 3Topology of Vibe Deployment Options

You can configure OpenText Vibe to run on a single server or multiple servers, depending on the size 
and needs of your Vibe site.

For more information about which configuration type will best achieve the needs of your 
organization, see Appendix A, “Sizing and Performance Considerations,” on page 227.

For more information about how to set up these configurations, see Part V, “Multi-Server 
Configurations and Clustering,” on page 133.

Configuration Description

Single Server By default, the Vibe Installation program installs all Vibe components on the same 
server. 

Database Server For better performance and scalability, you can install the Vibe database on a remote 
server.

Lucene Index Server For better performance and scalability, you can install the Lucene index on a remote 
server.

Multiple Vibe Servers By running Vibe on multiple servers, you can achieve high availability, including 
failover and load balancing, depending on how you configure your servers.

Multiple Lucene 
Servers

Your Vibe site depends on the Lucene Index Server for full functionality. Running 
multiple Lucene Index Servers provides high availability, so that if one Lucene Index 
Server goes down, Vibe users can still access the Vibe site because other Lucene 
Index Servers are still available.

Multiple Database 
Servers

Each of the three databases supported by Vibe has its own approach to clustering 
the database server. Information about clustering database servers is available on 
the Internet.
Topology of Vibe Deployment Options 19
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II IISystem Requirements and Support

Reference these sections for information about Vibe system requirements and platform and 
environment support systems.

 Chapter 4, “Vibe System Requirements,” on page 23
 Chapter 5, “Vibe User Platform Support,” on page 27
 Chapter 6, “Environment Support,” on page 31
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4 4Vibe System Requirements

You, as a OpenText Vibe site administrator, must ensure that your system meets Vibe system 
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you 
must ensure that users’ browsers and office applications meet Vibe user requirements, so that users 
can access the Vibe site successfully.

 “Server Hardware Requirements” on page 23
 “Server Operating System Requirements” on page 23
 “Database Server Requirements” on page 24
 “Directory Service (LDAP) Requirements” on page 25
 “Disk Space Requirements” on page 26
 “Other Requirements” on page 26

Server Hardware Requirements
Your server hardware must meet the following requirements:

Server Operating System Requirements
Your server must have one of the following operating systems installed and running.

Item Requirement

Processor  x64
 Minimum 2 GHz
 Multi-CPU systems preferred

Server Memory  At least 4 GB RAM

See Appendix A, “Sizing and Performance Considerations,” on page 227 
and “Server Memory” on page 43.

Platform Requirement

Linux  OpenText Open Enterprise Server 23.4, plus the latest Support Pack 
 SUSE Linux Enterprise Server (SLES) 15, plus the latest Support Pack and 

with tk-32bit and tcl-32bit packages installed.

Recommended

 OpenText Open Enterprise Server 2023 SP1, plus the latest Support Pack Supported but 
not tested

NOTE: On SLES, the X Window System is required by the GUI Vibe installation program. However, 
it is not required for running Vibe after installation, or for text-based or silent installations.
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See “Virtualization Support” on page 31 for information about support for running Vibe in a 
virtualized environment.

Database Server Requirements
The Vibe server must have access to a database server listed below.

IMPORTANT: The database server must be online and accessible before you begin the Vibe 
installation process.

Windows  Windows Server 2022
 Windows Server 2019, plus the latest Support Pack

Recommended

 Windows Server 2016, plus the latest Support Pack Supported but 
not tested

Platform Requirement

Platform Requirement

SuSE Linux  MariaDB 10 on SLES 15
 MySQL 5.5.3 or later on SLES 11

NOTE: MySQL 8 and later has password complexity enabled by default, 
which Vibe doesn’t support. For help disabling password complexity and 
setting a non-complex password, see “Disabling Password Complexity in 
MySQL 8” on page 241.

 Oracle 12c
 PostgreSQL 14

Recommended

 MariaDB 10 on SLES 12
 Oracle 11g

Supported but 
not tested

Windows  Microsoft SQL Server 2019 on Windows Server 2019
 Microsoft SQL Server 2017 on Windows Server 2019
 Oracle 12c
 PostgreSQL 9.6, 10
 MySQL 8.0 on Windows 2019

Recommended

 MariaDB 5.5 or later server and tools
 MySQL 5.5.3 or later server and tools

NOTE: MySQL 8 and later has password complexity enabled by default, 
which Vibe doesn’t support. For help disabling password complexity and 
setting a non-complex password, see “Disabling Password Complexity in 
MySQL 8” on page 241.

 Microsoft SQL Server 2014 on Windows Server 2012 R2
 Oracle 11g
 PostgreSQL 9.4.x

Supported but 
not tested
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Directory Service (LDAP) Requirements
One of the following directory services:

Disk Space Requirements

Platform Requirement

GroupWise  GroupWise 18 Recommended

Linux  eDirectory 9 plus the latest patch for Linux Recommended

 eDirectory 8.8 plus the latest patch for Linux Supported but 
not tested

Windows  Windows Server 2022
 eDirectory 9 with the latest patch for Windows

Recommended

 Windows Server 2016
 eDirectory 8.8 with the latest patch for Windows

Supported but 
not tested

Item Requirement

Vibe software At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has free 
disk space equal to the disk space currently in use, plus an additional 500 
MB in the following area:

Linux: /var/opt/novell/teaming
Windows: c:\Program Files\Novell\Teaming

Database server software At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has free 
disk space equal to the disk space currently in use, plus an additional 500 
MB in the following area:

Linux: /var/opt/novell/teaming
Windows: c:\Program Files\Novell\Teaming

Vibe file repository Depends on the anticipated size of the Vibe site

Database content Substantially less than the Vibe file repository

See “Planning the Vibe Database” on page 51 to plan for the disk space 
needs of your Vibe site.
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Other Requirements

Requirement Additional Information

Tomcat 8 This is included with Vibe on Linux and Windows.

OpenJDK 11 This is included with Vibe on Linux and Windows.
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5 5Vibe User Platform Support

 “Browser Support” on page 27
 “Office Add-In Support” on page 27
 “Office Application WebDAV Support” on page 28
 “Collaboration Client Support” on page 28
 “Desktop Support” on page 28
 “Mobile Support” on page 29
 “File Viewer Support” on page 29

Browser Support

Office Add-In Support
Table 5-1   Desktop OS

Platform Requirement

Linux  Mozilla Firefox (latest version)

Windows  Microsoft Internet Explorer 11 (latest version) (must not have the 
Google Chrome Frame plug-in installed)

 Mozilla Firefox (latest version)
 Google Chrome (latest version)
 Microsoft Edge (latest version) (Windows 10 only)

Mac  Safari (latest version)
 Chrome (supported but not tested)
 Firefox (supported but not tested)

Platform Requirement

Linux N/A

Windows   Office 365
 Office 2019
 Office 2016 (Supported not tested)

Mac N/A
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Office Application WebDAV Support
Table 5-2   Workstation OS

Collaboration Client Support
Vibe is integrated with GroupWise 2018.

Desktop Support
You can download Windows and Mac desktop applications that let you work with Vibe files directly 
from the file system on your computer. The following operating systems are supported:

Platform Requirement

Linux  LibreOffice (latest version)
 OpenOffice (Supported but not tested)

Windows   Office 365
 Office 2019
 Office 2016 (Supported not tested)
 LibreOffice (latest version)
 OpenOffice (Supported but not tested)
 Windows 10 Drive Mapping via WebDAV Permalink

Mac  MS Office 2016 for Mac

Platform Requirement

Windows  Windows 2022 (Professional and Enterprise) Recommended

 Windows 2022 Retail (Basic, Home, Education) Supported but not 
tested

Mac  Mac OS 11 Big Sur
 Mac OSX 10.15 or later

Recommended
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Mobile Support
You can download a native application for your iPhone, iPad, Android, or BlackBerry device. These 
applications have a more polished user interface and don’t require you to sign in each time you 
access Vibe. However, the mobile app for Vibe does not store information on your device; 
information can be viewed only when you have an Internet connection. 

Other devices can access the Vibe mobile interface by using a mobile browser that meets the 
requirements listed in “Browser Requirements” on page 29.

 “App Availability” on page 29
 “Browser Requirements” on page 29

App Availability
Vibe mobile apps are available for the following mobile operating systems:

 iOS (native application is available for both the iPhone and iPad for a free download in the Apple 
App Store for iOS 13 or later)

 Android (native application is available for a free download in the Google Play App Store for 
Android 4.4 or later)

 Kindle Fire (native application is available for a free download in the Amazon Appstore for 
Android)

Your device’s browser must also meet the requirements that are discussed in Browser 
Requirements.

Browser Requirements
To access Vibe from a browser on a mobile device, your device’s browser must support the 
following: 

 HTML 4
 JavaScript

File Viewer Support
In Vibe, file viewing capabilities are provided by OpenText KeyView technology. For a list of 
supported file formats and background information on OpenText KeyView, see the “OpenText 
KeyView Filter SDK C Programming Guide.”

The file viewers also support data indexing by the Lucene Index Server.
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6 6Environment Support

 “IPV6 Support” on page 31
 “Clustering Support” on page 31
 “Virtualization Support” on page 31
 “Single Sign-On Support” on page 31
 “Linux File System Support” on page 32

IPV6 Support
OpenText Vibe supports the IPV6 protocol when it is available on the server. If the protocol is 
available, Vibe detects it and supports IPV6 by default, along with IPV4. 

Clustering Support
You can install Vibe components on multiple servers to provide failover support, as described in 
Part V, “Multi-Server Configurations and Clustering,” on page 133.

Virtualization Support
You can install Vibe in virtual environments where a software program enables one physical server 
to function as if it were two or more physical servers.

OpenText tests the Vibe software on both Xen and VMware platforms. Vibe is supported on these 
platforms, as well as other virtualization platforms, such as Microsoft Hyper-V. If you encounter an 
issue that cannot be duplicated in a OpenText test environment, you may be responsible for 
following up with the provider of your virtualization software.

For more information about virtualization support on SUSE Linux Enterprise Server, see the SLES 
Documentation website (https://www.suse.com/documentation/sles11/#additional).

For more information about VMware virtualization support, see the VMWare website (http://
www.vmware.com).

Single Sign-On Support
OpenText Access Manager can be used to provide single sign-on capabilities for your Vibe site. For 
setup instructions, see “Configuring Single Sign-On with Novell Access Manager” on page 107.
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Linux File System Support
The following file systems are supported for Vibe running on Linux:

 ext3 (recommended in most cases)

NOTE: The maximum number of file entries in a Vibe File folder cannot exceed 31,998 when 
using the ext3 file system.

 NSS (recommended if you are running OES Linux and need the feature-rich environment of NSS)
 reiser3
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III IIISingle-server (Basic) Installation

 Chapter 7, “Single-server Installation Planning Worksheet,” on page 35
 Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on page 41
 Chapter 9, “Obtaining the Vibe Software,” on page 61
 Chapter 10, “Installing and Running the Database Server,” on page 63
 Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 71
 Chapter 12, “Adding Users to Your Vibe Site,” on page 91
 Chapter 13, “Updating Your Vibe License,” on page 93
 Chapter 14, “Setting Up Vibe,” on page 95
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7 7Single-server Installation Planning 
Worksheet

We recommend that you print this section and record your planning decisions. You will then be able 
to complete your Vibe installation process more efficiently, and you’ll have a record of your Vibe 
installation for future reference.

Installation Program Field Your Setting/Choice Explanation

Vibe Server Platform: 

 Windows
 Linux

See “Vibe Server Platform” on 
page 42.

Server Memory: 

 4 GB
 8 GB
 More

See “Server Memory” on 
page 43.

Install Location: 

 Software Location

Linux default:

/opt/novell/teaming
Windows default:

c:\Program 
Files\Novell\Teaming

 Data Location
Linux default:
/var/opt/novell/teaming
Windows default:
c:\Novell\Teaming

See “Install Location” on 
page 44.
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Default Locale: 

Language (Country):

 Chinese (China) (Taiwan)
 Czech (Czech Republic)
 Danish (Denmark)
 Dutch (Belgium) (Netherlands)
 English (Australia) (Canada) 

(India) (Ireland) (New Zealand) 
(South Africa) (United States)

 Finnish (Finland)
 French (Belgium) (Canada) 

(France) (Luxembourg) 
(Switzerland)

 German (Austria) (Germany) 
(Luxembourg) (Switzerland)

 Hungarian (Hungary)
 Italian (Italy) (Switzerland)
 Japanese (Japan)
 Polish (Poland)
 Portuguese (Brazil)
 Russian (Russia)
 Spanish (Argentina) (Bolivia) 

(Chile) (Colombia) (Costa Rica) 
(Dominican Republic) (Ecuador) 
(El Salvador) (Guatemala) 
(Honduras) (Mexico) (Nicaragua) 
(Panama) (Paraguay) (Peru) 
(Puerto Rico) (Spain) (Uruguay) 
(Venezuela)

 Swedish (Sweden)

Logfile Timezone: 

Country / Zone:



See “Planning the Default Locale 
and Logging Time Zone” on 
page 45.

User ID for OpenText Vibe: 

 User ID:
 Group ID:

See “Identifying Vibe’s Linux 
User and Group” on page 45.

Installation Program Field Your Setting/Choice Explanation
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Network Information: 

 Host:
 HTTP port: 8080
 Secure HTTP port: 8443
 Listen port: 8080
 Secure listen port: 8443
 Shutdown port:8005
 AJP port:8009

See “Gathering Network 
Information for Your Vibe Site” 
on page 46.

WebDAV Authenticaiton Method: 

 basic
 digest

See “Planning the WebDAV 
Authentication Method” on 
page 50.

Database Type: 

 MySQL/MariaDB
 Microsoft SQL
 Oracle
 PostgreSQL

See “Database Type” on 
page 52.

JDBC URL: 

 Hostname:
 Port number:

See “Database Location” on 
page 53.

Database Credentials: 

 User name:
 Password:

See “Database Credentials” on 
page 53.

Database Setup Method: 

 Basic installation (same server as 
Vibe software)

 Remote installation

See “Database Setup Method” 
on page 52.

Database Encryption Algorithm: 

 SHA-256
 PBEWITHSHA256AND128BITAES-

CBC-BC

See “Database Encryption 
Algorithm” on page 54.

Java JDK Memory: 

 JVM heap size:

See “Server Memory” on 
page 43.

Outbound Email Protocol: 

 SMTP

See “Outbound Email Protocol” 
on page 55.

Installation Program Field Your Setting/Choice Explanation
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Outbound Email Host: 

 Hostname:
 SMTP port:

Default: 25
 Time zone

 Continent/region:
 Country/state:
 City:

See “Outbound Email Host” on 
page 56.

Outbound Email Authentication: 

 User name:
 Password:
 Authentication required? No / Yes

See “Outbound Email 
Authentication” on page 56.

Allow Sending Email to All Users 

Yes / No

See “Outbound Email Send 
Restriction” on page 57.

From email address override 

 Email address for outbound email

Use this email address for all 
outbound email 

Yes / No

See “Outbound Email From 
Address” on page 57.

Inbound Email Configuration 

 Enable: No / Yes
 SMTP bind address:
 SMTP port:
 Announce TLS: Yes / No

See “Planning to Enable 
Inbound Email” on page 57.

Additional File Types for HTML 
Conversions 

 Added HTML Extensions:

See “Planning File Types for 
HTML Conversions” on page 59

Installation Program Field Your Setting/Choice Explanation
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Built-in Administrator Name: 

 Default-Administrator Name:

(Initial default is admin. You 
should secure it by changing the 
name.)

 Default-Administrator Password:
(The initial password is the same 
as the default-administrator name 
that you enter [above]. You are 
prompted to change this the first 
time you log in.)

See “Planning a Secure 
Administrator Name and 
Password” on page 46.

LDAP Directory Service: 

 eDirectory
 GroupWise
 Microsoft Active Directory

See “Synchronizing Users and 
Groups from an LDAP Directory” 
in the OpenText Vibe 4.0.8 
Administration Guide.

LDAP Server: 

 LDAP server URL:
 User DN:
 Password:

See “Server Information” in the 
OpenText Vibe 4.0.8 
Administration Guide.

GUID Attribute (to identify the user): 

 For eDirectory, select GUID.
 For Active Directory, select 

objectGUID. 
 For GroupWise, select entryUUID. 

See “Server Information” in the 
OpenText Vibe 4.0.8 
Administration Guide.

Vibe Account Name Attribute: 

 LDAP Attribute that is used for 
Vibe usernames.

See “Server Information” in the 
OpenText Vibe 4.0.8 
Administration Guide.

LDAP User Search Context: 

 Base DNs:
 Additional filter attributes:
 Search subtree: Yes / No

See “Configuring User 
Synchronization Options” in the 
OpenText Vibe 4.0.8 
Administration Guide.

LDAP Group Search Context: 

 Base DNs:
 Additional filter attributes:
 Search Subtree: Yes / No

See “Configuring Group 
Synchronization Options” in the 
OpenText Vibe 4.0.8 
Administration Guide.

Installation Program Field Your Setting/Choice Explanation
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LDAP Synchronization Schedule: 

 Days
 Every day
 Weekly

Sun Mon Tue Wed Thu Fri 
Sat

 Hours:
 At time:
 Repeat every nn hours

See “Configuring the 
Synchronization Schedule” in 
the OpenText Vibe 4.0.8 
Administration Guide.

LDAP User Options: 

 Synchronize user profiles
 Register LDAP user profiles 

automatically
 Delete users that are not in LDAP
 When deleting a user, delete 

associated user workspaces and 
content

 Time zone for new users

See “Configuring User 
Synchronization Options” in the 
OpenText Vibe 4.0.8 
Administration Guide.

LDAP Group Options: 

 Synchronize group profiles
 Register LDAP group profiles 

automatically
 Synchronize group membership
 Delete local groups that are not in 

LDAP

See “Configuring User 
Synchronization Options” in the 
OpenText Vibe 4.0.8 
Administration Guide.

Installation Program Field Your Setting/Choice Explanation
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8 8Planning a Basic (Single-server) Vibe 
Installation

The installation program for OpenText Vibe helps you install the Vibe software and file repository to 
the appropriate locations.

 “What Is a Basic Vibe Installation?” on page 41
 “Planning the Operating Environment of Your Vibe Server” on page 42
 “Planning the Default Locale and Logging Time Zone” on page 45
 “Identifying Vibe’s Linux User and Group” on page 45
 “Planning a Secure Administrator Name and Password” on page 46
 “Gathering Network Information for Your Vibe Site” on page 46
 “Planning the WebDAV Authentication Method” on page 50
 “Planning the Vibe Database” on page 51
 “Planning for Outbound Email” on page 55
 “Planning to Enable Inbound Email” on page 57
 “Planning File Types for HTML Conversions” on page 59
 “Gathering Directory Services Information” on page 59

What Is a Basic Vibe Installation?
The OpenText Vibe installation program provides two installation types: Basic (single-server) and 
Advanced. When you perform a Basic installation, the result is a fully functional Vibe site with all 
required options configured and with typical defaults in use for optional settings. 

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all 
Vibe components installed on the same server. Then you can add advanced configuration options to 
your Vibe site after the Basic installation has been successfully tested. However, experienced Vibe 
administrators can choose to perform an Advanced installation immediately, which includes all 
installation and configuration options, as described in Part IV, “Advanced Installation and 
Reconfiguration,” on page 97.
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IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as 
your initial installation of the Vibe software:

 Setting up the Vibe file repository so that some types of files are located outside the Vibe file 
repository root directory. See “Distributing Different Data Types to Different Locations” on 
page 100 for Advanced installation instructions. You cannot move subdirectories within the 
Vibe file repository after they have been created.

 Installing the Vibe software on multiple servers to create a clustered environment. See 
Chapter 21, “Running Vibe on Multiple Servers,” on page 147 for Advanced installation 
instructions. The option to enable a clustered environment is available only during an Advanced 
installation.

This section helps you make informed decisions about the required options for a Basic installation:

 Server platform (Linux or Windows)
 Physical server memory requirements
 File locations (Vibe software and data)
 Database type (MySQL/MariaDB, Microsoft SQL Server, or Oracle)
 Database creation (during installation or before installation)
 Database authentication (user name and password)
 Network information (Vibe server hostname or fully qualified domain name, and ports)
 Outbound email configuration (SMTP vs. Secure SMTP, hostname, SMTP port, time zone, 

authentication)
 Inbound email configuration (SMTP address, SMTP port, and TLS support)
 User and group for running the Vibe software (Linux only)

Before performing a Basic installation, ensure that all system requirements are met, as listed in 
Chapter 4, “Vibe System Requirements,” on page 23.

As you proceed with planning, you can use the Single-server Installation Planning Worksheet to 
record your decisions about the options you want to use.

Planning the Operating Environment of Your Vibe Server
 “Vibe Server Platform” on page 42
 “Server Memory” on page 43
 “Install Location” on page 44

Vibe Server Platform
OpenText Vibe can run on the versions of Linux and Windows listed in “Server Operating System 
Requirements” on page 23.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.
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Server Memory
Vibe server memory usage is significantly affected by some factors and less affected by others:

 Number of users logged in: No significant effect.
 Number of concurrent active sessions: No significant effect.
 Database server caches: Significant memory usage. 

When you follow the instructions for a Basic installation, the database is located on the same 
server as the Vibe software. After you have successfully tested your Basic installation, you can 
reconfigure Vibe to have its database on a remote server, so that the database uses separate 
memory resources, as described in Chapter 19, “Creating the Vibe Database on a Separate 
Server,” on page 135.

 Vibe internal data caches: Significant memory usage. 
When you follow the instructions for a Basic installation, the Vibe internal data caches are 
subdirectories of the teamingdata directory, described in “Install Location” on page 44. The 
Vibe internal data caches are separate from any caching or memory usage by the database 
server itself.

 Lucene index cache: Significant memory usage. 
The Lucene Index Server is a high-performance Java search engine. Large file repositories 
(particularly with large files or a large number of files) can create a very large data index. When 
you perform a Basic installation, the Lucene index is created on the same server where the Vibe 
software is installed. After you have successfully tested your Basic installation, you can 
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory 
resources, as described in “Installing the Lucene Index Server on a Separate Server” on 
page 143.

 JVM: When you perform a Basic installation, the default amount of memory allocated to the 
Java Virtual Machine (JVM) where the Vibe software runs is 1 GB. This memory allocation, 
called the Java “heap size,” does not include memory used by your database server or by the 
Lucene Index Server when these programs are running on the same server as the Vibe 
software.
A general rule is that no more than 75% of the available physical memory should be allocated to 
the JVM. Memory not allocated to the JVM must be sufficient to support the operating system, 
the database server, and the Lucene Index Server if they are also running on the Vibe server, 
and any other processes running on the Vibe server.
Although it is possible to run Vibe with less than 4 GB of memory for the JVM (the 
recommended minimum), this applies only to very small test configurations, and is not suitable 
for production systems. In a test configuration, 512 MB is the minimum amount of memory 
required to produce a functioning Vibe installation.

After you have considered all of the points above, you are ready to specify the 

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Memory, specify the amount of memory to allocate to the JVM where Vibe runs.
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Install Location
Software Location: This varies by platform:

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer 
software.

Data Location: This also varies by platform:

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with 
forward slashes (/) rather than the traditional backslashes (\). This syntax is necessary in the 
installation program.

The Vibe file repository holds all files that are imported into Vibe, information related to the 
imported files, such as thumbnails and HTML renderings, and the search engine index.

A Basic installation lets you change the root directory for the Vibe software and the Vibe file 
repository. 

IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under 
the Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe 
installation. You cannot move directories out of the Vibe file repository root directory after the initial 
installation has been performed. To perform an Advanced installation in order to organize the Vibe 
file repository to meet your needs, complete the planning steps for a Basic installation and complete 
the Single-server Installation Planning Worksheet, then follow the additional instructions in 
“Distributing Different Data Types to Different Locations” on page 100.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe 
server.

Linux: /opt/novell/teaming
Windows: c:\Program Files\Novell\Teaming

Linux: /var/opt/novell/teaming
Windows: c:\Novell\Teaming

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Install Location, specify the directories where you want to install the Vibe software and data if 
you prefer not to use the default locations.
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Planning the Default Locale and Logging Time Zone
Default Locale
The OpenText Vibe installation program runs in English only. When you install the Vibe software, you 
can choose to have the primary language of the Vibe site be any of the languages listed on the 
planning worksheet.

Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays 
in locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace 
tree icon : 

The language you select also establishes the default interface language and locale for creating new 
workspaces.

Additional language customization can be done after installation, as described in “Managing a 
Multiple-Language Vibe Site” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration Guide.

Logfile Timezone
You also need to specify the time zone to be used for times recorded in Vibe log files.

Identifying Vibe’s Linux User and Group
For optimum security, Vibe should not run as the Linux root user. For example, if an intruder 
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the 
commandeered process. If the process is running with root user privileges, the intruder has root 
access to your system. If the process is running as a user with minimal privileges, the intruder has 

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and locale for your Vibe site.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Logfile Time Zone, mark the time zone where your Vibe site is located.
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only restricted access to your system. Therefore, your system is more secure if the Vibe program 
does not run as root. For example, you might want to create a user named vibeadmin for the Vibe 
program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group 
for that user to belong to. This enables the Vibe program to create directories and files with 
consistent ownership and permissions. For example, you might want to create a group named 
vibeadmin for the vibeadmin user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux user name and group for Vibe, you can use the existing 
wwwrun user name and the www group. This account is typically used to start web server processes.

Planning a Secure Administrator Name and Password
By default, the built-in default-administrator name and password are both set to admin by the Vibe 
installation program. 

We strongly recommend that you change the name during the initial Vibe installation. The initial 
password is then set to whatever name you specify. 

We also recommend that you change the password when you log in for the first time after Vibe is 
installed.

If you don’t change the password during the initial login, you can change it (and the Vibe default-
adminsitrator user name) at any time, as described in “Changing the Vibe Administrator User ID or 
Password” in the  OpenText Vibe 4.0.8 Administration Guide.

Gathering Network Information for Your Vibe Site
When you perform a Basic installation, the OpenText Vibe installation program needs hostname and 
HTTP port information about the server where you are installing Vibe.

 “Host Identification” on page 47
 “Port Numbers” on page 47

BASIC VIBE INSTALLATION SUMMARY SHEET

Under User ID for Vibe, specify the non-root Linux user name and group name to use for running the 
Vibe program.

IMPORTANT: The non-root Linux user and group must exist before you start the Vibe Installation 
program. See “Performing Pre-Installation Tasks on Linux” on page 71.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Built-in Administrator Name, specify a Default-Administrator Name different from admin.

Also specify a password that you can enter and confirm the first time you log in as the Vibe site 
administrator. (The initial password (for logging in the first time) is set to whatever you specify as the 
administrator name.)
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Host Identification
When you install Vibe, the Vibe installation program needs to know the name of the server where 
you are installing the Vibe software. 

For use inside your firewall, you can use the DNS hostname of the Vibe server. However, if you want 
your Vibe site to be accessible from the Internet, you must specify the fully qualified domain name 
for the Vibe server in order to allow external access.

Do not use the default localhost

Port Numbers
When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a 
standalone web server for delivering data to Vibe users in their web browsers. For more information 
about Tomcat, see the Apache Tomcat website (http://tomcat.apache.org). 

IMPORTANT: If the server where you want to install Vibe already has a web server running on it, 
shut it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that 
no other web server is running on the Vibe server. If you want to maintain another web server on 
the Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use the netstat command to see what ports are currently in use on the 
server where you plan to install Vibe:

Ensure that the port numbers that you specify during Vibe installation do not conflict with ports that 
are already in use on the server.

 “HTTP/HTTPS Ports” on page 48
 “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 49
 “Shutdown Port” on page 49
 “AJP Port” on page 50

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe 
server.

Linux: netstat -tan
Windows: netstat -a -n -p tcp
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HTTP/HTTPS Ports
By default, standard web servers such as Apache and Microsoft Internet Information Services (IIS) 
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure 
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a result, 
web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to port 443 
when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS 
connections, so that it does not conflict with the standard web server port numbers. If you configure 
Vibe with the Tomcat default port numbers, users must include the appropriate port number when 
providing the Vibe site URL. Typically, users prefer not to do this. 

Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers 
of 80 and 443. On Linux, non-root processes are not allowed access to port numbers lower than 
1024 and you are counseled against running Vibe as root in “Identifying Vibe’s Linux User and 
Group” on page 45. Also on Linux and Windows, the default Tomcat installation expects ports 8080 
and 8443.

For a Basic installation, you can use the default port numbers as presented by the Vibe Installation 
program:

HTTP port: 80
Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use 
by iManager. In order for Vibe to listen on port 80 (which is the standard port), you need to change 
iManager to listen on a non-standard port, such as 81.

After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding on 
SLES 12” on page 79 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate 
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the  OpenText Vibe 
4.0.8 Administration Guide either before or after you install Vibe.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You need to specify 
different port numbers only if you anticipate port conflicts with other software on the Vibe server. 
Resolving port conflicts is beyond the scope of this Vibe documentation.
48 Planning a Basic (Single-server) Vibe Installation

https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bomt7xw
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bity0sy
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo


HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe
If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe is 
running.

Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is 
the standard port.

 “Windows Port Configuration” on page 49
 “Linux Port Configuration” on page 49

Windows Port Configuration
Use the following port configuration when Novell Access Manager is fronting your Vibe system on 
Windows:

HTTP Port: 80

Secure HTTP Port: 443

Listen Port: 80

Secure Listen Port: 443

Linux Port Configuration
Use the following port configuration when Novell Access Manager is fronting your Vibe system on 
Linux:

HTTP Port: 80

Secure HTTP Port: 443

Listen Port: 8080

Secure Listen Port: 8443

With this suggested configuration on Linux, you also need to set up port forwarding, as described in 
“Setting Up Port Forwarding on SLES 12” on page 79.

Shutdown Port
By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see 
Tomcat - Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html). 

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default 
of 8005 is already in use on the Vibe server.
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AJP Port
By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see 
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html). 

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server, port 8009 is already in use, 
so you need to select a different port, such as 8010. 

Planning the WebDAV Authentication Method
 “Understanding WebDAV” on page 50
 “Choosing the WebDAV Authentication Method” on page 50

Understanding WebDAV
WebDAV is a standard collaborative editing and file management protocol. OpenText Vibe relies on 
the WebDAV protocol for two key features:

 Edit-in-Place for using tools such as LibreOffice and Microsoft Office, as described in “Editing 
Files Accessed through a Web Browser” in the OpenText Vibe 4.0.8 User Guide.

 Mapping Vibe folders as a web folder on the client computer, which allows access to Vibe files 
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as 
described in “Creating a Mapped Drive to the Vibe Folder” in the OpenText Vibe 4.0.8 Advanced 
User Guide.

Choosing the WebDAV Authentication Method
The WebDAV authentication method determines how user credentials are passed from Vibe to the 
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:

 “Choosing Basic Authentication” on page 50
 “Choosing Digest Authentication” on page 51
 “Choosing Windows Authentication” on page 51

Choosing Basic Authentication
Basic authentication encodes the user name and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC 
(HTTPS). 

Select this type of authentication when you plan to use Novell Access Manager or Internet 
Information Services (IIS) to authenticate users.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 
is already in use on the Vibe server.
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For more information about encryption algorithms, see “Database Encryption Algorithm” on 
page 54.

Choosing Digest Authentication
Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a 
password before sending it over the network. This option is more safe than Basic Authentication 
when used over HTTP. 

Select this type of authentication when client users are using Windows 7 as their operating system 
and Microsoft Office as their text editor.

For more information about encryption algorithms, see “Database Encryption Algorithm” on 
page 54.

Choosing Windows Authentication
Windows Authentication provides Windows users with a single sign-on experience, enabling users to 
automatically authenticate to Vibe after they are logged in to their individual workstations. Internet 
Information Services (IIS) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAV authentication method, select 
basic in the WebDAV authentication method field during the Vibe installation program, then 
configure Windows Authentication as described in “Configuring Single Sign-On with Internet 
Information Services for Windows” on page 108.

Planning the Vibe Database
OpenText Vibe database disk space requirements are relatively modest. Files that are imported into 
Vibe are saved in the Vibe file repository, as described in “Install Location” on page 44. 

The Vibe database is primarily used for storing the following information:

 Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)

 Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)

 User profile information (for example, full name, phone number, and email address)

You or your database administrator must make the following decisions about the Vibe database:

 “Database Type” on page 52
 “Database Setup Method” on page 52
 “Database Location” on page 53

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when 
authenticating to WebDAV.
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 “Database Credentials” on page 53
 “Database Encryption Algorithm” on page 54

Database Type
Vibe supports the following database types:

On Linux: MariaDB, MySQL, Oracle, and PostgreSQL

On Windows MariaDB, MySQL, Microsoft SQL, Oracle, and PostgreSQL

Ensure that a supported version of the database server, as listed in “Database Server Requirements” 
on page 24, is installed and running before you install Vibe.

Database Setup Method
You or your database administrator must manually create the Vibe database. This is a requirement, 
regardless of which type of database you are using.

 “Basic Setup” on page 52
 “Remote Server Setup” on page 52

Basic Setup
If you plan to deploy the Vibe database as a basic installation, with the database running on the 
same server as the Vibe software, you first install the Vibe software, and then create the database, 
as described in Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 71.

Remote Server Setup
If you plan to deploy the Vibe database on a remote server, follow the instructions in Chapter 19, 
“Creating the Vibe Database on a Separate Server,” on page 135.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you are setting up the database as a basic installation 
(with the database running on the same server as the Vibe software), or whether you are performing a 
remote server setup, with the database server on a remote server.
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Database Location
Creating the database on the same server where you install the Vibe software is the preferable 
location for your Basic installation. The default database name is sitescape (a reference to the 
company that previously developed the Vibe software).

You can have your database administrator create a database on a remote server later, after you have 
successfully tested your Basic installation. See Chapter 19, “Creating the Vibe Database on a 
Separate Server,” on page 135.

You must decide before installation whether you want the database on the Vibe server or on a 
remote server. See Chapter 19, “Creating the Vibe Database on a Separate Server,” on page 135.

Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you 
provide during installation. For a database that is local to the Vibe software, the default JDBC URL 
that provides localhost as the hostname of the Vibe server is appropriate. If the database is on a 
remote server, the JDBC URL must provide the hostname of the remote database server. 

The JDBC URL also includes the port number on which Vibe can communicate with the database 
server. The default port number depends on the database server you are using:

Use this port number unless it is already in use by another process on the database server.

Database Credentials
When you have the Vibe Installation program create the database for you, it defaults to the 
following administrator user names for the database server:

Database Server Default Port Number

MySQL/MariaDB 3306

Microsoft SQL 1433

Oracle 1521

PostgreSQL 5432

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (localhost or the 
hostname of a remote server) and the port number it will use to communicate with Vibe.
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For an Oracle database and Microsoft SQL database, your database administrator establishes the 
administrator user name and password for the database server.

Check with your database administrator to see if the default administrator user name is still in use 
for your database server, and obtain the administrator password for the database server before you 
run the Vibe Installation program.

Database Encryption Algorithm
Different encryption algorithms provide differing encryption strength. The supported algorithms for 
encrypting the Vibe database password are listed below.

 SHA-256

This is the only available option when you use Basic Authentication for WebDAV authentication, 
as described in “Planning the WebDAV Authentication Method” on page 50.

 PBEWITHSHA256AND128BITAES-CBC-BC 
This is the only available option when you select Digest Authentication for WebDAV 
authentication, as described in “Planning the WebDAV Authentication Method” on page 50.

Database Default Administrative User Name

MySQL/
MariaDB

root
IMPORTANT: The database root user name is not the same as the Linux root user on a 
Linux server.

Microsoft SQL (no default) For a Microsoft SQL database, your database administrator establishes the 
administrator user name and password for the database server.

Oracle (no default) For an Oracle database, your database administrator establishes the 
administrator user name and password for the database server.

PostgreSQL postgres

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator user name and password for the database 
server so that Vibe can access its database.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe 
passwords.
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Planning for Outbound Email
Your OpenText Vibe site can be configured to send outbound email through an existing email 
system. Email from the Vibe site is useful for the following activities:

 Vibe users can subscribe to email notifications, so that they automatically receive a message 
whenever content of interest changes. For more information, see “Subscribing to a Folder or 
Entry” in “Getting Informed” in the OpenText Vibe 4.0.8 User Guide.

 From the Vibe site, users can send email messages to individual users or to teams. For more 
information, see “Sending Email from within Vibe” in “Connecting With Your Co-Workers” in 
the OpenText Vibe 4.0.8 User Guide.

In order for your Vibe site to communicate with your email system, you need to gather the following 
information about your email system:

 “Outbound Email Protocol” on page 55
 “Outbound Email Host” on page 56
 “Outbound Email Authentication” on page 56
 “Outbound Email Send Restriction” on page 57
 “Outbound Email From Address” on page 57

After installation, outbound email can be disabled and enabled again on the Vibe site, as described 
in “Configuring Email Integration” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration 
Guide. However, you must configure outbound email in the Vibe installation program.

Outbound Email Protocol

IMPORTANT: Email systems communicate by using SMTP.

If you need to secure the email communications in Vibe, do not select SMTPS. SMTPS was proposed 
as an industry standard but never implemented. 

For securing SMTP communications, select the Enable STARTTLS option.

For GroupWise, you can check how the Internet Agent is configured:

1 In the GroupWise Admin Console, browse to Internet Agents > GWIA > Agent Settings.
2 The SMTP row, SSL column indicates which protocols can be used. Note the setting for your 

system.
3 Click Close.

4 If the email system requires Secure SMTP, see “Securing Email Transfer” in “Site Security” in the  
OpenText Vibe 4.0.8 Administration Guide.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Protocol, mark SMTP or Secure SMTP to match the email system that you want 
Vibe to communicate with.
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Outbound Email Host
In order to send messages to your email system, Vibe needs to know the hostname of your SMTP 
mail server.

The default SMTP port is 25.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise 
always uses port 25, even when SSL is enabled.

When the Vibe site sends email notifications for scheduled events, the messages are time-stamped 
according to the time zone you specify here during installation. This setting allows you to use a time 
zone for email notifications that is different from the time zone where the server is located. The time 
zone list is grouped first by continent or region, optionally by country or state, and lastly by city. 
Some common selections for United States time zones include the following:

Outbound Email Authentication
Many SMTP mail hosts require a valid email address before they establish the SMTP connection. 
Some email systems can construct a valid email address if you specify only a valid user name; other 
email systems require that you specify the full email address for successful authentication. You 
should provide a user name (email address) to ensure a successful connection. Email notifications 
from the Vibe system are sent using this email address in the From field.

Some email systems also require a password. Some do not. If authentication is required, you should 
also provide a password.

By default, the GroupWise Internet Agent does not require authentication in order to receive 
inbound messages. However, the /forceinboundauth startup switch is available for use in the 
Internet Agent startup file (gwia.cfg), in order to configure the Internet Agent to refuse SMTP 
connections where a valid email user name and password are not provided. The Internet Agent can 
accept just the user name or the full email address.

Time Zone Continent/City

Pacific Time America/Los Angeles

Mountain Time America/Denver

Central Time America/Chicago

Eastern Time America/New York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Host, specify the name of the mail host, the SMTP port number it uses, and the 
time zone for the time stamp you want on scheduled event notifications.
56 Planning a Basic (Single-server) Vibe Installation



Outbound Email Send Restriction
By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users 
group on the Vibe site. On a very large Vibe site, this generates a very large number of email 
messages. If desired, you can prevent messages from being sent to the All Users group.

Outbound Email From Address
You can specify an email address to be used as the From address of emails sent from Vibe.

Planning to Enable Inbound Email
You can configure your OpenText Vibe site so that users can post comments by emailing them to the 
folder where they want to post the comment. In order to receive email postings, folders must be 
properly configured, as described in “Enabling Folders to Receive Entries through Email” in 
“Managing Folders” in the OpenText Vibe 4.0.8 Advanced User Guide. Also, users must know the 
email address of the folder where they want to post their comment.

 “Internal Mail Host for Inbound Email” on page 58
 “Inbound Email Port Number” on page 58
 “Inbound Email IP Address” on page 58
 “Inbound Email Security” on page 58

After installation, inbound email can be disabled and enabled again on the Vibe site, as described in 
“Disabling/Enabling Inbound Email Postings” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 
Administration Guide. However, you must configure inbound email in the Vibe installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Authentication, indicate whether or not authentication is required for the Vibe 
site to communicate with your email system. If it is, specify the user name or email address, and if 
necessary, the password for the email account.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending Email to All Users, mark whether you want users to be able to send messages to the All 
Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under From email address override, specify the email address to be used as the From address for emails 
sent from Vibe.

Under Use this from email address for all outbound email, mark whether you want this address to be used 
for all outbound email.
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Internal Mail Host for Inbound Email
Inbound email is disabled by default. When you enable it, the Vibe site starts an internal SMTP mail 
host to receive incoming messages and post them to the folders associated with the email addresses 
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so that 
it does not conflict with another mail host that might be running on the Vibe server. 

Inbound Email Port Number
Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs 
to be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 48. You 
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How 
you handle the issue depends on whether you are installing on Linux or on Windows.

Inbound Email IP Address
If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if 
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address 
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP 
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP address 
rather than all of them.

Inbound Email Security
You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it 
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a 
certificate on the Vibe server, as described in “Securing Email Transfer” in “Site Security” in the  

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want users to be able to post to the Vibe site from 
their email clients.

Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps 
in “Setting Up Port Forwarding on SLES 12” on page 79 so that requests incoming on port 25 are 
forwarded to port 2525. 

Windows: Specify port 25 for incoming email in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the port number for the Vibe internal SMTP host to listen on.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if 
you are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.
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OpenText Vibe 4.0.8 Administration Guide. When an SMTP mail host queries the Vibe mail host, the 
Vibe mail host communicates its ability or inability to handle TLS. The other SMTP mail host then 
communicates appropriately, taking into account how the Vibe internal mail host is configured. The 
default is to use TLS, because this provides more secure communication between mail hosts.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards. 
However, if you select Announce TLS, inbound email does not work until the certificate is available 
on the Vibe server.

Planning File Types for HTML Conversions
Many file formats in OpenText Vibe can be viewed as HTML by default, as described in “Viewing the 
File in HTML Format” in the OpenText Vibe 4.0.8 User Guide. File formats that can be viewed as 
HTML by default are: .123, .bmp, .doc, .docx, .dotm, .drw, .dxf, .htm, .html, .lwp, .odp, 
.ods, .odt, .ppt, .pptx, .prz, .rtf, .shw, .sxw, .tif, .txt, .vsd, .wpd, .xls, .xlsx, .sxi.

Some file formats, such as .pdf files, cannot be viewed as HTML by default. This is because the 
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as .pdf files, to be viewed as HTML.

Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure 
whether Vibe supports a particular file format to be viewed as HTML, try it and see. 

Gathering Directory Services Information
Unless you are planning a very small OpenText Vibe site, the most efficient way to create Vibe users 
is to synchronize initial user information from your network directory service (Novell eDirectory, 
GroupWise, or Microsoft Active Directory directory service) after you have installed the Vibe 
software. Over time, you can continue to synchronize user information from the LDAP directory to 
your Vibe site.

“Synchronizing Users and Groups from an LDAP Directory” in the OpenText Vibe 4.0.8 Administration 
Guide provides instructions for synchronizing user information via LDAP. Use this section when 
planning your LDAP configuration.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want the Vibe server to announce that it can use 
TLS.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Additional File Types for HTML Conversions, specify the file types (in addition to the default file 
types) that you want users to be able to view as HTML.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under the LDAP sections, mark the information specific for your environment.
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9 9Obtaining the Vibe Software

 Free Trial: After registering for a user account with OpenText, you can download a 60-day free 
trial of Vibe software from the OpenText web site to share and evaluate with your team. 

 Purchase: If you want to deploy Vibe services as part of your regular production system, visit 
the How to Buy link on the Vibe Trial Download page (linked above).
Obtaining the Vibe Software 61

https://www.microfocus.com/products/vibe/
https://www.microfocus.com/products/vibe/
https://www.microfocus.com/products/vibe/how-to-buy/


62 Obtaining the Vibe Software



10 10Installing and Running the Database Server

Vibe requires the creation of a Vibe database during installation. Therefore, a supported database 
server must be installed and running before you install Vibe.

A Basic Installation assumes that the database service is running on the same server as Vibe.

If your Vibe server already has one of supported database servers installed and running, skip to 
Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 71. 

To install an Oracle or Microsoft SQL server, see the documentation for those products. 

If you want to deploy a MySQL, MariaDB, or PostgreSQL database server, the following sections are 
provided for your convenience.

 “MySQL (or MariaDB) on Linux” on page 63
 “MySQL or MariaDB on Windows” on page 65
 “PostgreSQL on Linux” on page 66
 “PostgreSQL on Windows” on page 68
 “Securing PostgreSQL and Vibe Communications” on page 69

MySQL (or MariaDB) on Linux
IMPORTANT: The steps in this section are optimized for installing MYSQL on SUSE Linux Enterprise 
Server (SLES) 11. 

For information regarding the installation of MySQL on other versions of SLES or other flavors of 
Linux, see Installing and Upgrading MySQL (http://dev.mysql.com/doc/refman/5.1/en/
installing.html) in the MySQL documentation (http://dev.mysql.com/doc/).

In SLES 12, the default database changed from MySQL to MariaDB. Installation and management 
procedures, etc. are basically unchanged. For information on installing SLES 12 and using MariaDB, 
see the SLES 12 Documentation (https://www.suse.com/documentation/sles-12/) and MariaDB 
(http://www.mariadb.com) web sites.

Depending on the options you select when installing Open Enterprise Server and SUSE Linux 
Enterprise Server (SLES), the MySQL or MariaDB database server might be installed along with the 
operating system. Check for the following directory:

/usr/bin/mysql
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If the /usr/bin/mysql directory does not exist, you need to install the MySQL or MariaDB 
database server. If MySQL or MariaDB is already installed, you still need to configure it for use with 
Vibe.

 “Installing MySQL/MariaDB” on page 64
 “Configuring MySQL/MariaDB” on page 64
 “Learning More about MySQL/MariaDB” on page 65

Installing MySQL/MariaDB
1 Ensure you have access to your operating system installation media.
2 In YaST, click Software > Software Management.
3 In the Search field, type mysql, then click Search.
4 Select mysql, then click Accept.
5 Click Continue to resolve dependencies.
6 Click Continue to acknowledge package support status.

MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL/MariaDB” on page 64.

Configuring MySQL/MariaDB
When MySQL or MariaDB is initially installed, it is not configured with an administrator password, 
nor is it configured to start automatically. Follow the steps below to set up the MySQL or MariaDB 
database server for use with Vibe:

1 In YaST, click System > System Services.
2 Scroll to and select the service, then click Enable.
3 Click Continue to install dependencies, then click OK to close the status box.
4 Click OK > Yes to finish the installation, then exit YaST.
5 In a terminal window, become the root user.
6 To verify that the database server has started, use the following command:

ps -eaf | grep mysql
You should see the processes running. 

7 IMPORTANT: If you are installing MySQL 8, you must disable password complexity before 
setting the administrator password. Go to , complete the instructions there, then continue with 
“Learning More about MySQL/MariaDB” on page 65.

Set the administrator password for the database server:

mysqladmin -u root password new_password

This command changes the password for the database root user, which is the default 
administrator user name for the MySQL or MariaDB database server. This command is part of 
the database client package.
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IMPORTANT: The database root user name is not the same as the Linux root user. The Linux 
root user has a password established for it when you install Linux. In a parallel fashion, the 
database root user needs to have a password established for it when you install MySQL or 
MariaDB. 

Learning More about MySQL/MariaDB
The following table includes some basic and useful MySQL or MariaDB commands:

If you want to administer MySQL or MariaDB through a GUI interface, you can download tools from:

MySQL GUI Tools Downloads (http://dev.mysql.com/downloads/gui-tools/5.0.html)

For more information about MySQL, see:

MySQL Documentation (http://dev.mysql.com/doc)

MySQL or MariaDB on Windows
1 In your web browser, go to the MySQL or MariaDB download site.
2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit 

or 64-bit).
3 On the Windows Essentials line, click Download.
4 Click Save File, browse to and select a convenient temporary directory, then click Save. 
5 In Windows Explorer, browse to the directory where you saved the MySQL .exe file. 
6 Double-click the .exe file to start the Setup Wizard.
7 Follow the online instructions to install the software on the Windows server, then continue with 

Step 8 to configure the server.
8 Unless you are already familiar with configuring MySQL or MariaDB on a Windows server, select 

Standard Configuration, then click Next.
9 Select Include Bin Directory in Windows PATH, then click Next.

10 Set the database root user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Single-server Installation Planning Worksheet, specify the database 
administrator password. The Vibe installation program prompts you for this information.

Action Command

Stop MySQL /etc/init.d/mysql stop

Start MySQL /etc/init.d/mysql start

Show MySQL status mysqladmin -u root -p extended-status
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11 Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

12 To monitor the database server, click Start > All Programs, then click MySQL > MySQL Server 5.1 > 
MySQL Command Line Client or the equivalent MariaDB options.

PostgreSQL on Linux
IMPORTANT: The steps in this section are optimized for installing PostgreSQL on SUSE Linux 
Enterprise Server (SLES) 12 or 15. 

For information regarding the installation of PostgreSQL on other versions of SLES or other flavors of 
Linux, see the PostgreSQL (https://www.postgresql.org/docs/manuals/) and the SUSE (https://
www.suse.com/documentation/) documentation on the web.

 “Installing PostgreSQL and Setting the postgres User Password” on page 66
 “Configuring the Socket Connection Method” on page 67
 “Learning More about PostgreSQL” on page 68

Installing PostgreSQL and Setting the postgres User Password
1 Ensure you have access to your operating system installation media.
2 In YaST, click Software > Software Management.
3 In the Search field, type postgresql, then click Search.
4 Select the following packages:

 postgresql10
 libecpg6
 postgresql-jdbc (if available)
 The client packages, if not automatically added with the server packages.

5 Click Accept.
6 If needed, click Continue to resolve dependencies.
7 Click Continue to acknowledge package support status.

PostgreSQL is then installed from the SLES media.
8 Click Finish.
9 In YaST, click System > Services Manager.

10 Scroll to and select postgresql, then click Enable/Disable > Start/Stop > OK.
11 After the configuration is updated, close YaST and open a terminal prompt.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Single-server Installation Planning Worksheet, specify the 
database administrator password. The Vibe installation program prompts you for this information.
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12 Set a password for the database administrator (postgres system user) by entering the 
following commands:

su - postgres
psql
\password postgres
specify-a-password
repeat-the-password
\q
exit

13 Continue with “Configuring the Socket Connection Method” on page 67.

Configuring the Socket Connection Method 
1 As the root user, browse to /var/lib/pgsql/data.
2 Edit the pg_hba.conf file and change the following local and host lines to specify md5 

encryption, as follows:

local  all   all                  md5
host   all   all   127.0.0.1/32   md5
host   all   all   ::1/128        md5
host   all   all   0.0.0.0/0      md5
For more information about the pg_hba.conf file, see the PostgreSQL documentation on the 
web (https://www.postgresql.org/docs/9.4/static/auth-pg-hba-conf.html).

3 Save the file.
4 Edit the postgresql.conf file.
5 Uncomment the listen_addresses line by removing the pound sign (#).
6 Change ‘localhost’ to ‘*’.
7 Save and close the file.
8 In YaST, click System > Services Manager.
9 Scroll to and select postgresql, then click Start/Stop > OK to stop PostgreSQL.

10 Repeat from Step 8 to restart PostgreSQL, then close YaST.
11 Continue with “Securing PostgreSQL and Vibe Communications” on page 69

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Single-server Installation Planning Worksheet, record the postgres 
administrator password. If you want to use a password other than postgres you must modify the 
postgresql-create-empty-database.sql file. See the PostgreSQL documentation on the web (https://
www.postgresql.org/docs/manuals/) for help.
Installing and Running the Database Server 67

https://www.postgresql.org/docs/manuals/
https://www.postgresql.org/docs/9.4/static/auth-pg-hba-conf.html
https://www.postgresql.org/docs/9.4/static/auth-pg-hba-conf.html


Learning More about PostgreSQL
If you want to administer PostgreSQL through a GUI interface, you can download tools from:

Community Guide to PostgreSQL GUI Tools (https://wiki.postgresql.org/wiki/
Community_Guide_to_PostgreSQL_GUI_Tools)

For more information about PostgreSQL, see:

The PostgreSQL Wiki (https://wiki.postgresql.org/wiki/Main_Page)

PostgreSQL on Windows
1 In your web browser, go to the PostgreSQL download site.
2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit 

or 64-bit).
3 On the Windows Essentials line, click Download.
4 Click Save File, browse to and select a convenient temporary directory, then click Save. 
5 In Windows Explorer, browse to the directory where you saved the .exe file. 
6 Double-click the .exe file to start the Setup Wizard.
7 Follow the online instructions to install the software on the Windows server, then continue with 

Step 8 to configure the server.
8 Unless you are already familiar with configuring PostgreSQL on a Windows server, select 

Standard Configuration, then click Next.
9 Select Include Bin Directory in Windows PATH, then click Next.

10 Set the database postgres user password, then click Next.

11 Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

12 To monitor the database server, click Start > All Programs, then click PostgreSQL > PostgreSQL 
Server > PostgreSQL Command Line Client.

13 Continue with “Securing PostgreSQL and Vibe Communications” on page 69

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Single-server Installation Planning Worksheet, specify the 
database administrator password. The Vibe installation program prompts you for this information.
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Securing PostgreSQL and Vibe Communications
IMPORTANT: If SSL is enabled on your PostgreSQL server, you must modify the Vibe server as 
follows:

1 Shut down the Vibe server.
2 Rerun the Vibe installer and when specifying the JDBC URL, add ?ssl=true after the database 

name, for example:
url="jdbc:postgresql://IP_address_or_DNS_name:5432/
vibe_db_name?ssl=true"

3 Restart Vibe.
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11 11Installing and Setting Up a Basic Vibe Site

Follow the setup instructions for the platform where you are installing OpenText Vibe:

 “Linux: Installing and Setting Up a Basic Vibe Site” on page 71
 “Windows: Installing and Setting Up a Basic Vibe Site” on page 82

Linux: Installing and Setting Up a Basic Vibe Site
You should already have reviewed Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on 
page 41 and filled out the Single-server Installation Planning Worksheet. The following sections step 
you through the process of installing and starting OpenText Vibe on Linux:

 “Performing Pre-Installation Tasks on Linux” on page 71
 “Running the Linux Vibe Installation Program” on page 72
 “Creating the Vibe Database” on page 75
 “Performing Post-Installation Tasks on Linux” on page 77

Performing Pre-Installation Tasks on Linux
1 Ensure that the Linux server where you plan to install Vibe meets the system requirements 

listed in “Vibe System Requirements” on page 23.
2 In a terminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Vibe software:

3a Open the /etc/security/limits.conf file in an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example lines:

* hard nofile 65535
* soft nofile 4096

3c Save the file, then exit the text editor.
4 Perform the following conditional tasks if necessary:

 “Stopping and Disabling an Existing Web Server” on page 71
 “Creating a Vibe User and Group” on page 72

Stopping and Disabling an Existing Web Server
If a web server is currently running on the Vibe server, stop it, and preferably disable it.

For example, to stop the Apache web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:
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/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop

2 Enter the following commands to ensure that Apache and Tomcat do not start again when you 
reboot the server:

chkconfig --del apache2
chkconfig --del tomcat5

Creating a Vibe User and Group
If the user and group that you want to use for Vibe (as described in “Identifying Vibe’s Linux User 
and Group” on page 45) do not exist yet, create them. It is easier if you create the group first.

1 Create the Linux group that you want to own the Vibe software and data store directories:
1a In YaST, click Security and Users > User and Group Management to display the User and 

Group Administration page.
1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.

The group does not need a password.
2 Create the Linux user that you want Vibe to run as:

2a Click Users, then click Add.
2b On the User Data tab, specify the user’s full name, user name, and password, then select 

Disable User Login.
Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe 
Linux user does not need a password, either, but YaST requires you to provide one.

2c Click the Details tab.
2d In the Login Shell drop-down list, select /bin/false, because this user does not need to 

manually log in.
2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Additional Groups list, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.

Running the Linux Vibe Installation Program
When you run the Vibe installation program for the first time, you typically want to use the GUI 
interface. However, if you are installing Vibe on a server where the X Window System is not 
available, a text-based installation program is also available. After you are familiar with the Vibe 
installation process, you can use a silent installation to automate the process.

 “Using the GUI Installation Program” on page 73
 “Using the Text-Based Installation Program” on page 74
 “Performing a Silent Installation” on page 75
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Using the GUI Installation Program
1 In a terminal window, enter su - to become the root user, then enter the root password.

You need root permissions in order to install the Vibe software, but you should not run the 
Vibe software as root.

2 Change to the directory where you downloaded and extracted the Vibe software.
3 Ensure that you have a license-key.xml file in the same directory with the Vibe installation 

program.
more license-key.xml
The Vibe installation program does not start without a license file in the same directory. If you 
have not already, rename the license file to be called license-key.xml.
For more information about licensing, see Chapter 13, “Updating Your Vibe License,” on 
page 93.

4 Enter the following command to start the Vibe installation program:

./installer-teaming.linux
5 Accept the License Agreement, then click Next.

6 Click Next to accept the default of New installation.

7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Single-server Installation Planning 

Worksheet to provide the information that the Vibe installation program prompts you for:

Installation Locations
Additional Extensions for View as HTML
Default Locale for OpenText Vibe
User ID for OpenText Vibe
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Built-In Administrator Name for Vibe
Network Information
WebDAV Authentication Method
Database Selection

Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm

Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users

Inbound Email Configuration
The installation program stores the information that it gathers in the installer.xml file in 
the same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 Verify that the JCE is properly configured.
11 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.

12 Continue with “Creating the Vibe Database” on page 75.

Using the Text-Based Installation Program
If you try to start the GUI Vibe installation program in an environment where the X Windows System 
is not running, the text-based Vibe Installation program starts. 
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If you want to use the text-based installation program in an environment where the GUI starts by 
default, use the following command in the directory where the installation program is located:

./installer-teaming.linux --text

IMPORTANT: The text-based Vibe installation program must be run in the same directory where the 
Vibe license file is located. If the license file is not in the same directory, the text-based installation 
program cannot find it.

The text-based installation program gathers the same configuration information as the GUI 
installation program does. This information is stored in the installer.xml file in the directory 
where you run the installation program.

The installation program does not write the information it gathers into the installer.xml file 
until you exit the installation program, and you cannot go back when you use the text-based 
installation program. Therefore, when you use the text-based installation program, you should plan 
your installation carefully in advance, using the Single-server Installation Planning Worksheet or the 
Advanced Vibe Installation Summary Sheet. If you make a mistake during the installation, continue 
to the end of the installation process and exit the installation program normally, so that all 
information is saved. Then run the text-based installation program again. Your previous information 
is supplied as defaults, and you can change the information as needed.

Performing a Silent Installation
If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe 
components. A silent installation makes this an easy process. 

1 Edit an existing installer.xml file so that it has the hostname of the server where you want 
to perform the silent installation and copy it to that server. 

2 In the directory where the installation program is located, use the appropriate command to run 
the Vibe installation program, depending on the action that you want the silent installation to 
perform:

./installer-teaming.linux --silent --install

./installer-teaming.linux --silent --upgrade

./installer-teaming.linux --silent --reconfigure
The Installation program obtains all the information it needs from the installer.xml file and 
completes the installation without user interaction. If you have manually modified index server 
scripts, such as the indexserver-startup.sh file as described in “Installing the Lucene 
Software” on page 143, all modifications will be lost when you perform a silent upgrade. To 
retain your modifications, you should upgrade with the GUI installation program, as described 
in “Using the GUI Installation Program” on page 73.

Creating the Vibe Database
Before you can start Vibe, you need to create the Vibe database. 

1 If you haven’t done so already, install the database on the Vibe server.
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For single-server installations running on Linux, we recommend that you install the PostgreSQL 
database, but other databases are also supported (see Step 3). For information about how to 
install the database on the Vibe server (on Linux), see “PostgreSQL on Linux” on page 66.
For more information about installing the database for a multi-server Vibe system, see 
Chapter 19, “Creating the Vibe Database on a Separate Server,” on page 135.

2 Ensure that the database already exists on the server that is running the Vibe software or on 
the remote server, depending on where you want to install the database. 

3 In the terminal window as root, change to the following directory, as follows:
cd /vibe_installation_source/temp-installer/db/scripts/sql
This directory contains the following scripts, one for each database type (MySQL/MariaDB, 
Microsoft SQL, Oracle, and Postgresql):
 mysql-create-empty-database.sql
 oracle-create-empty-database.sql
 postgresql-create-empty-database.sql
 sqlserver-create-empty-database.sql

4 (Optional) If you need to change the default database name from sitescape to something 
else, edit the .sql file for your database type to replace sitescape with the new name.

5 Use the database utility command for your database type to run the corresponding script for 
your database from the vibe_installation_source/temp-installer/db/scripts/
sql directory:

6 Change to the db directory in the Vibe installation:
cd /vibe_installation_source/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 postgresql-liquibase.properties
 sqlserver-liquibase.properties

MySQL/
MariaDB:

mysql -uadmin-username -ppassword < "mysql-create-empty-
database.sql"

Microsoft 
SQL:

psql -Uadmin-username -Ppassword -i sqlserver-create-empty-
database.sql
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;cd
SQL>@oracle-create-empty-database
SQL>quit;

Postgresql: psql -Uadmin-username < "postgresql-create-empty-database.sql"
You are prompted for the password that you set for the admin user.
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7 In a text editor, open the properties file that corresponds with your database type and make the 
applicable changes in both the Driver and referenceDriver sections. Save and close the 
text editor when you are finished making changes. 
 Change the username, password, referenceUsername, and referencePassword 

fields to reflect the username and password for accessing your database.
 (Conditional) If the database is running on a remote server, replace localhost with the IP 

address of the remote server.
 (Optional) If you changed the database name in Step 4 on page 76, change the url and 
referenceURL fields to reflect name of your Vibe database.

Save and close the text editor.
8 In the same directory, execute the following commands to create the database schema:
PATH=/opt/novell/teaming/jre/bin:$PATH
./manage-database.sh database_type updateDatabase
where database_type is one of the following: mysql, oracle, postgresql, or sqlserver.

NOTE: Extending the schema can take a while. Wait until the command prompt reappears.
You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

9 Start the Vibe server as described in “Starting Vibe on Linux” on page 81.
10 For security reasons, delete the password that you specified in Step 7:

10a Change to the following directory in your Vibe installation:
cd /vibe_installation_source/temp-installer/db

10b In a text editor, open the database script that corresponds with your database type to 
delete the password.

10c Save and close the properties file.
11 Continue with “Performing Post-Installation Tasks on Linux” on page 77.

Performing Post-Installation Tasks on Linux
 “Checking for Available Hot Patches” on page 78
 “Configuring Vibe to Start Automatically on Reboot” on page 78
 “Disabling Automatic Starting on Reboot” on page 78
 “Setting Up Port Forwarding on SLES 12” on page 79
 “Setting Up Port Forwarding on SLES 15” on page 80
 “Starting Vibe on Linux” on page 81
 “Checking the Status of the Vibe Server” on page 81
 “Restarting Vibe” on page 81
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 “Stopping Vibe” on page 82
 “Uninstalling Vibe” on page 82

Checking for Available Hot Patches
After you install Vibe, ensure that you check the Vibe download site where you downloaded the 
Vibe software for any hot patches that might be available.

Configuring Vibe to Start Automatically on Reboot
You can configure Vibe to start automatically each time you reboot the Linux server.

1 As the Linux root user, enter the following command:

systemctl enable vibe.service
The system returns a message that a symlink has been created.

2 To verify that automatic startup is turned on, enter the following command:

systemctl status vibe.service
The system returns a message containing 

Loaded: loaded (/usr/lib/systemd/system/vibe.service; enabled;
indicating that autoload is enabled.

IMPORTANT: Configuring Vibe to start automatically on a reboot doesn’t start the Vibe service. 
You must still use the systemctl start vibe.service command or restart the server to 
start Vibe.

Disabling Automatic Starting on Reboot
If you have configured Vibe to start automatically each time you reboot the Linux server and you 
want to disable this, do the following.

1 As the Linux root user, enter the following command:

systemctl disable vibe.service
The system returns a message that a symlink has been removed.

2 To verify that automatic startup is turned off, enter the following command:

systemctl status vibe.service
The system returns a message containing 

Loaded: loaded (/usr/lib/systemd/system/vibe.service; disabled;
indicating that autoload is disabled.

IMPORTANT: Disabling autostart on a reboot doesn’t stop the Vibe service. You must still use 
the systemctl stop vibe.service command or restart the server to stop Vibe.
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Setting Up Port Forwarding on SLES 12
In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up 
port forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports 
(8080 and 8443). In addition, you must set up port forwarding if you want to forward the default 
SMTP mail host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether you are using the Vibe 
server as a firewall.

 “Using the SuSEfirewall2 File” on page 79
 “Using iptables Commands on SLES 12 or 15” on page 79

Using the SuSEfirewall2 File
To enable port forwarding on a SUSE Linux server that uses SuSEfirewall2:

1 As the Linux root user, open the following file:
/etc/sysconfig/SuSEfirewall2

2 Find the following line:
FW_REDIRECT=""

3 Between the quotation marks, copy and insert the following string:

0/0,ip_address,tcp,80,8080 0/0,ip_address,tcp,443,8443 0/
0,ip_address,tcp,25,2525

4 Replace ip_address with the IP address of the Vibe server.
5 Save the SuSEfirewall2 file, then exit the text editor.
6 Use the following command to restart the firewall:
/sbin/SuSEfirewall2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been 
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port 
(25) has been forwarded to the Vibe internal mail host:
iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.

Using iptables Commands on SLES 12 or 15
Complete the following steps to avoid needing to run the iptables commands after every boot:

1 As the Linux root user, change to the /etc/init.d directory.
2 Open the after.local file in a text editor.
3 Copy/past the following commands to the end of the after.local file and save the file.
Installing and Setting Up a Basic Vibe Site 79



iptables -t nat -A OUTPUT -d localhost -p tcp --dport 80 -j REDIRECT --
to-ports 8080

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80 -j REDIRECT --
to-ports 8080

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 80 -j REDIRECT 
--to-ports 8080

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 443 -j REDIRECT -
-to-ports 8443

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 443 -j REDIRECT --
to-ports 8443

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 443 -j REDIRECT 
--to-ports 8443

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 25 -j REDIRECT --
to-ports 2525

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 25 -j REDIRECT --
to-ports 2525

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 25 -j REDIRECT 
--to-ports 2525 

4 Replace hostname with the hostname or IP address of the Vibe server.
The lines above are wrapped. When you copy/paste them into the text editor, if the lines are 
still wrapped, remove the hard returns so that you have nine iptables commands, each on its 
own line.

5 Save the /etc/init.d/after.local file, then exit the text editor. 
6 Reboot the Vibe server. Port forwarding should now be working again.

Setting Up Port Forwarding on SLES 15
When SLES15 SP4 or later server is installed with Vibe 4.0.x, then the Vibe default ports are 8443, 
8080 and internal SMTP port 2525 has to be configured. You can have URLs without a port specified.

Perform the following steps to configure port forwarding on the Vibe server:

1 Check if the firewall daemon is up and running:

systemctl status firewalld.service
2 Enable masquerading:

 firewall-cmd --zone=internal --add-masquerade
success

3 Configure port forwarding to your internal port 8443:

 firewall-cmd --zone=public --add-forward-
port=port=443:proto=tcp:toport=8443:toaddr=<IP>
success
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Similarly for the ports 8080 and 2525, 

# firewall-cmd --zone=public --add-forward-
port=port=80:proto=tcp:toport=8080:toaddr=<IP>

firewall-cmd --zone=public --add-forward-
port=port=25:proto=tcp:toport=2525:toaddr=<IP>

Starting Vibe on Linux
To start Vibe services, do the following:

1 In a terminal window, become root by entering su - and the root password.
2 Enter the following command to start Vibe:
systemctl start vibe.service
You must execute the teaming script as root, but the script runs Vibe as the user you selected 
in “Identifying Vibe’s Linux User and Group” on page 45 and specified during installation.

3 Ensure that Vibe is ready for work:
3a Change to the following directory:

/opt/novell/teaming/apache-tomcat/logs
3b Enter the following command to display the end of the Tomcat log:

tail --f catalina.out
At the end of the log file listing, you should see:

INFO: Server startup in nnnn ms 
4 Press Ctrl+C when you finish viewing the catalina.out file.

Checking the Status of the Vibe Server
You can see if Vibe is running by checking for its process ID (PID).

1 In a terminal window, enter the following command:
ps -eaf | grep teaming
You should see the Vibe PID number, along with a listing of configuration settings.

Restarting Vibe
You need to restart Vibe whenever you use the Vibe installation program to make configuration 
changes, as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 125.

1 As root in a terminal window, enter the following command:
systemctl restart vibe.service
You should see the same output as when you originally started Vibe.
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Stopping Vibe
1 As root in a terminal window, enter the following command:
systemctl stop vibe.service
You should see the same output as when you started Vibe.

2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teaming
The Vibe PID number, along with a listing of configuration settings, should no longer be 
displayed.

Uninstalling Vibe
If you move the Vibe site to a different server, you can delete the Vibe files from the original server 
to reclaim disk space. The default Vibe file locations are: 

For a complete list of your Vibe files, check the installer.xml file in the directory where you 
originally ran the Vibe installation program.

Windows: Installing and Setting Up a Basic Vibe Site
You should already have reviewed Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on 
page 41 and filled out the Single-server Installation Planning Worksheet. The following sections step 
you through the process of installing and starting OpenText Vibe on Windows:

 “Performing Pre-Installation Tasks on Windows” on page 82
 “Running the Windows Vibe Installation Program” on page 83
 “Creating the Vibe Database” on page 85
 “Performing Post-Installation Tasks on Windows” on page 87

Performing Pre-Installation Tasks on Windows
 “Verifying System Requirements” on page 83
 “Stopping an Existing Web Server” on page 83
 “Setting Environment Variables” on page 83

Vibe Software /opt/novell/teaming
Vibe File Repository and 
Lucene Index

/var/opt/novell/teaming

MySQL or MariaDB 
Database

/var/lib/mysql

Postgresql Database /var/lib/pgsql
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Verifying System Requirements
Ensure that the Windows server where you plan to install Vibe meets the system requirements listed 
in “Server Operating System Requirements” on page 23.

Stopping an Existing Web Server
If a web server is currently running on the Vibe server, stop it, and preferably disable it.

For example, to stop and disable the Internet Information Services (IIS) web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 In the Startup type drop-down list, select Disabled.
4 Click Stop, then click OK.

Setting Environment Variables
Ensure that the Windows PATH environment variable includes the path to your database server.

1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Check the PATH environment variable:

3a On the Advanced tab, click Environment Variables.
3b In the System variables list, locate the PATH environment variable.
3c If the path includes your database server software directory, click Cancel.

or
If the path does not include your database server software directory, add the directory, 
then click OK. 

Running the Windows Vibe Installation Program
1 Log in to the Windows server as a user with Administrator rights.
2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe 

software.
3 Ensure that there is a license-key.xml file in the directory.

The Vibe installation program does not start without a license file, and it has a different name 
when you download it.
For more information about licensing, see Chapter 13, “Updating Your Vibe License,” on 
page 93.

4 Double-click the installer-teaming.exe file to start the Vibe installation program.
5 Accept the License Agreement, then click Next.
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6 Click Next to accept the default of New installation.

7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Single-server Installation Planning 

Worksheet to provide the information that the Vibe installation program prompts you for:

Installation Locations
Default Locale for OpenText Vibe
Network Information
WebDAV Authentication Method
Database Selection

Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm

Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users

Inbound Email Configuration
Adding File Types for HTML Conversions
The installation program stores the information that it gathers in the installer.xml file in 
the same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is complete, click Finish to exit the Vibe installation program.
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Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.

11 Continue with “Creating the Vibe Database” on page 85.

Creating the Vibe Database

IMPORTANT: The following procedures are performed at the command prompt.

Before you can start Vibe, you need to create the Vibe database.

1 If you haven’t done so already, install the database on the Vibe server.
For single-server installations running on Windows, install either the MySQL/MariaDB, 
Postgresql, or Microsoft SQL database. (For information about how to install the PostgreSQL, 
MySQL or MariaDB database on the Vibe server (on Windows), see “PostgreSQL on Windows” 
on page 68 and “MySQL or MariaDB on Windows” on page 65).
For more information about installing the database for a multi-server Vibe system, see 
Chapter 19, “Creating the Vibe Database on a Separate Server,” on page 135.

2 Open a command prompt window, then change to the following directory in your Vibe 
installation-source location:
vibe_installation_source\temp-installer\db\scripts\sql
This directory contains the following scripts for each database type (MySQL/MariaDB, Microsoft 
SQL, and Oracle):
 mysql-create-empty-database.sql
 Oracle-create-empty-database.sql
 postgresql-create-empty-database.sql
 sqlserver-create-empty-database.sql

3 (Optional) If you need to change the default database name from sitescape to something 
else, edit the .sql file for your database type to replace sitescape with the new name.

4 Open a command terminal, then use the database utility command for your database type to 
run the corresponding script for your database from the vibe_installation_source/
temp-installer/db/scripts/sql directory:
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5 Change to the db directory in the Vibe installation:
vibe_installation_source\temp-installer\db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 postgresql-liquibase.properties
 sqlserver-liquibase.properties

6 In a text editor, open the properties file that corresponds with your database type and make the 
applicable changes in both the Driver and referenceDriver sections. Save and close the 
text editor when you are finished making changes.
 Change the database user name and password for accessing the database.
 (Conditional) Specify the IP address for the database if it is running on a remote server.

You need to replace localhost with the IP address of the remote server.
 (Optional) Change the name of the Vibe database (the default name of the Vibe database 

is sitescape, the name of the company that previously developed the Vibe software).
7 In the same directory, execute the following commands to create the database schema:
manage-database.bat database_type updateDatabase
For example, if you are using a Microsoft SQL database:
manage-database.bat sqlserver updateDatabase

NOTE: You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

8 Start the Vibe server as described in “Running Vibe as a Windows Service” on page 87 and 
“Running Vibe as a Windows Application” on page 89.

MySQL/
MariaDB:

mysql -uadmin-username -ppassword < "mysql-create-empty-
database.sql"

Microsoft 
SQL:

psql -Uadmin-username -Ppassword -i sqlserver-create-empty-
database.sql
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the databasecd.

Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@oracle-create-empty-database
SQL>quit;

Postgresql: psql -Uadmin-username < "postgresql-create-empty-database.sql"
You are prompted for the password that you set for the admin user.
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9 For security reasons, delete the password that you specified in Step 7:
9a Change to the following directory in your Vibe installation:

vibe_installation_source\temp-installer\db
9b In a text editor, open the database script that corresponds with your database type to 

delete the password.
10 Continue with “Performing Post-Installation Tasks on Windows” on page 87.

Performing Post-Installation Tasks on Windows
 “Checking for Available Hot Patches” on page 87
 “Running Vibe as a Windows Service” on page 87
 “Running Vibe as a Windows Application” on page 89
 “Uninstalling Vibe” on page 89

Checking for Available Hot Patches
After you install Vibe, ensure that you check on the Vibe download site where you downloaded the 
Vibe software for any hot patches that might be available.

Running Vibe as a Windows Service
 “Configuring Vibe as a Windows Service” on page 87
 “Starting Vibe as a Windows Service” on page 88
 “Configuring the Vibe Service to Start Automatically on Reboot” on page 88
 “Restarting the Vibe Service” on page 88
 “Stopping the Vibe Service” on page 88
 “Removing Vibe as a Windows Service” on page 88

Configuring Vibe as a Windows Service
The Vibe installation program created a service.bat file for configuring Vibe to run as a Windows 
service.

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows\x64

2 Copy all the files in the x64 directory to c:\Program Files\Novell\Teaming\apache-
tomcat\bin directory.

3 Use the following command to configure Vibe as a Windows service:
service.bat install Teaming
This creates a service named Apache Tomcat Teaming.
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Starting Vibe as a Windows Service

IMPORTANT: If you named your Vibe service something other than “Teaming,” substitute your 
service name for Teaming in the sections that follow.

1 On the Windows desktop, click Start > Windows Administrative Tools > Services.
2 Right-click Apache Tomcat 9.0 Teaming, then click Properties.
3 Select the Log On tab.
4 Click Local System Account > Apply > OK.

Configuring the Vibe Service to Start Automatically on Reboot
When you run Vibe as a Windows service, you can configure Vibe to start automatically each time 
you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic (Delayed Start), then click OK.

Restarting the Vibe Service
You need to restart Vibe whenever you use the Vibe installation program to make configuration 
changes, as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 125.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.

Stopping the Vibe Service
1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.
3 Close the Services window.

Removing Vibe as a Windows Service
The Vibe installation program creates a service.bat file that you can use to remove the Vibe 
service.

1 In the c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows directory, 
copy the files from the appropriate subdirectory—x64 or ia64.
If you are unsure which subdirectory is appropriate for your server, use the readme.txt file 
located in the windows directory as a reference.

2 Paste the files into the c:\Program Files\Novell\Teaming\apache-tomcat\bin 
directory.

3 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin
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4 Use the following command to configure Vibe as a Windows service:
service.bat remove Teaming
This removes a service named Apache Tomcat Teaming.

Running Vibe as a Windows Application
 “Starting Vibe as an Application” on page 89
 “Stopping Vibe as an Application” on page 89

Starting Vibe as an Application
The Vibe installation program created a startup.bat file for starting Vibe.

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin

2 Run the startup.bat file to start Vibe as an application.

Stopping Vibe as an Application
1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin

2 Run the shutdown.bat file to stop the Vibe application.

Uninstalling Vibe
If you move the Vibe site to a different server, you can delete the Vibe files from the original server 
to reclaim disk space. The default Vibe file locations are: 

For a complete list of your Vibe files, check the installer.xml file in the directory where you 
originally ran the Vibe Installation program.

Vibe Software c:\Program Files\Novell\Teaming
Vibe File Repository and 
Lucene Index

c:\Novell\Teaming

MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data
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12 12Adding Users to Your Vibe Site

After you have installed OpenText Vibe and ensured that Vibe starts successfully, you are ready to 
access your Vibe site from your web browser and add users.

 “Accessing Your Basic Vibe Site as the Site Administrator” on page 91
 “Creating a User” on page 92
 “Adding Vibe Users from Your LDAP Directory” on page 92

Accessing Your Basic Vibe Site as the Site Administrator
1 In your web browser, specify one of the following URLs, depending on whether you are using a 

secure SSL connection:

http://vibe_hostname
https://vibe_hostname

Replace vibe_hostname with the hostname or fully qualified domain name of the Vibe server 
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you 
do not need to include the port number in the Vibe URL.
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2 If this is the first time you have logged in to the Vibe site, log in using admin as the login name 
and admin as the password.
The Change Password dialog box is automatically displayed when you first log in to the Vibe site.
If this is not your first time logging in, log in using admin as the login name and your password.

Creating a User
For information about how to create a local user in the Vibe system, see “Creating a New Local User” 
in the  OpenText Vibe 4.0.8 Administration Guide.

Adding Vibe Users from Your LDAP Directory
Unless you have a very small OpenText Vibe site, you create Vibe users by synchronizing their user 
information from an LDAP directory service such as eDirectory, Active Directory, or GroupWise. 

For information about how to add users to your Vibe system via LDAP, see “Synchronizing Users and 
Groups from an LDAP Directory” in the  OpenText Vibe 4.0.8 Administration Guide.

IMPORTANT: Consider the following before you add users to your Vibe system:

 For a large Vibe site with thousands of users, the synchronization process can consume 
substantial server resources and can take some time to complete. Perform the initial import 
from the LDAP directory at a time when this processing does not conflict with other activities on 
the server.

 After they are added to the Vibe system, users could log into the Vibe site by using their 
eDirectory, Active Directory, or GroupWise user names and passwords. However, you should 
not invite users to access the Vibe site until after you have finished setting up the Vibe site, as 
described in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration Guide.
92 Adding Users to Your Vibe Site

https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bucj8x9
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#ldap
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#ldap
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bj5cq17
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo


13 13Updating Your Vibe License

Several Vibe license types are available:

 Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your 60-day evaluation license when you download the evaluation version of Vibe.
 Standard Vibe License: Purchased through a OpenText sales representative or OpenText 

partner.
The Standard Vibe License gives full Vibe functionality on a per-user basis.
After you purchase the Standard Vibe License, you can access your license key or view your 
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

If you are upgrading to a new version of Vibe, or if you originally installed Vibe with an Evaluation 
License, it is easy to update your Vibe site with a new license file.

1 Copy the new license file that you downloaded from one of the sources listed above into the 
directory where you originally ran the Vibe installation program.

2 Rename the existing license-key.xml file to a different name.
3 Rename the new license file to license-key.xml.
4 Stop Vibe.
5 Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic 

Installation option.
6 Click Next through all the installation program pages, then click Install to update your Vibe 

license.
7 Start Vibe.
8 Log in to the Vibe site as the Vibe administrator.
9 Click the admin link in the upper-right corner of the page, then click the Administration Console 

icon . 
10 Under Management, click License.
11 If the contents of the new license file are not displayed, click Reload Vibe License.
12 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site 
Maintenance” in the  OpenText Vibe 4.0.8 Administration Guide.
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14 14Setting Up Vibe

After you have installed and started OpenText Vibe, there are still administrative tasks to perform 
before your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following 
sections of the  OpenText Vibe 4.0.8 Administration Guide as you finish setting up your Vibe site.

 “Setting Up Initial Workspaces”
 “Planning and Controlling User Access to Workspaces and Folders”
 “Setting Up User Access to the Vibe Site”
 “Setting Up Site-Wide Customizations”
 “Configuring Email Integration”
 “Configuring Weekends and Holidays”
 “Configuring Real-Time Communication Tools”
 “Enabling Custom JSPs to Be Used on Your Vibe Site”
 “Enabling Custom JAR Files to Be Used on Your Vibe Site”
 “Setting Up Mirrored Folders”
 “Setting Up Zones (Virtual Vibe Sites)”
 “Adding Software Extensions to Your Vibe Site”
 “Using Remote Applications on Your Vibe Site”
 “Managing a Multiple-Language Vibe Site”
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IV IVAdvanced Installation and 
Reconfiguration

 Chapter 15, “Planning an Advanced Vibe Installation,” on page 99
 Chapter 16, “Performing an Advanced Vibe Installation,” on page 125
 Chapter 17, “Setting Configuration Options after Installation,” on page 127
 Chapter 18, “Advanced Vibe Installation Summary Sheet,” on page 129
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15 15Planning an Advanced Vibe Installation

The Advanced installation provides additional options for you to customize OpenText Vibe.

 “What Is an Advanced Installation?” on page 99
 “Distributing Different Data Types to Different Locations” on page 100
 “Using Advanced Network Information Settings” on page 101
 “Configuring Requests and Connections Configuration” on page 102
 “Configuring Web Services” on page 103
 “Changing Your Lucene Index Server Configuration” on page 103
 “Managing RSS Feeds” on page 105
 “Configuring Presence” on page 106
 “Configuring Single Sign-On with Novell Access Manager” on page 107
 “Configuring Single Sign-On with Internet Information Services for Windows” on page 108
 “Configuring Mirrored Folder Resource Drivers” on page 121
 “Installing the Vibe Software in a Clustered Environment” on page 123

As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record 
your decisions about the options you want to use.

What Is an Advanced Installation?
In addition to the Basic installation options described in “What Is a Basic Vibe Installation?” on 
page 41, the installation program for Vibe provides several advanced installation and configuration 
alternatives. You can implement the advanced options after performing a Basic installation, or you 
can have the installation program present all the options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

 Changing the session timeout
 Specifying a keystore file
 Specifying different directories for different types of data
 Configuring requests and connections configuration
 Disabling and enabling four different web services
 Changing the configuration of the Lucene Index Server
 Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
 Reconfiguring how RSS feeds are retained or disabling them entirely
 Enabling presence in conjunction with GroupWise Messenger
 Configuring a reverse proxy to accommodate single sign-on
 Configuring Windows Authentication
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 Configuring mirrored folders
 Installing Vibe in a clustered environment

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as 
your initial installation of the Vibe software:

 Setting up the Vibe file repository so that some types of files are located outside the Vibe file 
repository root directory. See “Distributing Different Data Types to Different Locations” on 
page 100 for Advanced installation instructions. You cannot move subdirectories within the 
Vibe file repository after they have been created.

 Installing the Vibe software on multiple servers to create a clustered environment. See 
Chapter 21, “Running Vibe on Multiple Servers,” on page 147 for Advanced installation 
instructions. The option to enable a clustered environment is available only during an Advanced 
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation 
first, in a test environment, before performing the Advanced installation to set up your permanent 
Vibe site.

Distributing Different Data Types to Different Locations
The default location for the OpenText Vibe file repository varies by platform:

Under the main Vibe file repository root directory are subdirectories for various kinds of data files 
that are not stored in the Vibe database (MySQL/MariaDB, Microsoft SQL Server, Oracle, or 
PostgreSQL). You can use an Advanced installation to store Vibe data files in various locations.

The data files not stored in the Vibe database are divided into several functional areas:

 Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.
 Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file 

repository.
By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to 
store data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache 
Jackrabbit website (http://jackrabbit.apache.org) for setup instructions.

 Extensions repository: Disk space consumption depends on the number of extensions you add 
to your Vibe site.
An extension is a software program that you can incorporate into your Vibe site in order to 
enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension 
that filters out advertisements. You or a Java developer can create custom extensions for your 
Vibe site. For more information about creating and using Vibe extensions, see the OpenText 
Vibe 4.0.8 Developer Guide.

Linux: /var/opt/novell/teaming
Windows: c:\Novell\Teaming
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 Archive store: A large consumer of disk space.
When entries are deleted, files that were attached to the deleted entries are retained in the 
archive store in order to meet compliance and archival goals. Previous versions of documents 
are also retained in the archive store. After files have been archived, they are inaccessible from 
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to 
manage the disk space occupied by the archive store.

 Cache store: Consumes less disk space than the file repository.
Information derived from the attachments (such as thumbnails, HTML renderings, scaled 
images), and word lists for indexing are stored in the cache store. 

 Lucene index: Takes only a fraction of the space consumed by the file repository.
The Lucene index contains only pointers to the actual data stored in the file repository. The 
index enables the Lucene search engine to perform very fast searches through large quantities 
of data.

The directories for the various types of data can be on the Vibe server or on a remote server. Data 
access is fastest if the data is local; however, depending on the size of your Vibe site and the types of 
data you store, the Vibe server might not be the best place to store all the Vibe data. If you want to 
store any of the data types on a remote server, you must ensure that the remote location of the data 
appears local to the Vibe server and that it is always available with read/write access.

Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Using Advanced Network Information Settings
 “Changing the Vibe Session Timeout” on page 101
 “Providing a Secure Keystore File” on page 102

Changing the Vibe Session Timeout
By default, if a user’s OpenText Vibe session is idle for four hours (240 minutes), Vibe logs the idle 
user out. For increased convenience to Vibe users, you can make the session timeout interval longer. 
For increased security for your Vibe site, you can make the session timeout shorter.

Linux: Mount the file repository to the Vibe server.

Windows: Map a drive from the Vibe server to the file repository.

Linux and 
Windows

Place the file repository on a SAN (storage area network) with read/write access. This 
alternative provides the most reliable remote location for the Vibe file repository. This is 
required for a clustered environment, as described in Chapter 21, “Running Vibe on Multiple 
Servers,” on page 147.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.
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Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Providing a Secure Keystore File
For your convenience, the Vibe software includes a self-signed public certificate that enables you to 
specify secure HTTP and listen ports during installation. This certificate is stored in the .keystore 
file in the following directory:

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public 
certificate with a public certificate issued by a valid certificate authority. 

If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP 
Browser Connections” in “Site Security” in the  OpenText Vibe 4.0.8 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Configuring Requests and Connections Configuration
You can configure the number of client requests and database connections that Vibe is able to 
support. 

If you have an extremely large Vibe site and you need to make numerous client requests and 
database connections, you might see improved performance by increasing these settings.

 Max Threads: The maximum number of simultaneous client request threads that Vibe is able to 
support. The default is 200 threads.

 Max Active: The maximum number of database connections that can be allocated from this 
pool at the same time.
If your database server license (for Oracle or MS SQL) restricts you from having more 
connections than the Vibe default of 50, you must specify a number that does not exceed your 
database server license.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.

Linux: /opt/novell/teaming/apache-tomcat/conf
Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.
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 Max Idle: The maximum number of database connections that can be idle in this pool at the 
same time. The default is 20 connections.

Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Configuring Web Services
When you install and set up your OpenText Vibe site, three web services are enabled by default; a 
fourth is available for selection. These web services enable programs to access information on your 
Vibe site just as users would. Allowing programmatic access to your Vibe site can be useful or can be 
viewed as a security risk.

 WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).
 HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/

rfc2617).
 Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote 

applications. For more information, see “Using Remote Applications on Your Vibe Site” in 
“VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration Guide.

 Anonymous access: Allows access to your Vibe site without authentication. It is similar to the 
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in 
“VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Changing Your Lucene Index Server Configuration
The default Lucene Index Server configuration is appropriate for a medium-sized OpenText Vibe site. 
If you have a larger Vibe site, you can change its Lucene Index Server configuration.

 “Understanding Indexing” on page 104
 “Changing Lucene Configuration Settings” on page 104
 “Running the Lucene Index Server in Its Own JVM” on page 105

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Requests and Connections Configuration, mark the maximum client request threads, maximum 
active database connections, and maximum idle database connections.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which web services you want enabled for your Vibe site. The first three are 
enabled by default. The fourth is disabled by default.
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 “Running the Lucene Index Server on a Remote Server” on page 105
 “Running Multiple Lucene Index Servers” on page 105

After planning your Lucene configuration, complete the planning process for additional Advanced 
installation features as needed, then perform the Advanced installation as described in Chapter 16, 
“Performing an Advanced Vibe Installation,” on page 125.

Understanding Indexing
The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can 
easily use the Find and Search features to retrieve the information that they need. Text posted in 
folder entries is easy to index, because the formatting is simple. However, text in attached files 
arrives in many different file formats, many of which require conversion before the text in the files 
can be indexed. Therefore, the Lucene Index Server is dependent on the available file conversion 
technology in order to perform its indexing function. For information about the file viewers that 
Vibe uses, see “File Viewer Support” on page 29.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In 
fact, you cannot access your Vibe site if the Lucene Index Server is not running.

Changing Lucene Configuration Settings
If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see 
improved performance by increasing these settings.

 Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a 
query. You need to increase this only if your Vibe site includes more than 10,000 users, groups, 
or teams.

 RAM in MB that may be used for buffering: The default is 256 MB for remote and high 
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount 
of RAM that is allocated for buffering documents and deletions before they are flushed to the 
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe 
installer.)

 Merge factor: The default is 10. This sets the number of index segments that are created on 
disk. When additional index segments are needed, existing segments are merged to keep the 
merge factor constant.

 Network interface for RMI service: (Optional) Specify the IP address or hostname for the 
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.
This is the hostname of the server where the Lucene Index is installed.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.
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Running the Lucene Index Server in Its Own JVM
By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe 
software. To leave more memory available for the Vibe software, you can configure the Lucene 
Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe software 
using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/basic/
rmi/index.jsp)) port, which by default is 1199.

To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own 
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a 
remote server. This includes manually installing the Lucene Index Server software on the Vibe server, 
as described in Chapter 20, “Installing the Lucene Index Server on a Separate Server,” on page 143.

Running the Lucene Index Server on a Remote Server
If the Lucene Index Server requires more memory, disk space, or CPU resources than are available on 
the Vibe server, you can move it to a remote server. This requires installing the Lucene Index Server 
software on that server. For instructions, see Chapter 20, “Installing the Lucene Index Server on a 
Separate Server,” on page 143.

Running Multiple Lucene Index Servers
Because the availability of the index is critical to the functioning of the Vibe site, you can install 
multiple Lucene Index Servers on multiple remote servers to provide high availability. For 
instructions, see Chapter 22, “Running Multiple Lucene Index Servers,” on page 155.

Managing RSS Feeds
By default, OpenText Vibe users can set up RSS feeds in folders on the Vibe site, as described in 
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the OpenText Vibe 4.0.8 User 
Guide. 

 “Configuring RSS Feeds” on page 106
 “Disabling RSS Feeds” on page 106

After planning the RSS settings, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 16, “Performing 
an Advanced Vibe Installation,” on page 125.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of localhost. Use the default RMI port number 
unless it is already in use on the server.
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Configuring RSS Feeds
The following aspects of RSS functionality on your Vibe site are configurable:

 Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days. 
You can decrease the number of days to reduce the amount of disk space occupied by the RSS 
files.

 Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the 
feed is no longer updated. Increase or decrease the retention time for inactive feeds to meet 
the needs of Vibe users and disk space considerations.

Disabling RSS Feeds
Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes user 
name and password information. If you do not want Vibe site users to be able to subscribe to RSS 
feeds from the Vibe site, you can disable this feature.

Configuring Presence
If you are using GroupWise Messenger as your instant messaging solution, you can configure 
OpenText Vibe to display a user’s Messenger presence information. For information about where 
presence information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the 
OpenText Vibe 4.0.8 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed. This enables you to send 
an instant message to the user, view the user’s personal workspace, follow the user, and more. 

In order to configure Messenger presence to be displayed in Vibe, you need the following 
information about the Messenger system during the Vibe installation:

 Server address: Specify the IP address or DNS hostname of the messaging agent for your 
Messenger system.

 Port: Specify the port number.
 Server user: Specify the Messenger user you created and assigned as the Service ACL in

“Integrating Vibe with GroupWise Messenger” in the GroupWise Messenger 18 Administration 
Guide.
Prior to Messenger 18, a Fully Qualified Domain Name (FQDN) was required; beginning with 
Messenger 18, just the userid is used.

 Password: Specify the password for the Allowed Service User that you want to log in to the 
Messenger system and retrieve presence information.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.
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For more information about the Allowed Service User, see “Integrating Vibe with GroupWise 
Messenger” in the GroupWise Messenger 18 Administration Guide.

 Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this 
certificate to identify the Messenger server.
If Messenger is installed on a separate server, copy the certificate from the Messenger server 
and place it in a location on the Vibe server that can be reached from the Vibe installation 
program.
The certificate is located in the following directory on the Messenger server:

To remove the certificate after you have already selected it, click Browse > Cancel.

Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

IMPORTANT: In order for Messenger presence to display in Vibe when using LDAP, you need to map 
presenceID to your authentication attribute in the Vibe LDAP configuration page. For example, 
presenceID=cn. For more information, see “Configuring Presence” in the  OpenText Vibe 4.0.8 
Administration Guide

Configuring Single Sign-On with Novell Access Manager
Novell Access Manager provides secure single sign-on access to your Vibe site by functioning as a 
reverse proxy server. Access Manager 4.5 SP1 IR1 is required for use with Vibe. You can download 
the required version of Access Manager from Novell Downloads (http://download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager 
3.1 Documentation website (http://www.novell.com/documentation/novellaccessmanager31). For 
instructions specific to Vibe, see “Configuring a Protected Resource for a Vibe Server” in the  
OpenText Vibe 4.0.8 Administration Guide.

After you have configured Novell Access Manager, you must configure your Vibe site with the NAM 
IP address or hostname. The Access Gateway IP and logout URL should have IP or hostname of NAM. 
When you configure the Vibe site to use the Access Gateway, the IP addresses that you specify are 
the only locations from which the Vibe site accepts logins. The logout URL is the location where 
users find themselves when they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through 
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the 
Access Gateway and some do not.

Linux: /opt/novell/messenger/certs
Windows: c:\Novell\Messenger\certs

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable GroupWise Messenger Presence, then list the 
information that the Vibe site needs to know in order to communicate with the Messenger system.
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Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 
Installation,” on page 125.

Configuring Single Sign-On with Internet Information 
Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-on 
experience, enabling users to automatically authenticate to Vibe after they log in to their individual 
workstations. Internet Information Services (IIS) provides this capability.

Before you implement Windows Authentication, consider the following limitations:

 IIS is best suited for an intranet environment. Because NTLM is a connection-based protocol, it 
does not work well with HTTP proxy servers.

 IIS does not support Guest Access.

After you configure the Vibe server to support Windows Authentication, complete the planning 
process for additional Advanced installation features as needed, then perform the Advanced 
installation as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 125.

 “System Requirements” on page 108
 “Planning Your IIS Installation and Configuration” on page 110
 “Configuring the Vibe Server to Support Windows Authentication” on page 111
 “Running the Vibe Installation Program” on page 116
 “Configuring Your Browser to Allow Access to the Vibe Site” on page 116
 “Bypassing Windows Authentication to Configure LDAP and Perform Other Tasks” on page 117
 “Logging In to the Vibe Site through Windows Authentication” on page 118
 “Editing Files through WebDAV with Windows Authentication” on page 119
 “Configuring IIS to Allow Uploading of Large Files to the Vibe Site” on page 120
 “Configuring IIS to Load Balance in a Clustered Environment” on page 120

System Requirements
Windows Authentication with IIS can be enabled for Vibe only in the following environments:

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have 
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname 
for WebDAV connections.
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Server
 Windows 2008 Server
 Windows 2008 R2 Server

IIS
 IIS 7 with IIS Manager with CGI and ISAPI components
 IIS 7.5 with IIS Manager with CGI and ISAPI components

Authentication Protocol
One of the following authentication protocols:

 NTLM
 Kerberos v5
 Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller
 Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service. For 
more information about configuring LDAP synchronization within Vibe, see “Gathering 
Directory Services Information” on page 59 and “Synchronizing Users and Groups from an LDAP 
Directory” in the  OpenText Vibe 4.0.8 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Services is also 
required.

For more information about installing and configuring the domain controller and other domain 
services to support Windows Authentication, refer to the appropriate Microsoft 
documentation.

Client
One of the following clients:

 Windows 7
 Windows XP

Browser
One of the following browsers, configured to support Windows Authentication:

 Internet Explorer
 Firefox

For information on how to configure your browser to support Windows Authentication, see 
“Configuring Your Browser to Allow Access to the Vibe Site” on page 116.
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Planning Your IIS Installation and Configuration
Use the information in the following table as you consider your IIS installation.

Directory: The default installation directory for the IIS plug-in is C:\Program Files\Novell. 
This is the recommended directory. If for some reason you choose to install the IIS plug-in in a 
directory other than the C:\Program Files\Novell directory, you need to modify the 
isapi_redirect.properties files, as described in “Installing the Vibe IIS Plug-In” on 
page 111.

External or Local Server: You can install the IIS plug-in on the same server where you are running 
Vibe, or you can install it on an external server. Installing IIS on an external server can have the 
following benefits:

 Performance improvement
 Ability to integrate with several Vibe servers in a clustered environment
 Ability to run Vibe from a non-Windows server

If you are running IIS from an external server, you need to edit the C:\Program 
Files\Novell\Vibe IIS Plugin\conf\workers.properties file, as described in 
“Installing the Vibe IIS Plug-In” on page 111.

64-bit/32-bit: You can install the IIS plug-in on a 64-bit or 32-bit operating system. However, Vibe 
should run on a 64-bit operating system; therefore, if you install IIS on a 32-bit operating system, 
you should use an external server.

HTTP Ports: Regardless of whether IIS and Vibe are located on the same server or separate 
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures 
that when links are generated, they contain the correct hostname and port number. 

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single 
server without Windows Authentication), the HTTP ports can be the same as the listen ports. 
However, in a Vibe system with Windows Authentication enabled, the HTTP ports correspond 
with the ports that the IIS server is configured to use.

Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen 
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you 
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the 
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 16, “Performing an 
Advanced Vibe Installation,” on page 125.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with IIS for Windows Authentication, select Enable Integration with IIS for 
Windows Authentication, then list the logout URL.
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Configuring the Vibe Server to Support Windows Authentication
To configure the Vibe server to support Windows Authentication, you must first configure IIS. You 
can set up IIS on the same server where Vibe is running, or on a separate server. See “Planning Your 
IIS Installation and Configuration” on page 110 for more information.

Complete the instructions in the following sections to ensure that IIS is configured correctly to work 
with Vibe.

 “Installing the Vibe IIS Plug-In” on page 111
 “Installing ISAPI and GCI” on page 112
 “Installing Windows Authentication Role Service” on page 112
 “Creating and Managing Vibe Resources with IIS Manager” on page 112

Installing the Vibe IIS Plug-In
1 Locate the teaming-version-iis-plugin.zip file from the Vibe distribution, then unzip it 

into the C:\Program Files\Novell directory.
This creates a directory called Vibe IIS Plugin.

2 If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into the 
C:\Program Files\Novell directory, continue with Step 3.
or
If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into a location 
other than C:\Program Files\Novell, you must complete the following steps:
2a Locate the isapi_redirect.properties file in each of the following directories: 

 Vibe IIS Plugin\resources1\bin
 Vibe IIS Plugin\resources2\bin

2b In each of the directories, open the isapi_redirect.properties file in a text editor.
2c Adjust the values of the log_file, worker_file and worker_mount_file properties 

to reflect the directory where you chose to unzip the teaming-version-iis-
plugin.zip file.

2d Save your changes and close both of the isapi_redirect.properties files.
3 If IIS and the Vibe server are located on the same server, continue with Step 4. 

or
If IIS and the Vibe server are located on separate servers, complete the following steps:
3a Locate the C:\Program Files\Novell\Vibe IIS 

Plugin\conf\workers.properties file.
3b Open the workers.properties file in a text editor.
3c Adjust the value of the worker.worker1.host property from localhost to the 

hostname or IP address of the Vibe server.
3d Save your changes and close the editor.
Planning an Advanced Vibe Installation 111



4 (Conditional) If you are running IIS on a 64-bit server, complete the following steps:
4a Locate the C:\Program Files\Novell\Vibe IIS Plugin\library\win64 

directory.
4b Copy the appropriate version of the .dll library and paste it into each of the following 

directories:
 C:\Program Files\Novell\Vibe IIS Plugin\resources1\bin
 C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin

Ensure that you copy the correct version of the .dll library. If you copy the incorrect 
version, you receive a 500 error when you try to access the Vibe site.

4c Delete the existing isapi_redirect.dll files from the C:\Program 
Files\Novell\Vibe IIS Plugin\resources1\bin directory, as well as from the 
C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin directory.

4d Rename the .dll library files that you copied in Step 4b to isapi_redirect.dll.
For example, if Vibe is running on an AMD64/EM64T platform, copy C:\Program 
Files\Novell\Vibe IIS Plugin\library\win64\amd64\isapi_redirect-
version.dll into the C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\bin and C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\bin directories, then delete the original isapi_redirect.dll 
file and rename isapi_redirect-version.dll to isapi_redirect.dll.

Installing ISAPI and GCI
1 Install the ISAPI and CGI components:

1a Launch the Web Platform Installer.
1b Search for isapi.
1c Add both the extensions and filters.

Installing Windows Authentication Role Service
If the Windows Authentication Role Service is not already installed, use the Add Roles and Features 
Wizard to add "Windows Authentication" to IIS/Web Server/Security.

Creating and Managing Vibe Resources with IIS Manager
Internet Information Services (IIS) Manager is used to complete the integration.

1 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2 In the Connections pane on the left side of the window, expand your server, then expand Sites.
3 Right-click Default Web Site, then click Add Virtual Directory.

The Add Virtual Directory dialog box is displayed.
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4 In the dialog box, specify the following information:
Alias: VibeResources1
Physical path: C:\Program Files\Novell\Vibe IIS Plugin\resources1\bin

5 Click OK.
6 Repeat Step 3 through Step 5 to add another virtual directory.

This time, specify the following information in the Add Virtual Directory dialog box:
Alias: VibeResources2
Physical path: C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin

7 In the Connections panel, select VibeResources1, then double-click Handler Mappings.

8 In the Actions pane, click Edit Feature Permissions.
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The Edit Feature Permissions dialog box is displayed.

9 Select Execute, then click OK.
10 Repeat Step 7 through Step 9 for the VibeResources2 virtual directory.
11 In the Connections pane, select Default Web Site, then double-click ISAPI Filters.
12 In the Actions panel, click Add.

The Add ISAPI Filter dialog box is displayed.

13 In the dialog box, specify the following information:
Filter name: VibeResources1
You must name the filter VibeResources1 for Windows Authentication to work successfully.
Executable: C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\bin\isapi_redirect.dll

14 Click OK.
15 Repeat Step 12 through Step 14 to add another ISAPI filter.

This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: VibeResources2
You must name the filter VibeResources2 in order for Windows Authentication to work 
successfully.
Executable: C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\bin\isapi_redirect.dll

16 In the Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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17 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.

18 In the dialog box, specify the following information:
ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\bin\isapi_redirect.dll
Description: VibeResources1
Allow extension path to execute: Select this option to allow the path to execute.

19 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.
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20 In the dialog box, specify the following information:
ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\bin\isapi_redirect.dll
Description: VibeResources2
Allow extension path to execute: Select this option to allow the path to execute.

21 In the Connections pane, select VibeResources1, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.
25 Perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe 

Installation,” on page 125.

Running the Vibe Installation Program
See “Choosing Windows Authentication” on page 51 for information about how to configure the 
Vibe installation program to support Windows Authentication, then follow the instructions for the 
advanced installation as described in Chapter 16, “Performing an Advanced Vibe Installation,” on 
page 125. 

Return here and continue with “Configuring Your Browser to Allow Access to the Vibe Site” on 
page 116.

Configuring Your Browser to Allow Access to the Vibe Site
After Windows Authentication has been enabled on the server, you need to configure the client 
browser to allow access to the Vibe site.

 “Internet Explorer” on page 116
 “Firefox” on page 117

Internet Explorer
1 In an Internet Explorer window, click Tools > Internet Options.

The Internet Options dialog box is displayed.
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2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.

3 Click Advanced.
4 In the Add this website to the zone field, specify the Vibe website.
5 Click Add > Close.

Firefox
1 In Firefox, specify about:config in the URL field.
2 Specify ntlm in the Filter window, then locate and select the network.automatic-ntlm-

auth.trusted-uris entry.
The Enter String Value dialog box is displayed.

3 Specify the DNS name of your Vibe site, then click OK.
For example, vibe.mycompany.com.

4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.

Bypassing Windows Authentication to Configure LDAP and 
Perform Other Tasks
After Windows Authentication is working on your Vibe server, you can bypass the Windows 
Authentication functionality by including the Vibe listening port in the Vibe URL. 

You need to do this in order to configure your LDAP directory.

1 In a web browser, specify your Vibe URL with the Vibe listening port.
For example, http://vibe:8080.
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The Vibe login page is displayed.

2 Log in to the Vibe site as the Vibe administrator.
3 Configure LDAP, as described in “Adding Vibe Users from Your LDAP Directory” on page 92.

You might also need to bypass Windows Authentication to access Vibe for the following reasons:

 To access a specific Vibe node in a clustered environment
 To troubleshoot the Vibe system

Logging In to the Vibe Site through Windows Authentication
After you have performed the configuration steps described in “Configuring the Vibe Server to 
Support Windows Authentication” on page 111 through “Configuring Your Browser to Allow Access 
to the Vibe Site” on page 116, users can access the Vibe site through Windows Authentication. Users 
who have been configured through LDAP and are already logged in to their individual workstations 
do not need to log in again to access the Vibe site. Users who are not already logged in before they 
access Vibe see the following dialog box:
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Editing Files through WebDAV with Windows Authentication
 “Achieving Single Sign-On When Editing Files through WebDAV” on page 119
 “Enabling Basic Authentication for WebDAV” on page 119

Achieving Single Sign-On When Editing Files through WebDAV
By default, when you edit a file in Vibe through WebDAV, you are prompted for your system login 
credentials before you can edit the file. However, when Windows Authentication is enabled on your 
Vibe server, you are no longer prompted for your system login credentials before you edit a file 
through WebDAV.

This functionality is supported only when you use Microsoft Office as your default document editor. 
When you use LibreOffice as your default document editor, Vibe allows you to edit files through 
WebDAV, but it still requires you to enter your system login credentials. The single sign-on 
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV
If you are using a version of LibreOffice that requires basic authentication (it does not support 
Windows Authentication), you need to configure your IIS server to support basic authentication. 
Supporting basic authentication enables Vibe users to edit files through WebDAV when using a 
document editor other than Microsoft Office.

NOTE: If you enable basic authentication on your IIS server, all users who access the Vibe site 
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer 
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on 
experience.

To enable basic authentication on your IIS server, you need to install the Basic Authentication Role 
Service.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (IIS).
3 Click Add Role Services.

The Add Role Services window is displayed.
4 Scroll to the Security section, then select Basic Authentication.
5 Click Next, then complete the installation.
6 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
7 In the Connections pane on the left side of the window, expand your server, expand Sites, then 

expand Default Web Site.
8 Select VibeResources1, then double-click Authentication.
9 Select Basic Authentication, then click Enable in the Actions panel.

10 Close the Internet Information Services (IIS) Manager.
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Configuring IIS to Allow Uploading of Large Files to the Vibe Site
By default, IIS might not allow you to upload large files to the Vibe site. This is caused by timeout 
restrictions as well as maximum upload size restrictions.

For information about how to configure IIS to allow you to upload large files, see article 925083 in 
the Microsoft Support Knowledgebase (http://support.microsoft.com/kb/925083).

Configuring IIS to Load Balance in a Clustered Environment
If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can 
configure IIS to balance the load of user requests from the multiple Vibe nodes, while still 
supporting Windows Authentication.

1 On the IIS server, locate the C:\Program Files\Novell\Vibe IIS 
Plugin\conf\workers.properties.clustered.template file, then open the file in a 
text editor.

2 Copy the contents of the file.
3 Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties 

file, then open the file in a text editor.
4 Paste the contents of the C:\Program Files\Novell\Vibe IIS 
Plugin\conf\workers.properties.clustered.template file that you copied in Step 2 
and into the C:\Program Files\Novell\Vibe IIS 
Plugin\conf\workers.properties file, overwriting the content that was previously there.

5 Replace the value of worker.worker1.host from first_hostname_or_ip with the hostname or IP 
address of your first Vibe node.

6 Repeat Step 5 for each additional Vibe node that is running in your environment. If you have 
more than two Vibe nodes, you should add an additional section to the workers.properties 
file for each additional node.
The values that you specify in the workers.properties file (for example, worker1, 
worker2, etc.) must exactly match the values that you specify as the JVM Route setting during 
the Vibe installation, as described in “Installing the Vibe Software on Multiple Servers” on 
page 148. 

7 Locate the C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\conf\uriworkermap.properties file, then open the file in a text 
editor.

8 Replace all instances of worker1 with balancer.
9 Repeat Step 7 and Step 8 for each Vibe node.

10 Locate the C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\conf\uriworkermap.properties file, then open the file in a text 
editor.

11 Replace all instances of worker1 with balancer.
12 Repeat Step 10 and Step 11 for each Vibe node.
13 Restart each Vibe node.
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14 Restart the IIS server:
14a Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
14b Select your server in the Connections panel, then click Restart in the Actions panel.

Configuring Mirrored Folder Resource Drivers
A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is 
directly accessible from the Vibe site. The files on the file system are accessed by the Vibe program 
through a resource driver, not directly by individual Vibe users. A resource driver defines how the 
Vibe program accesses the file system. 

During installation, you define the users and groups that can access the mirrored folder resource 
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe 
folders and use folder access controls to govern which users and groups can access the data in the 
mirrored folder. As a result, you can set up a small number of users who can create mirrored folders, 
and allow a larger number of users to access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of 
the actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively 
static data. Mirrored folders are also useful for making extremely large files available from your Vibe 
site without including them in the Vibe file repository.

Although the installation program allows you to set up three mirrored folder resource drivers during 
installation, you can set up and test just one to start with, and then set up additional resource drivers 
later. 

 “File System Type” on page 121
 “File System Directory” on page 122
 “File System Access” on page 122
 “Mirrored Folder Setup” on page 123

After planning mirrored folders, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 16, “Performing 
an Advanced Vibe Installation,” on page 125.

File System Type

IMPORTANT: Vibe mirrored folders are not supported on NSS volumes.

Vibe provides resource drivers for two different types of file systems:

 file: A directory in a regular file system on a Linux or Windows server.
 webdav: A directory on a web server that supports WebDAV (Web-based Distributed Authoring 

and Versioning). The WebDAV server must support HTTP Basic Authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a user name and a 
password when making a request from the WebDAV server.
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File System Directory
The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as 
the following conditions are met:

 The file system is accessible from the Vibe server by using a directory path specification that the 
Vibe server operating system understands.

 The file system is accessible through the standard java.io package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the path name, not the typical 
Windows backslashes (\). For example, use c:/Documents rather than c:\Documents.

If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you 
can edit the installer.xml file in the directory where you run the Installation program.

File System Access
Vibe offers several security options for controlling access to the data that resides on the file system.

 You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full 
read/write access.

 You can list specific Vibe users who are allowed to access the mirrored folder resource drivers 
and thereby create mirrored folders.

 You can list specific Vibe groups whose members are allowed to access the mirrored folder 
resource drivers and thereby create mirrored folders.

 For WebDAV mirrored folder resource drivers, you must also specify a user name and password 
that the Vibe program can use to access the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to 
mirror in your Vibe site.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you 
want to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that 
indicates what directory or data is being mirrored. For WebDAV mirrored folders, you must also specify 
the URL of the WebDAV host where the data is located.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for 
the mirrored data, along with users and groups that you want to have access to the resource driver. For 
a WebDAV mirrored folder, list a user name and password that provides access to the WebDAV server.
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Mirrored Folder Setup
After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource 
drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders” 
in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration Guide.

Installing the Vibe Software in a Clustered Environment
You must use an Advanced installation in order to install the Vibe software on multiple servers and 
set up a clustered environment. Setting up multiple Vibe servers, along with other clustering 
options, are described in Chapter 21, “Running Vibe on Multiple Servers,” on page 147.
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16 16Performing an Advanced Vibe Installation

You should already have reviewed Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on 
page 41 and filled out the Single-server Installation Planning Worksheet. You should also have 
reviewed Chapter 15, “Planning an Advanced Vibe Installation,” on page 99 and filled out the 
Advanced Vibe Installation Summary Sheet for those aspects of an Advanced installation that you 
want to implement for your OpenText Vibe site.

1 Follow the Basic installation instructions provided in Chapter 11, “Installing and Setting Up a 
Basic Vibe Site,” on page 71 for the platform where you are installing Vibe.

2 When you run the installation program, select Advanced on the Choose Installation Type page.

3 Use the information that you have gathered on the Single-server Installation Planning 
Worksheet and the Advanced Vibe Installation Summary Sheet to provide the information that 
the Vibe Installation program prompts you for:
Basic Installation Pages: 

Installation Locations
Default Locale for OpenText Vibe
User ID for OpenText Vibe (Linux only)
Network Information
WebDAV Authentication Method
Database Selection
Outbound Email Configuration
Inbound Email Configuration
Some Basic installation pages have additional options available when you perform an Advanced 
installation.
Advanced Installation Pages: 

Web Services
Lucene Configuration
RSS Configuration
Presence Configuration
Reverse Proxy Configuration
Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
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Vibe Cluster Configuration
The Installation program stores the information it gathers in the installer.xml file in the 
same directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced 
installation.

5 When the installation is complete, click Finish to exit the Vibe installation program.
Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem occurs during the installation, 
the installer.log file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described 
in Chapter 12, “Adding Users to Your Vibe Site,” on page 91.
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17 17Setting Configuration Options after 
Installation

After you install OpenText Vibe, following the instructions in Part III, “Single-server (Basic) 
Installation,” on page 33 or Part IV, “Advanced Installation and Reconfiguration,” on page 97, you can 
rerun the Vibe installation program to change configuration options or add new functionality to your 
Vibe site.

1 Stop Vibe.
2 Start the Vibe installation program as described in “Running the Linux Vibe Installation 

Program” on page 72 and “Running the Windows Vibe Installation Program” on page 83.

Because the Installation program finds an existing installer.xml file, it defaults to 
Reconfigure settings. 

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.

4 Click Yes.

5 Select Basic or Advanced, depending on the configuration settings that you want to change, 
then click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages: 

Installation Locations
Default Locale for OpenText Vibe
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User ID for OpenText Vibe (Linux only)
Network Information
WebDAV Authentication Method
Database Selection
Outbound Email Configuration
Inbound Email Configuration
Advanced Installation Pages: 

Web Services
Lucene Configuration
RSS Configuration
Presence Configuration
Reverse Proxy Configuration
Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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18 18Advanced Vibe Installation Summary 
Sheet

Installation Program Field Value for Your Vibe Site Explanation

Data Locations: 

Linux default:

/var/opt/novell/teaming
Windows default:

c:\Novell\Teaming
 Simple file repository
 Jackrabbit repository
 Extensions repository
 Cache store
 Lucene index

See “Distributing Different Data 
Types to Different Locations” on 
page 100.

Network Information: 

 Enable web services: 

No / Yes
 Session timeout

Default: 240 minutes
 Enable Tomcat access log: 

No / Yes
 Keystore file:

See “Using Advanced Network 
Information Settings” on page 101.

Network Information: 

 Max Threads

Default: 200
 Max Active

Default: 50
 Max Idle 

Default: 20

See “Configuring Requests and 
Connections Configuration” on 
page 102.

WebDAV Authentication Method 

 basic
 digest

See “Planning the WebDAV 
Authentication Method” on 
page 50.
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Web Services: 

 Enable WSS authentication
 Enable Basic authentication
 Enable token-based 

authentication
 Enable anonymous access

See “Configuring Web Services” on 
page 103.

Lucene Configuration: 

Configuration type: all

 Max booleans:

Default: 10000
 Merge factor:

10

See “Changing Lucene 
Configuration Settings” on 
page 104.

Server Lucene Configuration: 

Configuration type: server only

 Host:
 RMI port:

Default: 1199

See “Running the Lucene Index 
Server in Its Own JVM” on 
page 105.

High Availability Lucene 
Configuration: 

Configuration type: high availability 
only

Number of high availability search 
nodes:

 Service name:
 Service title:
 Host:
 RMI port:

 Service name:
 Service title:
 Host:
 RMI port:

See Chapter 22, “Running Multiple 
Lucene Index Servers,” on 
page 155.

RSS Configuration: 

Enable RSS: No / Yes

 Max elapsed days:
 Max inactive days:

See “Managing RSS Feeds” on 
page 105.

Installation Program Field Value for Your Vibe Site Explanation
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Presence Configuration: 

Enable presence: No / Yes

 Server address:
 Port:
 Server user:
 Password:
 Server Certificate:

See “Configuring Presence” on 
page 106.

Reverse Proxy Configuration: 

Enable Access Gateway: No / Yes

 Access Gateway address(es):
 Logout URL:
 Use Access Gateway for WebDav 

connections: No / Yes
 WebDAV Access Gateway 

address:

See “Configuring Single Sign-On 
with Novell Access Manager” on 
page 107.

Integration with IIS for Windows 
Authentication: 

Enable Integration with IIS for 
Windows Authentication: No / Yes

 IIS address(es):
 Logout URL:

See “Configuring Single Sign-On 
with Internet Information Services 
for Windows” on page 108.

Mirrored Folder Resource Driver 
Configuration: 

Enable file share: No / Yes

 Share type
 File
 WebDav

 Read only: No / Yes
 Title
 Root path
 Allowed users
 Allowed groups
 User
 Password
 Host URL

See “Configuring Mirrored Folder 
Resource Drivers” on page 121.

Installation Program Field Value for Your Vibe Site Explanation
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V VMulti-Server Configurations and 
Clustering

 Chapter 19, “Creating the Vibe Database on a Separate Server,” on page 135
 Chapter 20, “Installing the Lucene Index Server on a Separate Server,” on page 143
 Chapter 21, “Running Vibe on Multiple Servers,” on page 147
 Chapter 22, “Running Multiple Lucene Index Servers,” on page 155
 Chapter 23, “Running Multiple Database Servers,” on page 173
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19 19Creating the Vibe Database on a Separate 
Server

The default database location for OpenText Vibe is on the same server with the Vibe software, as 
described in “Database Location” on page 53. However, for better performance and scalability, you 
can install the database server (MySQL, MariaDB, Microsoft SQL, Oracle, or PostgreSQL) on a 
Separate server, and then use the scripts that are included with the Vibe software to manually create 
the Vibe database in any location that you prefer.

 “JDK 9 or Later Required to Run manage-database Script” on page 135
 “Creating a MySQL/MariaDB Database” on page 135
 “Creating a Microsoft SQL Database” on page 137
 “Creating an Oracle Database” on page 139
 “Creating a PostgreSQL Database” on page 140

NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part III, “Single-server (Basic) 
Installation,” on page 33 before attempting a more complex Vibe configuration.

JDK 9 or Later Required to Run manage-database Script
Creating the Vibe database by running the manage-database.sh script as instructed in the following 
sections, requires that the server have JDK 9 or later installed. Any Java release, such as IBM, Oracle, 
OpenJDK, and so on, meets this requirement.

Creating a MySQL/MariaDB Database
Before you begin, you should be familiar with standard database maintenance procedures.

For more information about MySQL, see the following references:

 MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
 MySQL 5.1 Reference Manual (http://dev.mysql.com/doc/refman/5.1/en)

For information on installing SLES 12 and using MariaDB, see the SLES 12 Documentation (https://
www.suse.com/documentation/sles-12/) and MariaDB (http://www.mariadb.com) web sites.

The following database tools can be helpful:

 MySQL GUI Tools (http://dev.mysql.com/downloads/gui-tools)
 SQLyog (http://www.webyog.com)
 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)
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To create the MySQL database:

1 Review the MySQL requirements listed in “Database Server Requirements” on page 24.
2 Ensure that the MySQL database server and client have been installed and configured, as 

described in “Installing and Running the Database Server” on page 63.
3 Ensure that the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the 
separate MySQL database server.

4 Ensure that you know the password for the MySQL root administrator user.
5 Ensure that innodb support is enabled. 

It is enabled by default. To verify that innodb support is enabled:
5a Enter the following command to access the MySQL monitor:

mysql -u root -p
For information on how to set a password for your MySQL database if you have not already 
done so, see “Configuring MySQL/MariaDB” on page 64.

5b Specify your password.
5c From the MySQL prompt, enter the following command to display status information 

about the server’s storage engines:

SHOW ENGINES\G
5d Locate the InnoDB engine, and ensure that innodb support is enabled.

6 Update the MySQL configuration file:
6a Locate the MySQL configuration file and open it in a text editor.

6b Under the [client] section, add the following line:

default_character_set = utf8
6c Under the [mysqld] section, add the following line:

character_set_server = utf8
Setting the character set to UTF-8 ensures that extended characters are handled correctly 
in the database.

6d (Conditional) For a system with multiple network interfaces, in the [mysqld] section, add 
the following line:

bind-address = mysql_server_address

Replace mysql_server_address with the IP address that you want MySQL to bind to 
and to listen on.

6e Save the updated configuration file, then exit the text editor.

Linux: /etc/my.cnf
Windows: c:\Program Files\MySQL\MySQL Server version\my.ini
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7 Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation 
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

8 In the directory where the Vibe Installation program is located on the database server, or in the 
location where you copied the teaming-4.0.n-db.zip file, unzip the teaming-4.0.n-
db.zip file.

9 Change to the db subdirectory.
10 Change to the db/scripts/sql subdirectory.
11 Copy the mysql-create-empty-database.sql script to a convenient temporary location 

on the server where you want to create the database, and ensure that your database 
management utility is on your path so that you can run it from that directory.

12 Specify the following command to run the MySQL database creation script:

mysql -uuser -ppassword < mysql-create-empty-database.sql
13 Configure MySQL to allow access from a separate server:

mysql -uuser -ppassword
mysql> grant all privileges on *.* 

-> to 'username'@'%'
-> identified by 'password' 
-> with grant option
-> ;

14 Edit the mysql-liquibase.properties file to use your specific credentials.
For example:
vi mysql-liquibase.properties

15 Populate the database that you just created:
./manage-database.sh mysql updateDatabase

16 Verify that the database tables were created:
mysql -uuser -p

17 Specify the password for the MySQL user.
18 Specify the following command to use the default Vibe database:

mysql> use sitescape;
A message indicating that the database has been changed is displayed.

19 Specify the following command to show that the tables were created:
mysql> show tables;

Creating a Microsoft SQL Database
Before you begin, you should be familiar with standard database maintenance procedures.

For more information about Microsoft SQL, see the following Microsoft Web Site (http://
www.microsoft.com/sqlserver/).
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The following database tool can be helpful:

 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

To create a Microsoft SQL database:

1 Review the Microsoft SQL requirements listed in “Database Server Requirements” on page 24.
2 Ensure that the Microsoft SQL Server and Client have been installed and configured properly.

IMPORTANT: Ensure that TCP/IP is enabled for the Microsoft SQL Server.

For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).

3 Ensure that the Microsoft SQL database client is also installed on the Vibe server.
The Vibe installation program needs the Microsoft SQL client in order to communicate with the 
Microsoft SQL database server.

4 When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe.

5 Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation 
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

6 In the directory where the Vibe Installation program is located on the database server, or in the 
location where you copied the teaming-4.0.n-db.zip file, unzip the teaming-4.0.n-
db.zip file.

7 Change to the db subdirectory.
8 Change to the db/scripts/sql subdirectory.
9 Use Microsoft SQL Server Management Studio to create the empty database:

9a Copy the sqlserver-create-empty-database.sql file from the db/scripts/sql 
subdirectory .

9b Execute the query to create the empty database.
When the database is created, you should see Command(s) completed successfully 
in the messages window.

10 Change to the db directory.
11 Edit the sqlserver-liquibase.properties file to use your administrator user name and 

password for the SQL database server.
12 Populate the database that you just created (requires that Java is installed):

run manage-database.bat sqlserver updateDatabase
13 Verify that the database tables were created by using Microsoft SQL Server Management 

Studio.
14 If desired, you can now uninstall Java. 
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Creating an Oracle Database
Before you begin, you should be familiar with standard database maintenance procedures.

For more information about your Oracle database, see the following references:

 Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/
)

 Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/
b14357/toc.htm)

The following database tool can be helpful:

 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

1 Review the Oracle database requirements listed in “Database Server Requirements” on page 24.
2 Ensure that the Oracle database server software has been installed and configured properly.

For more information, see Oracle Database (http://www.oracle.com/database).
3 Set up the Oracle database character set to support Unicode character encodings. 

Vibe requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle 
recommends AL32UTF8, because it has increased support for certain Asian languages. For more 
information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/
B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support 
Guide.

4 Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation 
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

5 In the directory where the Vibe Installation program is located on the database server, or in the 
location where you copied the teaming-4.0.n-db.zip file, unzip the teaming-4.0.n-
db.zip file.

6 Change to the db subdirectory.
7 Change to the db/scripts/sql subdirectory.
8 Edit the oracle-create-empty-database.sql script with your Oracle database password.

Original: 

drop user sitescape cascade;
create user sitescape identified by sitescape;
grant connect, resource to sitescape;
connect sitescape/sitescape;
(SiteScape is the name of the company that previously developed the Vibe software.)
Updated: 

drop user sitescape cascade;
create user sitescape identified by your_oracle_password;
grant connect, resource to sitescape;
connect sitescape/your_oracle_password;
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IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do 
not attempt to change the name of the database from the legacy default of sitescape.

9 Enter the following commands to run the database creation script:

sqlplus "/ as sysdba"
SQL> spool oracle-create-empty-database.out;
SQL> @oracle-create-empty-database;
SQL> quit

10 Check the resulting oracle-create-empty-database.out file for errors and resolve them.
11 Edit the oracle-liquibase.properties file to use your administrator user name and 

password.
For example:
vi oracle-liquibase.properties

12 Populate the database that you just created:
run ./manage-database.sh oracle updateDatabase

13 Verify that the database tables were created.

Creating a PostgreSQL Database
Before you begin, you should be familiar with standard database maintenance procedures.

For more information about PostgreSQL, see the PostgreSQL documentation on the web (https://
www.postgresql.org/docs/manuals/).

To create the PosgreSQL database:

1 Review the PostSQL requirements listed in “Database Server Requirements” on page 24.
2 Ensure that the PostgreSQL database server and client have been installed and configured, as 

described in “Installing and Running the Database Server” on page 63.
3 Ensure that the PostgreSQL database client is also installed on the Vibe server.

The Vibe installation program needs the PostgreSQL client in order to communicate with the 
PostgreSQL database server.

4 Ensure that you know the password for the PostgreSQL postgres administrator user.
5 Configure the socket connection method. 

5a As the root user, browse to /var/lib/pgsql/data.
5b Edit the pg_hba.conf file and change the following local and host lines to specify md5 

encryption, as follows:

local  all   all                  md5
host   all   all   127.0.0.1/32   md5
host   all   all   ::1/128        md5

5c Save the file.
5d Edit the postgresql.conf file.
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5e Make sure that the listen_addresses line is uncommented and configured to allow 
connection requests from all Vibe servers by specifying individual IP addresses or by 
replacing localhost with an asterisk (*).

5f Save and close the file.
5g Stop and restart the PostgreSQL system process.

6 Copy the teaming-4.0.n-db.zip file from the Vibe server where the Vibe installation 
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

7 In the directory where the Vibe Installation program is located on the database server, or in the 
location where you copied the teaming-4.0.n-db.zip file, unzip the teaming-4.0.n-
db.zip file.

8 Change to the db subdirectory.
9 Change to the db/scripts/sql subdirectory.

10 Copy the postgresql-create-empty-database.sql script to a convenient temporary 
location on the server where you want to create the database, and ensure that your database 
management utility is on your path so that you can run it from that directory.

11 Run the script to create your Vibe database:
psql -Uadmin-username < "postgresql-create-empty-database.sql"
You are prompted for the admin-user password.

12 Change to the db directory:
13 In a text editor, open the postgresql-liquibase.properties file and make the following 

changes: 
 Change the username, password, referenceUsername, and referencePassword 

fields to reflect the admin-username and password for accessing your database.
 Replace localhost with the addresses specified in Step 5e on page 141.
 (Optional) If you changed the database name, change the url and referenceURL fields 

to reflect name of your Vibe database.
Save and close the text editor.

14 In the same directory, make the manage-database.sh file executable by entering the 
following command:
chmod +x manage-database.sh

15 Use the following command to create the database schema:
./manage-database.sh postgresql updateDatabase

NOTE: You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

16 Start the Vibe server as described in “Starting Vibe on Linux” on page 81.
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17 For security reasons, delete the password that you specified in Step 13 by opening the 
postgresql-liquibase.properties file and removing the password from the password 
and referencePassword fields.

18 Save and close the properties file.
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20 20Installing the Lucene Index Server on a 
Separate Server

You can install the Lucene Index Server on a different server from where Vibe is running. If the 
Lucene Index Server is already running on the same server as Vibe, you can move the Lucene Index 
Server to a different server. 

Running the Lucene Index Server on a separate server allows both the Lucene Index Server and the 
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on a separate 
server, or moving the Lucene Index Server to a separate server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them. 
The RMI protocol used for the Lucene Index Server port works only within a trusted local area 
network (LAN).

 “Installing the Lucene Software” on page 143
 “Updating Your Vibe Site” on page 145
 “Managing a Separate Lucene Index Server” on page 145

NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part III, “Single-server (Basic) 
Installation,” on page 33 before attempting a more complex Vibe configuration.

Installing the Lucene Software
1 Ensure that there is no firewall between the Vibe server and the Lucene Index Server.
2 Copy the Lucene installation program from its original location in the same directory with the 

Vibe installation program to a convenient temporary directory on the separate server.
The file name for the Lucene Installation program varies by platform:

3 Change to the directory where you copied the Lucene installation program, then start it.
4 Accept the License Agreement, then click Next.
5 Select New installation, then click Next.
6 Browse to and select the directory where you want to install the Lucene Index Server, then click 

Next.

Linux: lucene-installer.linux
Windows: lucene-installer.exe
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The default location varies by platform:

7 Browse to and select the directory where you installed the JDK, then click Next.
8 Adjust the configuration of the Lucene Index Server, as described in “Changing Your Lucene 

Index Server Configuration” on page 103, then click Next.
9 Click Install to install the Lucene software.

10 (Conditional) On Linux, deselect Start Lucene server.
You must edit the Lucene Index Server startup script before you start the Lucene Index Server. 
Instructions are provided later in this procedure.

11 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately, 
deselect Start Lucene server.
For instructions on starting and stopping the Lucene Index Server manually, see “Managing a 
Separate Lucene Index Server” on page 145.

12 Click Finish.
13 (Conditional) On Linux:

13a Change to the following directory:

/opt/novell/teaming/luceneserver/indexserver/bin
13b Open the indexserver-startup.sh file in a text editor.
13c Add the following switch to the java launch command at the end of the script:

-Djava.rmi.server.hostname=ip_address

Rename ip_address with the IP address of the server where you installed the Lucene 
Index Server.

13d Save the indexserver-startup.sh file, then exit the text editor.
13e Start the Lucene Index Server.

For instructions on starting and stopping the Lucene Index Server manually, see “Managing 
a Separate Lucene Index Server” on page 145.

Moving the Lucene Index Server from the Vibe server to a separate server increases the scalability of 
your Vibe system, because the workload is distributed between two different physical servers. 
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site 
depends on the Lucene Index Server for full functionality. If that server goes down for some reason, 
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can 
further expand your Vibe system by setting up multiple Lucene Index Servers to provide high 
availability, as described in Chapter 22, “Running Multiple Lucene Index Servers,” on page 155.

Linux: /opt/novell/teaming/luceneserver
Windows: c:\Program Files\Novell\Teaming\luceneserver
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Updating Your Vibe Site
Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh 
Lucene Index Server installation, disregard this section.

1 Stop Vibe.
2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.

For information on how to start the installation program, see “Running the Linux Vibe 
Installation Program” on page 72 or “Running the Windows Vibe Installation Program” on 
page 83.

3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.

5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.
RMI Port: Use the same port number that you used when you installed the Lucene Index Server 
software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.

Managing a Separate Lucene Index Server
 “Linux: Managing a Separate Lucene Index Server” on page 145
 “Windows: Managing a Separate Lucene Index Server” on page 146

Linux: Managing a Separate Lucene Index Server
Use the following commands to start and stop the Lucene index server manually:
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/etc/init.d/indexserver start
/etc/init.d/indexserver stop
To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver

Windows: Managing a Separate Lucene Index Server
Use the following commands at a DOS command prompt to start and stop the Lucene index server 
manually:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\
indexserver-

startup.bat
c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\

indexserver-
shutdown.bat
To configure the Lucene Index Server to start automatically when the Windows server reboots, you 
can set it up as a scheduled task that runs at system startup.

1 On the Windows server where the Lucene Index Server is installed, click Start > All Programs > 
Accessories > System Tools > Scheduled Tasks.

2 Double-click Add Scheduled Task to open the Scheduled Task Wizard, then click Next to 
continue.

3 Click Browse, then browse to and double-click the indexserver-startup.bat file in the 
following directory:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin
4 In the Task name field, specify an informative name for the task, such as Lucene Index Server.

The default task name is the name of the batch file.
5 In the Perform this task field, select When my computer starts, then click Next.
6 Specify and confirm the Administrator password for the Windows server, then click Next.
7 Select Open advanced properties for this task when I click Finish, then click Finish.
8 Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks 
window.

9 Click File > Exit to close the Scheduled Task Wizard.
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21 21Running Vibe on Multiple Servers

By running Vibe on multiple servers, you can achieve high availability, including failover and load 
balancing, depending on how you configure your servers. You must perform an Advanced 
installation on each server in order to configure the Vibe software for such a clustered environment. 

 “Planning a Multi-Server Vibe Configuration” on page 147
 “Installing the Vibe Software on Multiple Servers” on page 148
 “Configuring a Web Application to Provide High Availability Functionality for Your Vibe Site” on 

page 151
 “Configuring Internet Information Services to Support Multiple Vibe Servers” on page 153

NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommended that you follow the instructions in Part III, “Single-server 
(Basic) Installation,” on page 33 before attempting a more complex Vibe configuration.

Planning a Multi-Server Vibe Configuration
 “Lucene Index Server Considerations” on page 147
 “Vibe File Repository Considerations” on page 147
 “Configuring Routing for Multicast IP on the Vibe Server” on page 148

Lucene Index Server Considerations
Before you can implement a multi-server Vibe configuration, you must move your Lucene Index 
Server away from the initial Vibe server, as described in Chapter 20, “Installing the Lucene Index 
Server on a Separate Server,” on page 143. 

Vibe File Repository Considerations
Before you implement a multi-server Vibe configuration, you must plan the Vibe file repository for 
the clustered Vibe servers. Your configuration must comply with the following restrictions:

 The Vibe file repository must be placed in a shared location that is accessible to each Tomcat 
instance.

 All Tomcat instances must be configured with the same path leading to the shared storage.

For background information on the contents of the Vibe file repository, see “Distributing Different 
Data Types to Different Locations” on page 100.
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Configuring Routing for Multicast IP on the Vibe Server
If you are planning to use ehcache as your hibernate caching provider, you might need to set up the 
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on 
your Vibe system, you might see a communication error when you start the Vibe server. For 
example, in the log file you might see the following:

Error starting heartbeat. Error was: No such device.
To prevent this error, or to fix the Vibe system after the error occurs:

1 Run the following command:

route add -net 232.0.0.0/8 dev eth0

Installing the Vibe Software on Multiple Servers
1 Update your existing Vibe server to participate in a multi-server configuration:

1a Stop Vibe.
1b Start the Vibe Installation program.

For information on how to start the installation program, see “Running the Linux Vibe 
Installation Program” on page 72 or “Running the Windows Vibe Installation Program” on 
page 83.

1c On the Installation Settings page, select Reconfigure Settings, then click Next.
1d On the Choose Installation Type page, select Advanced, then click Next.
1e Click Next to proceed through the installation pages where no changes are needed.
1f (Conditional) If you do not have the Single-server Installation Planning Worksheet and 

Advanced Vibe Installation Summary Sheet from the initial Vibe server installation, record 
the configuration of the initial Vibe server as you proceed through the installation pages.
Subsequent Vibe servers in the multi-server configuration must be installed with the same 
configuration settings as the initial Vibe server.

1g On the Vibe Cluster Configuration page, select Enable clustered environment to enable 
clustering.

1h On the first Vibe node, in the JVM Route field, specify worker1. On the second Vibe node, 
in the JVM Route field, specify worker2, and so forth for each Vibe node, incrementing the 
JVM Route setting. Each Tomcat instance should have a unique JVM Route setting.
worker1, worker2, and so forth are the default names for the matching values used for 
the reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse 
proxy, these are the default values. The JVM Route setting in the Vibe installer must match 
these values.

1i Select one of the following options for your hibernate caching provider:
ehcache: Ehcache is recommended for small clustered Vibe sites, and is included in the 
Vibe software. If you select this option, no further configuration is necessary. For more 
information, see Ehcache (http://ehcache.sourceforge.net).
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memcached: Memcached is recommended for medium to large clustered Vibe sites. 
Memcached is not included in the Vibe software. If you select this option, you must 
download and install memcached on each server that you plan to use for caching in your 
Vibe cluster. For information about downloading and installing memcached, see 
Appendix B, “Memcached Caching with Vibe,” on page 235. 
Depending on the cache provider you select, different options are displayed.

1j (Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify 
the following information on the Vibe Cluster Configuration page to configure ehcache:
Network interface for distributed cache service: Specify the IP address or hostname of the 
distributed cache service.
Multicast Group Address: (Optional) Specify the common multicast group IP address. Each 
clustered node recognizes other nodes in the cluster by means of this IP address.

IMPORTANT: Ensure you specify the same IP address on all Vibe nodes in the cluster. After 
you have set this IP address for each Vibe node, restart each node in succession, allowing 
each node to initialize before restarting the next.
Running Vibe on Multiple Servers 149



The default multicast group IP address is 232.0.0.1. If you have more than one clustered 
Vibe system (for example, one in the lab and one in production), or if you have another 
software product that is already using the default multicast group IP address, you must 
update this field for one system so that it uses an IP address other than the default.
Use an IP address in the range of 224.0.0.1 to 239.255.255.255.
Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes 
will communicate.

1k (Conditional) If you selected memcached as the hibernate caching provider in Step 1g, 
specify the following information on the Vibe Cluster Configuration page to configure 
memcached:
Server Addresses: Specify a list of memcached servers, with each server separated by a 
space. For example, hostname1:port hostname2:port hostname3:port

The server addresses listed here are all nodes within the Vibe cluster. Changes made to one 
Vibe node are immediately visible in other Vibe nodes. Ensure that the clock settings for 
each Vibe node are synchronized. Failure to do so can significantly degrade overall system 
performance.
Memcached is not included in the Vibe software. If you select memcached as your 
hibernate caching provider, you must download and install memcached on each server in 
your Vibe cluster. For information about downloading and installing memcached, see .

1l On the Ready to Install page, click Install.
1m On the Installation Complete page, click Finish.

2 Install the Vibe software on each additional server, using the same installation settings that you 
used for the initial Vibe server.

3 (Conditional) If you set up ehcache as the caching provider, on each Linux server where you 
installed the Vibe software, set the multicast route to enable the servers to function as a 
cluster:
3a Use the following command on the command line to immediately set the multicast route 

for the server:

route add -net 232.0.0.0/8 dev eth0
3b To run this command each time the server reboots, add the command to the following file 

on each server:

/etc/init.d/boot.local
4 Start Vibe on each server, as described for the platform where you are installing Vibe:

 “Starting Vibe on Linux” on page 81
 “Running Vibe as a Windows Service” on page 87
 “Running Vibe as a Windows Application” on page 89

5 (Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start 
because of a communication error, ensure that you have followed the steps in “Configuring 
Routing for Multicast IP on the Vibe Server” on page 148.

6 Continue with Configuring a Web Application to Provide High Availability Functionality for Your 
Vibe Site.
150 Running Vibe on Multiple Servers



Configuring a Web Application to Provide High Availability 
Functionality for Your Vibe Site

After Vibe is installed and running on multiple servers, you must provide additional software to 
provide high availability functionality. Because Vibe is based on Tomcat, you can use software that 
provides high availability for Tomcat.

1 Install and configure one of the following web applications to provide high availability for your 
Vibe site:
 Apache web server (http://www.apache.org)
 Linux Virtual Server (http://www.linuxvirtualserver.org)
 Novell Access Manager (https://www.netiq.com/products/access-manager/)
 Microsoft Internet Information Services (http://www.iis.net)

2 Configure the web application to establish the Vibe site URL, which then stays constant for Vibe 
users regardless of which Vibe server they access at any given time.

3 Start the web application with its new configuration settings.
4 Test your Vibe site for high availability.

 If you are using Apache web server, Linux Virtual Services, or Microsoft Internet 
Information Services, users can immediately log in to the Vibe site again after a failover has 
occurred. The connection between the user’s browser and the Vibe site is maintained as 
the failover occurs.

 If you are using Novell Access Manager, users must start a new browser session, and then 
log in to the Vibe site after a failover has occurred. They cannot log in again from the same 
browser session, because the connection between the user’s browser and the Vibe site 
must be reestablished after the failover.

The following sections provide examples of how to configure the web applications:

 “Configuring Apache as a Load Balancer” on page 151
 “Configuring Linux Virtual Server as a Load Balancer” on page 153

Configuring Apache as a Load Balancer
The following example configuration uses the balancer module built into the newer Apache (version 
2.2.4 and later) web server. It is based on a widely used sticky session technique. Vibe does not 
support session sharing/replication among Tomcat instances.

If you are using Novell Access Manager as described in “Configuring Single Sign-On with Novell 
Access Manager” on page 107, you do not need to configure Apache to load balance as described in 
this section, because Access Manager provides this service.

NOTE: When you update your Vibe system, these settings are not preserved. You must redefine 
these settings each time you update your Vibe system.
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To configure Apache to load balance:

1 Install the Apache web server (http://httpd.apache.org) on one server.
2 Edit the /etc/sysconfig/apache2 file:

2a Locate the following line:

APACHE_MODULES=
Then add the following lines:

proxy
proxy_ajp
proxy_balancer
The end result should look similar to the following:

APACHE_MODULES="actions alias auth_basic authn_file authz_host 
authz_groupfile authz_default authz_user authn_dbm autoindex cgi dir 
env expires include log_config mime negotiation setenvif ssl suexec 
userdir php5 reqtimeout proxy proxy_ajp proxy_balancer"

2b Create the following new configuration file:

/etc/apache2/httpd.conf.vibe
2c Add the following section to the /etc/apache2/httpd.conf.vibe file, providing a 

BalancerMember line for each jvmRoute value in a Tomcat server.xml file.

<Location /balancer-manager>
SetHandler balancer-manager
Order deny,allow
Deny from all
Allow from 127.0.0.1

</Location>
<Proxy balancer://cluster_name>

BalancerMember ajp://vibe_server_1:8009 route=worker1
BalancerMember ajp://vibe_server_2:8009 route=worker2

</Proxy>
<Location />

ProxyPass balancer://cluster_name/ stickysession=JSESSIONID
</Location>
The values that you specify for the route setting (for example, worker1, worker2, etc.) 
must exactly match the values that you specify as the JVM Route setting during the Vibe 
installation, as described in “Installing the Vibe Software on Multiple Servers” on page 148. 

2d Save the httpd.conf.vibe file.
3 Reconfigure each Vibe server in the cluster so that each server has the same network 

information (hostname and ports) as the Apache web server.
For each Vibe server in the cluster:
3a Run the Vibe installation program by reconfiguring the Vibe server.

For information about how to reconfigure your Vibe server, see Chapter 17, “Setting 
Configuration Options after Installation,” on page 127.
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3b On the Network Information page in the Vibe installation program, change the hostname in 
the Host field for each Vibe server. The hostname must match the DNS name that users use 
to access the Vibe service.
For example, if the URL for you Vibe site is vibe.acme.com, you would specify 
vibe.acme.com in this field.

3c Continue through the Vibe installation program for each Vibe server in the cluster, as 
described in Chapter 17, “Setting Configuration Options after Installation,” on page 127.

4 Restart Apache.

TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system 
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular 
expression configuration from the following:

SetEnvIf User-Agent ".*MSIE.*" \
nokeepalive ssl-unclean-shutdown \
downgrade-1.0 force-response-1.0
to the following:

SetEnvIf User-Agent ".*MSIE [1-5].*"
nokeepalive ssl-unclean-shutdown
downgrade-1.0 force-response-1.0

SetEnvIf User-Agent ".*MSIE [6-9].*"
ssl-unclean-shutdown

Configuring Linux Virtual Server as a Load Balancer
Consult the following online sources for instructions on setting up Linux Virtual Server as a load 
balancer for your Vibe site:

 The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
 Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)
 Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)

Configuring Internet Information Services to Support 
Multiple Vibe Servers

You can configure Internet Information Services (IIS) to support multiple Vibe servers. For more 
information, see “Configuring IIS to Load Balance in a Clustered Environment” on page 120.
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22 22Running Multiple Lucene Index Servers

Your Vibe site depends on the Lucene Index Server for full functionality. Different Lucene 
configurations provide different levels of scalability and reliability.

You can install the Lucene Index Server on a different server from where Vibe is running so that both 
programs have access to more server memory, disk space, and CPU resources. However, the Vibe 
server and the Lucene Index Server must not have a firewall between them. The RMI protocol used 
for the Lucene Index Server port works only within a trusted local area network (LAN).

 A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe 
software is installed.

 To provide additional memory for the Lucene Index Server, you might already have configured it 
to run in its own memory space, as described in “Running the Lucene Index Server in Its Own 
JVM” on page 105. 

 To provide additional disk space and memory for the Lucene Index Server, you might already 
have moved it to a different server, as described in Chapter 20, “Installing the Lucene Index 
Server on a Separate Server,” on page 143.

These configurations provide additional resources for the Lucene Index Server, but it is still a single 
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes 
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene 
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index Servers 
are still available.

 “Planning a High Availability Lucene Configuration” on page 155
 “Setting Up a High Availability Lucene Configuration” on page 156
 “Testing Your Lucene High Availability Configuration” on page 168
 “Synchronizing a High Availability Lucene Configuration” on page 170

NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part III, “Single-server (Basic) 
Installation,” on page 33 before attempting a more complex Vibe and Lucene configuration.

Planning a High Availability Lucene Configuration
A high availability Lucene Index Server configuration must include at least two different servers 
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodes in a 
high availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default 
location for the index files for the Lucene Index Server varies by platform:
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As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation 
Summary Sheet to record the options you want to use.

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and 
title identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens 
on RMI port 1199 on its server, but you can configure it to use a different port number if the default 
port number is already in use.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the 
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are 
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming 
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol 
used for the Lucene Index Server port works only within a trusted local area network (LAN).

Setting Up a High Availability Lucene Configuration
 “Changing from a Local Lucene Index Server” on page 156
 “Changing from a Single Lucene Index Server” on page 159
 “Expanding an Existing High Availability Lucene Configuration” on page 162
 “Changing Your Lucene Configuration without Vibe Site Down Time” on page 164

Changing from a Local Lucene Index Server
To change from a local Lucene Index Server running on the Vibe server, you must install the Lucene 
Index Server on two or more separate servers, and then reconfigure Vibe for a high availability 
Lucene configuration.

Linux: /var/opt/novell/teaming/lucene
Windows: c:\Novell\Teaming\lucene

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in 
your high availability Lucene configuration.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port 
number for each Lucene node.
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NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the 
“separate” Lucene nodes, this is not a recommended configuration. Consider it only if you are 
restricted to two servers for your Vibe site.

1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in “Installing the Lucene 

Software” on page 143.
1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each 

additional Lucene node.
The default location for the index files varies by platform:

1c Start the Lucene Index Server on each Lucene node, as described in “Managing a Separate 
Lucene Index Server” on page 145.

2 Stop Vibe.
If you have installed the Vibe software on multiple servers, as described in Chapter 21, 
“Running Vibe on Multiple Servers,” on page 147, stop Vibe on all servers, or follow the 
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on 
page 164.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where you 
have installed and started the Lucene Index Server.

Linux: /var/opt/novell/teaming/lucene
Windows: c:\Novell\Teaming\lucene
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3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration 

information for each Lucene node from the Advanced Vibe Installation Summary Sheet 
that you filled out in “Planning a High Availability Lucene Configuration” on page 155, then 
click Next.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.

4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then 
click Close.
The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 168.

Changing from a Single Lucene Index Server
To change from a single Lucene Index Server to a high availability configuration, you must install the 
Lucene Index Server on one or more additional servers, and then reconfigure Vibe for additional 
Lucene nodes.

1 Bring down your Vibe site:
1a Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 21, 
“Running Vibe on Multiple Servers,” on page 147, stop Vibe on all servers, or follow the 
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on 
page 164.

1b Ensure that the existing Lucene Index Server also stops.
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2 Set up one or more additional Lucene nodes:
2a Install the Lucene Index Server on each additional server, as described in “Installing the 

Lucene Software” on page 143.
2b (Optional) Copy accumulated index data from the initial Lucene node to each additional 

Lucene node.
The default location for the index files varies by platform:

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Separate 
Lucene Index Server” on page 145, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Change server to high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where you 
have installed the Lucene Index Server.

3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration 

information for each Lucene node from the Advanced Vibe Installation Summary Sheet 
that you filled out in “Planning a High Availability Lucene Configuration” on page 155, then 
click Next.

Linux: /var/opt/novell/teaming/lucene
Windows: c:\Novell\Teaming\lucene
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3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.

4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 168.

Expanding an Existing High Availability Lucene Configuration
After you have set up an initial high availability Lucene configuration, you can add additional Lucene 
nodes at any time.

1 Bring down your Vibe site:
1a Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 21, 
“Running Vibe on Multiple Servers,” on page 147, stop Vibe on all servers, or follow the 
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on 
page 164.

1b Stop all Lucene nodes, as described in “Managing a Separate Lucene Index Server” on 
page 145.

2 Set up one or more additional Lucene nodes:
2a Install the Lucene Index Server on each additional server, as described in “Installing the 

Lucene Software” on page 143.
2b (Optional) Copy accumulated index data from an existing Lucene node to each additional 

Lucene node.
The default location for the index files varies by platform:

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Separate 
Lucene Index Server” on page 145, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, increase the number of nodes in the Number of high 

availability search nodes field, then click Next.

Linux: /var/opt/novell/teaming/lucene
Windows: c:\Novell\Teaming\lucene
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3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each additional Lucene node, then click Next.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Vibe.
3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.

4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 168.

Changing Your Lucene Configuration without Vibe Site Down 
Time
Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers, 
as described in Chapter 21, “Running Vibe on Multiple Servers,” on page 147.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in “Installing the Lucene 

Software” on page 143
1b Start the Lucene Index Server on each Lucene node, as described in “Managing a Separate 

Lucene Index Server” on page 145.
2 Stop Vibe on one server.

The other Vibe servers remain in service for users and continue to communicate with the 
original Lucene Index Server.

3 Run the Vibe installation program on the Vibe server that you stopped to configure it for 
multiple Lucene Index Servers:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
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3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields.

Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where you 
have installed the Lucene Index Server.

3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration 

information for each Lucene node from the Advanced Vibe Installation Summary Sheet 
that you filled out in “Planning a High Availability Lucene Configuration” on page 155, then 
click Next.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.

4 Start the reconfigured Vibe server.
Running Multiple Lucene Index Servers 165



5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:

IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional 
Lucene nodes.

5a Log in to the reconfigured Vibe server as the Vibe administrator, using the server hostname 
rather than your Vibe site URL.

5b Click your linked name in the upper right corner of the page, then click the Administration 
Console icon . 

5c Under Search Index, click Nodes.

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. When you set up a high availability Lucene configuration 
without Vibe site down time, you need to prevent write access during the reconfiguration 
process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene 
nodes.

5e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Vibe server does 
not communicate with the additional Lucene nodes. 

6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6c Start each reconfigured Vibe server.

7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Log in to the reconfigured Vibe as the Vibe administrator.
7b Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
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7c Under Search Index, click Nodes.

7d In the User Mode Access box, change No Access to Write Only for the additional Lucene 
nodes.

7e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Vibe servers can 
now communicate with the additional Lucene nodes, although user access is still 
disallowed. 

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index 
data that the original Lucene Index Server has:
8a On the Administration page, under Search Index, click Index.

8b On the Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is 
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process. 
However, because one or more previously existing Lucene Index Servers are still servicing 
the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is complete, click Close.
9 Make the additional Lucene nodes available to Vibe users:

9a On the Administration page, under Search Index, click Nodes.

9b In the User Mode Access box, change Write Access to Read and Write for the additional 
Lucene nodes.

9c Click Apply, then click Close.
The new setting is put into effect immediately, so that Vibe users have additional Lucene 
Index Servers available as they use the Vibe site.

Testing Your Lucene High Availability Configuration
When you first set up your high availability Lucene configuration, you can configure Vibe to write 
Lucene node information to the Tomcat log file so that you can observe the behavior of the Lucene 
nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe site. 
This process helps you prepare for the situation where a Lucene node goes down unexpectedly or 
you need to take one down on purpose, perhaps for maintenance.

 “Configuring Vibe to Log Lucene Node Activity” on page 169
 “Observing Lucene Node Activity” on page 169

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the  OpenText Vibe 4.0.8 Administration Guide.
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Configuring Vibe to Log Lucene Node Activity
By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a 
Lucene node. For testing purposes, you can change the logging level so that the Tomcat log file 
includes a message for each time Vibe contacts a Lucene Index Server. 

After observing and understanding the behavior, you should return the logging to normal levels.

1 Open the log4j2.properties file in a text editor.
The location of the log4j2.properties file varies by platform. 

2 Search for the following line:

logger.com_novell_teaming_search.name=com.novell.teaming.search
logger.com_novell_teaming_search.level=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level 
for the Lucene Index Server.
The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.

4 Save the log4j2.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

Observing Lucene Node Activity
After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat 
log file to see which Lucene nodes Vibe is contacting.

1 Change to the directory where the Tomcat log file is located.
For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the  OpenText Vibe 4.0.8 Administration Guide.

2 On Linux, use the tail command to monitor the end of the Tomcat log file.
tail -f catalina.out
or
On Windows, download an equivalent command from the Internet in order to perform the 
following steps.
For example, there is a command available at SourceForge.net (http://sourceforge.net/
projects/tailforwin32).

3 Perform some activities on the Vibe site to create new content.
For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting 
each available Lucene Index Server in turn as it submits the new information for indexing. 
Nodes are considered available if they are marked Read and Write in the User Mode Access box 
on the Lucene Nodes page.

4 Bring down one of the Lucene nodes.

Linux: /opt/novell/teaming/luceneserver/indexserver/lib

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf
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For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or 
otherwise prevent Vibe from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
6 Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the Lucene node that is no longer 
available.

7 Observe that the Tomcat log file shows when normal Vibe processing has resumed without 
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.
9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene 

node that was temporarily unavailable.
The journal record contains the indexing operations that failed to take place while the Lucene 
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it 
until it has been synchronized with the latest index information.

10 To synchronize the out-of-date Lucene node, follow the steps in “Synchronizing a High 
Availability Lucene Configuration” on page 170.
After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.

If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box on 
the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write Only. 
If no nodes are set to Write Only or Read and Write, Vibe temporarily accesses the first node in the 
list, even though it is set to No Access. This functionality is required because you cannot log in to the 
Vibe site without access to a Lucene Index Server.

Synchronizing a High Availability Lucene Configuration
You should ensure that your Lucene node servers remain in sync with each other. Whenever a 
Lucene node is down for a relatively short period of time (no more than one or two days), you can 
synchronize it with other Lucene nodes whose index files are up-to-date.

1 Ensure that the out-of-date Lucene node is running reliably again.
2 Log in to the Vibe site as the Vibe administrator.
3 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
4 Under Search Index, click Nodes.
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5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index, 
then click Apply.
The Deferred Update Log options disappear if the update is successful. If for some reason the 
deferred update log records cannot be applied to the index, you can rebuild the index, as 
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the  OpenText Vibe 4.0.8 
Administration Guide.

6 Click Close.
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23 23Running Multiple Database Servers

Each of the four databases supported by OpenText Vibe (MySQL, MariaDB, Microsoft SQL, Oracle, 
and PostgreSQL) has its own approach to clustering the database server. Information about 
clustering database servers is available on the Internet, for example:

 MySQL Cluster (http://www.mysql.com/products/database/cluster)
 MariaDB (https://mariadb.com/kb/en/mariadb/galera-cluster/)
 SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/

clustering_intro_p1.aspx)
 Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/

clustering)
 PostgreSQL High Availability (https://www.postgresql.org/docs/9.6/static/high-availability.html)

NOTE: We highly recommend that you follow the instructions in Part III, “Single-server (Basic) 
Installation,” on page 33 before attempting a more complex Vibe configuration.
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 Chapter 24, “Upgrading From Novell Vibe 4.x to OpenText Vibe 4.0.5 or Later,” on page 177
 Chapter 25, “Upgrading From Novell Vibe 3.4 to OpenText Vibe 4.0.5 or Later,” on page 189
 Chapter 26, “Upgrading to Novell Vibe 3.4 from Previous Versions,” on page 209
 Chapter 27, “Updating the Operating System Where Vibe Is Running,” on page 211
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24 24Upgrading From Novell Vibe 4.x to 
OpenText Vibe 4.0.5 or Later

This section describes how to upgrade from an earlier version of Novell Vibe 4 to OpenText Vibe 
4.0.5 or later.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you 
downloaded the Vibe software for any hot patches that might be available.

 “Obtaining and Preparing Vibe 4.0.5 or Later Software” on page 177
 “Understanding the Upgrade Process” on page 177
 “Backing Up Vibe Data” on page 178
 “Separate Lucene Index Server Upgrade” on page 178
 “Preserving Self-Signed Certificates During the Upgrade” on page 180
 “Upgrading the Vibe Software” on page 181
 “If the Installer Reports an Error” on page 182
 “Upgrading the Vibe Database from 4.x to 4.0.5 or Later” on page 183
 “Performing Post-Upgrade Tasks” on page 185

Obtaining and Preparing Vibe 4.0.5 or Later Software
You can download Vibe through your Customer Center account or obtain the software from a 
OpenText Partner.

As you extract the software, make sure that you don’t overwrite the previous Vibe version.

Understanding the Upgrade Process
During the upgrade to from an earlier version of Novell Vibe 4 to Vibe 4.0.5 or later, the following 
aspects of your Vibe system are modified:

 The software is upgraded to the new Vibe version.
 A backup copy of your existing Vibe 4.x installation is created in the following directory:

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell 
Teaming), the backup copy is located in the following directory:

Linux: /opt/novell/teaming/teaming-backup
Windows: C:\Program Files\Novell\Teaming\teaming-backup
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 The Java Virtual Machine (JVM) software that you installed to support the previous version of 
Vibe is replaced by a customized version of OpenJDK located in /opt/novell/teaming/jre. 
Using a separate JDK and JRE is no longer required, nor is it supported.

Backing Up Vibe Data
Ensure that your Vibe data is backed up before you begin the upgrade process. For information 
about the data that needs to be backed up, see “Backing Up Vibe Data” in the  OpenText Vibe 4.0.8 
Administration Guide.

Because of significant changes to the database schema, OpenText recommends that you use your 
database backup software to back up your Vibe database before upgrading to Vibe 4.0.5 or later.

Separate Lucene Index Server Upgrade
IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do 
not need to upgrade it separately. Skip to “Preserving Self-Signed Certificates During the Upgrade” 
on page 180.

You have the following options when upgrading your Lucene search index to Vibe 4.0.5 or later:

 Create a new search index 

Because a full re-index is required after upgrading to Vibe 4.0.5 or later, creating a new search 
index is less time-consuming than upgrading your existing search index. The benefit to creating 
a new Lucene search index is that you are able to maintain the original search index in the 
unlikely case of an emergency rollback.

 Upgrade your existing Lucene search index 
If you choose to upgrade your existing Lucene search index, you must perform a re-index after 
the upgrade, as described in “Resetting the Search Index” on page 185.

These options are described in the following sections:

 “Creating a New Search Index” on page 178
 “Upgrading an Existing Search Index” on page 179

Creating a New Search Index
1 Stop Vibe.

Linux: /opt/icecore
Windows: C:\Program Files\icecore
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2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 
Vibe 4.0 system.

4 On a different server than where your original search index was running, create a new search 
index, as described in “Installing the Lucene Software” on page 143.

Upgrading an Existing Search Index
The Vibe installation program cannot upgrade the Lucene search index when it is running on a 
separate server. To upgrade your search index from Novell Vibe 4.x to OpenText Vibe 4.0.5 or later, 
you need to run the Separate Lucene Server installation program:

1 Stop Vibe.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 
Vibe 4.x system.

4 Copy the new Vibe Lucene Server Installation program to a convenient directory on the server 
where the Lucene search index is located.
The name of the Lucene Server Installation program varies by platform:

Linux: On the Vibe server, specify the following command:

/etc/init.d/teaming stop
Windows: See “Stopping Vibe as an Application” on page 89.

Linux: /etc/init.d/indexserver stop
Windows: c:\Program 

Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat

Linux: On the Vibe server, specify the following command:

/etc/init.d/teaming stop
Windows: See “Stopping Vibe as an Application” on page 89.

Linux: /etc/init.d/indexserver stop
Windows: c:\Program 

Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat
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5 Start the Vibe Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.
11 In the Host field, specify the hostname where you are installing the Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration 
Settings” on page 104.

13 Click Install to install the upgraded Lucene search index software.
14 Click Finish when the upgrade is complete.
15 (Conditional) If memcached is running on the Lucene search index server, reboot the server 

where it is running to ensure that the 4 cache is cleared.
16 Start the Lucene Index Server.

On the Lucene index server, specify the following command:

17 Ensure that the index server is running.
/etc/init.d/indexserver status

18 Now that all Vibe components have been upgraded, follow the instructions in “Upgrading the 
Vibe Software” on page 181.

Preserving Self-Signed Certificates During the Upgrade
If your Vibe site uses self-signed certificates for SSL connections to other services, such as LDAP, 
WebDAV, and so on, the Vibe installation program can preserve SSL connectivity by automatically 
importing the certificates that you identify in your old JAVA Certificate Store (cacerts) to the new 
OpenJDK cacerts file.

The process works as follows:

1 You must identify the aliases of the certificates you want to have imported to the new 
certificate store. If you are unsure of any alias names, you can list the aliases in the current 
cacerts file using a command similar to the following:

Linux: lucene-installer.linux
Windows: lucene-installer.exe

Linux: systemctl start indexserver.service
Windows: c:\Program 

Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
startup.bat
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keytool -list -v -keystore $JAVA_HOME/jre/lib/security/cacerts
2 When you run the Vibe installer, you are prompted to enter the alias names, separated by 

commas. 
3 The Vibe installer makes appropriate backup copies of the old and new cacerts files. 
4 When the installation process concludes, the new OpenJDK installation is configured for secure 

communications just like your previous Java installation.

Upgrading the Vibe Software
Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 4.x system.
2 Stop Vibe.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 
Vibe 4.x system.

4 Copy the installer.xml file from the directory where the previous-version Vibe 4 
Installation program is located to the directory where you have extracted the Vibe 4.0.5 or later 
software.

5 Copy the license-key.xml file from the directory where the previous Vibe 4 Installation 
program is located to the directory where you have extracted the new Vibe installation 
software.
Alternatively, you can obtain a new license key (*.xml) from the location where you 
downloaded the new Vibe software, copy it to the directory containing the newly extracted 
Vibe installation software, and rename it to license-key.xml.

6 Start the Vibe 4.0.5 or later installation program.
If you need assistance with this task, see the detailed installation instructions for the platform 
where you are upgrading Vibe:
 “Running the Linux Vibe Installation Program” on page 72
 “Running the Windows Vibe Installation Program” on page 83

7 Accept the License Agreement, then click Next.

Linux: On the Vibe server, specify the following command:

/etc/init.d/teaming stop
Windows: See “Stopping Vibe as an Application” on page 89.
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Because you provided your Vibe 4 installer.xml file in the directory with the newly 
extracted Vibe installation program, the Update software and settings installation option is 
selected by default.

8 Click Next to continue.
9 Click Yes to let the Installation program know that you have stopped Vibe.

10 Select the check box to let the installation program know that you have backed up all of your 
data, then click Next.

11 Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then 
click Next.
For more information about the differences between basic and advanced installations, see 
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on 
page 99.

12 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 4.0.5 or later system.

13 If you are using self-signed certificates to secure communications between Vibe and other 
services, when you reach the Java JDK screen, enter the aliases that you used when importing 
the certificates, in a comma-separated list.

14 Click Install when you are ready to perform the upgrade.
15 Click Finish when the upgrade is complete.

If the installer reports errors, skip to “If the Installer Reports an Error” on page 182.
16 (Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the 

cache is cleared.
17 Continue with “Upgrading the Vibe Database from 4.x to 4.0.5 or Later” on page 183.

If the Installer Reports an Error
1 If you have typed an alias name wrong, or if the installer doesn’t find a specified certificate for 

some other reason, it notifies you. 
The installer.log file has information about the error. 

2 Run the installation again as instructed in “Upgrading the Vibe Software” on page 181 and be 
sure to repeat Step 4 on page 181 so that the installer.xml file doesn’t contain any 
modifications made by the failed attempt to install the new version of Vibe.
182 Upgrading From Novell Vibe 4.x to OpenText Vibe 4.0.5 or Later



Upgrading the Vibe Database from 4.x to 4.0.5 or Later
Upgrade the Vibe software (as described in “Upgrading the Vibe Software” on page 181) before 
upgrading the Vibe database.

When you upgrade to from Vibe 4.0.5 or later, the Vibe Installation program does not update the 
database as part of the Vibe software upgrade. Therefore, you must manually update the database 
before you can start Vibe:

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set 
for the Vibe system is in UTF-8 format.
1a To view the character set format, run the following command:

SELECT default_character_set_name FROM information_schema.SCHEMATA 
S WHERE schema_name = 'sitescape';
In this command sitescape is the name of the Vibe database. Replace sitescape with 
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to 
change it:
In the following command, sitescape is the name of the Vibe database. Replace 
sitescape with the name of your database.
ALTER DATABASE sitescape CHARACTER SET utf8;

2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 sqlserver-liquibase.properties

3 In a text editor, open the properties file that corresponds with your database type and make the 
applicable changes in both the Driver and referenceDriver sections. Save and close the 
text editor when you are finished making changes.
 Change the database user name and password for accessing the database.
 (Conditional) Specify the IP address for the database if it is running on a separate server.

You need to replace localhost with the IP address of the server.
 (Optional) Change the name of the Vibe database (the default name of the Vibe database 

is sitescape, the name of the company that previously developed the Vibe software).
4 Save your changes and close the properties file.
5 In the same directory (/vibe_installation/temp-installer/db), execute the following 

commands to update the database schema:
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NOTE: You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

6 Start the newly upgraded Vibe.
When you start Vibe for the first time after the upgrade, it takes longer to start than usual 
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in 
“Creating the Vibe Database” on page 75.
7a Change to the db directory in the Vibe installation:

cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 sqlserver-liquibase.properties

Windows SET PATH=C:\path_to_java_used_by_vibe\bin;%PATH%
manage-database.bat database_type updateDatabase
Possible database types (databaseType) are mysql, oracle, or sqlserver, 
depending on your type of database.

Linux PATH=/path_to_java_used_by_vibe/bin:$PATH
./manage-database.sh database_type updateDatabase
Possible database types (databaseType) are mysql, oracle, or sqlserver, 
depending on your type of database.

NOTE: Ensure that the manage-database.sh file is executable.

Linux: On the Vibe server, specify the following command:

systemctl start vibe.service
Windows: See “Starting Vibe as an Application” on page 89.

or

See “Starting Vibe as a Windows Service” on page 88.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your 
existing Windows service configuration and re-configure Vibe as a Windows service before 
you can start Vibe. For information about how to configure Vibe as a Windows service, see 
“Configuring Vibe as a Windows Service” on page 87.
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7b In a text editor, open the database_type-liquibase.properties file that 
corresponds with your database type, then delete the password.

7c Save and close the properties file.
8 Continue with “Performing Post-Upgrade Tasks” on page 185.

Performing Post-Upgrade Tasks
After you start OpenText Vibe, you can access your Vibe site as usual. However, you need to reset 
some aspects of the interface before you allow users to access the upgraded site. The interface reset 
affects only those definitions and templates that are included with the Vibe product. If you have 
created custom definitions and templates, they are unaffected by the interface reset.

 “Re-Installing the Windows Service” on page 185
 “Resetting the Search Index” on page 185
 “Resetting the Standard Templates” on page 187
 “Resetting Your Definitions” on page 187
 “Updating the Server.xml File When Using Secure HTTP” on page 188

Re-Installing the Windows Service
If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on 
page 87), you must do the following by using the instructions in the same section.

1. Remove the service as described in “Removing Vibe as a Windows Service” on page 88.
2. Re-install the service as described in “Configuring Vibe as a Windows Service” on page 87. 

This is necessary because the original service references an unsupported version of Tomcat.

Resetting the Search Index
In order for an upgraded search index to be compatible with Vibe 4.0.5 or later, you need to re-index 
the search index. Until you reset the search index, the search index and the vibe server are not in a 
compatible state. The catalina.out and appserver.log files show errors until the search index 
is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple 
Lucene Index Servers,” on page 155.

Depending on the size of your Vibe site, this can be a very time-consuming process.

 “Resetting a Single Search Index” on page 186
 “Resetting the Search Index with Multiple Index Servers” on page 186
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Resetting a Single Search Index
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log 
files:

Resetting the Search Index with Multiple Index Servers
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Search Index section, click Index.
4 Select Re-Index Everything.
5 Select each node that you want to re-index.
6 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.

7 After the index server has been reset, ensure that no errors are contained in the following log 
files:

Windows:  C:\Program Files\Novell\Teaming\apache-
tomcat\logs\catalina.out

 C:\Program Files\Novell\Teaming\apache-
tomcat\logs\appserver.log

Linux:  /opt/novell/teaming/apache-tomcat/logs/catalina.out
 /opt/novell/teaming/apache-tomcat/logs/appserver.log

Windows:  C:\Program Files\Novell\Teaming\apache-
tomcat\logs\catalina.out

 C:\Program Files\Novell\Teaming\apache-
tomcat\logs\appserver.log

Linux:  /opt/novell/teaming/apache-tomcat/logs/catalina.out
 /opt/novell/teaming/apache-tomcat/logs/appserver.log
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Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe templates. If you have manually customized any default Vibe templates, 
back up the files you have modified before performing the interface reset. This applies only to 
default templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Workspace and Folder Templates.

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe site is now ready for use.

Resetting Your Definitions
Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 4. Some of 
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the 
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it. This applies 
only to definitions that you have modified; definitions that you have created are not affected.
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To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Click Select All.

You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Updating the Server.xml File When Using Secure HTTP
The server.xml Tomcat configuration file (apache-tomcat-location/conf/server.xml) is 
overwritten during the upgrade process. If you set up secure HTTP browser connections to the Vibe 
server, and if you changed the password for the .keystore file to something other than the default 
changeit, you need to update the server.xml file after upgrading Vibe.

For information about how to update the .keystore password in the server.xml file, see “Do 
Not Change the Password for the Keystore File” in the  OpenText Vibe 4.0.8 Administration Guide.
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25 25Upgrading From Novell Vibe 3.4 to 
OpenText Vibe 4.0.5 or Later

The 3.4 Server Should Be Running JDK 8 or Later
Before you begin the upgrade process, check what JDK version the 3.4 server is running. If it is earlier 
than JDK 8, install a newer version before proceeding.

Backing Up Vibe Data
Ensure that your Vibe data is backed up before you begin the upgrade process. For information 
about the data that needs to be backed up, see “Backing Up Vibe Data” in the  OpenText Vibe 4.0.8 
Administration Guide.

Because of significant changes to the database schema, OpenText recommends that you use your 
database backup software to back up your Vibe database before upgrading to Vibe 4.

A Vibe Backup Is Automatically Created
A backup copy of your existing Vibe 3.4 installation is created in the following locations, depending 
on the hosting platform:

If your original Vibe system was Novell Teaming 1.0, the backup copy is located in the following 
locations, depending on the hosting platform:

Upgrading Vibe on Linux
This section is organized as presented in the overview graphic below. 

For your tracking convenience, the numbers at the beginning of the listed sections correspond with 
the numbers in the graphic.

 “Overview–The Linux Upgrade Process” on page 190
 “1 & 2: Preparing the New Target Server” on page 191
 “3: Upgrading All Vibe Services to Version 4.0.4” on page 191

Linux: /opt/novell/teaming/teaming-backup
Windows: C:\Program Files\Novell\Teaming\teaming-backup

Linux: /opt/icecore
Windows: C:\Program Files\icecore
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 “4: Migrating Your Data to the New Server” on page 199
 “5: Migrating (Re-Creating) Your Vibe Database on the New Server” on page 199
 “6: Upgrading the New Server to Vibe 4.0.5” on page 199

Overview–The Linux Upgrade Process
The platform requirements of Vibe 3.4 and Vibe 4.0.5 or later on Linux don’t overlap. 

Therefore, it’s not possible to upgrade from Vibe 3.4 to Vibe 4.0.5 or later on the same server 
hardware. Upgrading from 3.4 to 4.0.5 or later requires the installation of a new SLES 15 (or SLES 12) 
server along with the specific upgrade and migration processes that are outlined in Figure 25-1 and 
Table 25-1 and detailed in the sections referenced.

Figure 25-1   Graphical Overview–Upgrading from Vibe 3.4 to Vibe 4.0.5 or later

Table 25-1   Upgrade Process Explanation

Step Explanation

 Install a new SLES 15 (recommended) or SLES 12 (supported) Server by using the SLES 
documentation. See Chapter 4, “Vibe System Requirements,” on page 23.

 Install Vibe 4.0.4 on the new SLES server. For instructions, download the 4.0.4 documentation 
set in PDF format. See “Previous Release” on the Vibe 4.0.8 documentation web site (https://
www.novell.com/documentation/vibe4).

 On the old server, upgrade the Vibe and Lucene services from 3.4 to Vibe 4.0.4. See “3: 
Upgrading All Vibe Services to Version 4.0.4” on page 191.

 Migrate the data from your current (source) Vibe 4.0.4 deployment to the new (target) Vibe 
4.0.4 deployment. This involves replacing the data on the new server with the source server’s 
Vibe data. See “Migrating Vibe Data on Linux” on page 216.

 Migrate the sitescape.sql database from your current Vibe 4.0.4 deployment to the new Vibe 
4.0.4 deployment. As with the data, this involves replacing the newly deployed database with 
the older database. See “Re-creating Your Source Vibe Database on the Target Server” on 
page 218.

Old Source
(SLES 11)

Vibe 3.4 Vibe 4.0.4

3.4 Services
(Vibe & Lucene)

3.4 Data

3.4 Database
sitescape.sql

4.0.4 Services
(Vibe & Lucene)

4.0.4 Data

4.0.4 Database
sitescape.sql

Upgrade

New Target
(SLES 15 or 12)

Vibe 4.0.4 Vibe 4.0.5 or later

4.0.4 Services
(Vibe & Lucene)

4.0.4 Data

4.0.4 Database
sitescape.sql

4.0.5 or Later Services
(Vibe & Lucene)

4.0.5  or Later Data

4.0.5  or Later 
Database sitescape.sql

Upgrade

Migrate
(Replace)

Migrate
(Replace)
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1 & 2: Preparing the New Target Server
As outlined in “Overview–The Linux Upgrade Process” on page 190, upgrading Vibe on Linux from 
version 3.4 to 4.0.5 or later requires interim steps that involve the installation of a new Vibe 4.0.4 
server. 

Use the Vibe 4.0.4 software available through your Customer Center account for the new server.

If you need Vibe 4.0.4 installation instructions, download the 4.0.4 documentation set in PDF format 
by accessing the “Previous Release” section on the Vibe 4.0.8 documentation web site (https://
www.novell.com/documentation/vibe4).

IMPORTANT: To ensure a smooth upgrade process, we recommend that you prepare your new 
target Vibe 4.0.4 server at the beginning of the upgrade process.

Keep in mind that the new server will eventually be running Vibe 4.0.5 or later. 

Make sure that 

 Your new server meets the Vibe 4.0.5 or later system requirements specified in Part II, “System 
Requirements and Support,” on page 21.

 The new deployment uses the same database type as the previous deployment.

3: Upgrading All Vibe Services to Version 4.0.4
 “(Conditional) Upgrading a Separate Lucene Server to 4.0.4” on page 191
 “Upgrading the Vibe Service to 4.0.4” on page 193
 “Upgrading the Database to Support Version 4.0.4” on page 194
 “Verifying Success and Completing the Upgrade to 4.0.4” on page 196

(Conditional) Upgrading a Separate Lucene Server to 4.0.4

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do 
not need to upgrade it separately. Skip to “Upgrading the Vibe Service to 4.0.4” on page 193.

You have the following options when upgrading your Lucene search index to version 4.0.4:

 Create a new search index (Recommended) 

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less 
time-consuming than upgrading your existing search index. The benefit to creating a new 
Lucene search index is that you are able to maintain the original search index in the unlikely 
case of an emergency rollback.

 After verifying that Vibe 4.0.4 is running on the new server as expected, upgrade Vibe to new 
version. See Chapter 24, “Upgrading From Novell Vibe 4.x to OpenText Vibe 4.0.5 or Later,” on 
page 177.

Step Explanation

6
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 Upgrade your existing Lucene search index 
If you choose to upgrade your existing Lucene search index, you must perform a re-index after 
the upgrade, as described in “Resetting the Search Index” on page 196.

These options are described in the following sections:

 “Creating a New Search Index” on page 192
 “Upgrading an Existing Search Index” on page 192

Creating a New Search Index
1 On the Vibe server at a terminal prompt, stop Vibe by entering /etc/init.d/teaming 
stop.

2 On the Lucene server, stop the Lucene search index by entering /etc/init.d/indexserver 
stop.

3 Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.
4 On a different server than where your original search index was running, create a new search 

index, as described in “Installing the Lucene Software” on page 143.

Upgrading an Existing Search Index
The Vibe installation program cannot upgrade the Lucene search index when it is running on a 
separate server. To upgrade your search index from Novell Vibe 3.4 to OpenText Vibe 4.0.4, you need 
to run the Lucene Server installation program:

1 On the Vibe server at a terminal prompt, stop Vibe by entering /etc/init.d/teaming 
stop.

2 On the Lucene server, stop the Lucene search index by entering /etc/init.d/indexserver 
stop.

3 Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.
4 Copy the Vibe 4 Lucene Server Installation program–lucene-installer.linux–from the 

directory where the Vibe 4 Installation program is located to a convenient directory on the 
server where the Lucene search index is located.

5 Start the Vibe 4 Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.
11 In the Host field, specify the hostname where you are installing the Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration 
Settings” on page 104.

13 Click Install to install the upgraded Lucene search index software.
14 Click Finish when the upgrade is complete.
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15 (Conditional) If memcached is running on the Lucene search index server, reboot the server 
where it is running to ensure that the 3.4 cache is cleared.

16 On the Lucene server, start the Lucene Index Server by entering systemctl start 
indexserver.service.

17 Ensure that the index server is running.
/etc/init.d/indexserver status

18 Now that the separate Lucene server has been upgraded, follow the instructions in “Upgrading 
the Vibe Service to 4.0.4” on page 193.

Upgrading the Vibe Service to 4.0.4
Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 3.4 system.
2 On the Vibe server, stop Vibe by entering /etc/init.d/teaming stop.
3 Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.
4 Copy the installer.xml file from the directory where the Vibe 3.4 Installation program is 

located to the directory where you have extracted the Vibe 4 software.
The installer.xml file provides default values when you run the Vibe 3.4 Installation 
program.

5 Obtain a new license key from the location where you downloaded the Vibe 4 software, then 
place it in the same directory with the Vibe software. (The Vibe installation program does not 
start without a license file in the same directory.) Rename the license to license-key.xml. 
Vibe 4 requires an updated license. If you use a license from a previous version, not all features 
are available.

6 Make sure that your server platform meets the requirements outlined for the Vibe 4.0.4 
release. See the Vibe 4.0.4 documentation available for download from the Vibe 4.0.8 
documentation site (https://www.novell.com/documentation/vibe4). 

7 Start the Vibe 4 installation program.
If you need assistance with this task, see the detailed installation instructions in “Running the 
Linux Vibe Installation Program” on page 72.

8 Accept the License Agreement, then click Next.

Because you provided your Vibe 3.4 installer.xml file in the directory with the Vibe 4.0.4 
installation program, the Update software and settings installation option is selected by default.
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9 Click Next to continue.
10 Click Yes to let the Installation program know that you have stopped Vibe.
11 Select the check box to let the installation program know that you have backed up all of your 

data, then click Next.
12 Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then 

click Next.
For more information about the differences between basic and advanced installations, see 
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on 
page 99.

13 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 4 system.

14 Click Install when you are ready to perform the upgrade.
15 Click Finish when the upgrade is complete.
16 (Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the 

3.4 cache is cleared.
17 Continue with “Upgrading the Database to Support Version 4.0.4” on page 194.

Upgrading the Database to Support Version 4.0.4

IMPORTANT: Make sure you do the following:

1. Upgrade the Vibe software (as described in “Upgrading the Vibe Service to 4.0.4” on page 193) 
before upgrading the Vibe database.

2. Because the Vibe 4 upgrade process does not update the database as part of the Vibe software 
upgrade, you must 
 Ensure that the 3.4 system is in UTF-8 format before updating the database.
 Manually update the database before you start Vibe.

The following example outlines the process for MySQL. Refer to the documentation for your 
database type as needed.

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set 
for the Vibe 3.4 system is in UTF-8 format.
1a To view the character set format, run the following command:

SELECT default_character_set_name FROM information_schema.SCHEMATA 
S WHERE schema_name = 'sitescape';
In this command sitescape is the name of the Vibe database. Replace sitescape with 
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to 
change it:
In the following command, sitescape is the name of the Vibe database. Replace 
sitescape with the name of your database.
ALTER DATABASE sitescape CHARACTER SET utf8;

2 Change to the db directory in the Vibe installation:
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cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 sqlserver-liquibase.properties

3 In a text editor, open the properties file that corresponds with your database type and make the 
applicable changes in both the Driver and referenceDriver sections. Save and close the 
text editor when you are finished making changes.
 Change the database user name and password for accessing the database.
 (Conditional) Specify the IP address for the database if it is running on a separate server.

You need to replace localhost with the IP address of the server.
 (Optional) Change the name of the Vibe database (the default name of the Vibe database 

is sitescape, the name of the company that previously developed the Vibe software).
4 Save your changes and close the properties file.
5 In the same directory (/vibe_installation/temp-installer/db), execute the following 

commands to update the database schema:
PATH=/path_to_java_used_by_vibe/bin:$PATH (if not already set) (the path is /opt/
novell/teaming/jre/bin starting with Vibe 4.0.5)
./manage-database.sh databaseType mark33DatabaseAsUpdated
./manage-database.sh databaseType updateDatabase
Possible database types (databaseType) are mysql, oracle, or sqlserver, depending on 
your type of database.

NOTE: Ensure that the manage-database.sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

6 Start Vibe 4 in the same way that you have been starting Vibe 3.4 (/etc/init.d/teaming 
start).
When you start Vibe for the first time after the upgrade, it takes longer to start than usual 
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in 
“Creating the Vibe Database” on page 75.
7a Change to the db directory in the Vibe installation:

cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
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 Oracle-liquibase.properties
 sqlserver-liquibase.properties

7b In a text editor, open the database_type-liquibase.properties file that 
corresponds with your database type, then delete the password.

7c Save and close the properties file.
8 Continue with “Verifying Success and Completing the Upgrade to 4.0.4” on page 196.

Verifying Success and Completing the Upgrade to 4.0.4
After you start OpenText Vibe 4 on your old server, you can access your Vibe site as usual. However, 
you need to reset some aspects of the interface before you allow users to access the upgraded site. 
The interface reset affects only those definitions and templates that are included with the Vibe 
product. If you have created custom definitions and templates, they are unaffected by the interface 
reset.

 “Resetting the Search Index” on page 196
 “Resetting Your Definitions” on page 197
 “Resetting the Standard Templates” on page 198
 “Updating the Server.xml File When Using Secure HTTP” on page 198

Resetting the Search Index
In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search 
index. Until you reset the search index, the search index and the vibe server are not in a compatible 
state. The catalina.out and appserver.log files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple 
Lucene Index Servers,” on page 155.

Depending on the size of your Vibe site, this can be a very time-consuming process.

 “Resetting a Single Search Index” on page 196
 “Resetting the Search Index with Multiple Index Servers” on page 197

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.
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6 After the index server has been reset, ensure that no errors are contained in the following log 
files:
 /opt/novell/teaming/apache-tomcat/logs/catalina.out
 /opt/novell/teaming/apache-tomcat/logs/appserver.log

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Search Index section, click Index.
4 Select Re-Index Everything.
5 Select each node that you want to re-index.
6 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.

7 After the index server has been reset, ensure that no errors are contained in the following log 
files:
 /opt/novell/teaming/apache-tomcat/logs/catalina.out
 /opt/novell/teaming/apache-tomcat/logs/appserver.log

Resetting Your Definitions
Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of 
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the 
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it. This applies 
only to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Click Select All.
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You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe templates. If you have manually customized any default Vibe templates, 
back up the files you have modified before performing the interface reset. This applies only to 
default templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Workspace and Folder Templates.

4 Click Reset.
5 Click OK to confirm, then click Close.
6 Verify that the 4.0.4 site is working as expected before proceeding with the migration to your 

new 4.0.4 server.

Updating the Server.xml File When Using Secure HTTP
The server.xml Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up 
secure HTTP browser connections to the Vibe server, and if you changed the password for the 
.keystore file to something other than the default changeit, you need to update the 
server.xml file after upgrading to Vibe 4.

For information about how to update the .keystore password in the server.xml file, see “Do 
Not Change the Password for the Keystore File” in the OpenText Vibe 4.0.8 Administration Guide.

Now that the server is upgraded and performing well, it is time to shift your focus to the new target 
server.
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4: Migrating Your Data to the New Server
This involves replacing the datastore on the new server with the data from the source server. 
Complete the instructions in “Transferring Data from the Source Server to the Target Server” on 
page 217.

5: Migrating (Re-Creating) Your Vibe Database on the New 
Server
As with the data migration, this involves replacing the newly deployed 4.0.4 database with the older 
4.0.4 database.

Complete the instructions in “Re-creating Your Source Vibe Database on the Target Server” on 
page 218.

6: Upgrading the New Server to Vibe 4.0.5
Complete the applicable instructions in Chapter 24, “Upgrading From Novell Vibe 4.x to OpenText 
Vibe 4.0.5 or Later,” on page 177.

Upgrading Vibe on Windows from 3.4 to 4.0.4 or later
IMPORTANT: In contrast with the Linux upgrade process, which requires a new SLES server, 
upgrading from Vibe 3.4 to Vibe 4.0.5 or later on Windows doesn’t require interim steps, as long as 
the platform on which Vibe 3.4 is running also supports Vibe 4.0.5 or later.

Keep in mind, however, that OpenText policy dictates that we will no longer support Windows 2008 
SP2 once Microsoft discontinues support for the platform.

If that support change will impact your Vibe deployment, you might want to plan to upgrade your 
platform.

Separate Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do 
not need to upgrade it separately. Skip to “Upgrading the Windows Vibe Software” on page 201.

You have the following options when upgrading your separate Lucene search index to Vibe 4:

 Create a new search index 

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less 
time-consuming than upgrading your existing search index. The benefit to creating a new 
Lucene search index is that you are able to maintain the original search index in the unlikely 
case of an emergency rollback.
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 Upgrade your existing Lucene search index 
If you choose to upgrade your existing Lucene search index, you must perform a re-index after 
the upgrade, as described in “Resetting the Search Index” on page 196.

These options are described in the following sections:

 “Creating a New Search Index” on page 200
 “Upgrading an Existing Search Index” on page 200

Creating a New Search Index
1 Stop Vibe. 

See “Stopping Vibe as an Application” on page 89
2 Stop the Lucene search index.

On the Lucene index server, specify the command:
c:\Program 
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat

3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.
4 On a different server than where your original search index was running, create a new search 

index, as described in “Installing the Lucene Software” on page 143.

Upgrading an Existing Search Index
The Vibe installation program cannot upgrade the Lucene search index when it is running on a 
separate server. To upgrade your search index from Novell Vibe 3.4 to Novell Vibe 4, you need to run 
the Lucene Server installation program:

1 Stop Vibe.
See “Stopping Vibe as an Application” on page 89.

2 Stop the Lucene search index.
On the Lucene index server, specify the command:
c:\Program 
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
shutdown.bat :

3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.
4 Copy the new Vibe Lucene Server Installation program–lucene-installer.exe– to a 

convenient directory on the server where the Lucene search index is located.
5 Start the new Vibe Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.
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11 In the Host field, specify the hostname where you are installing the Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration 
Settings” on page 104.

13 Click Install to install the upgraded Lucene search index software.
14 Click Finish when the upgrade is complete.
15 (Conditional) If memcached is running on the Lucene search index server, reboot the server 

where it is running to ensure that the 3.4 cache is cleared.
16 Start the Lucene Index Server by specifying the following command:

c:\Program 
Files\Novell\Teaming\luceneserver\indexserver\bin\indexserver-
startup.bat

17 Now that all Vibe components have been upgraded, follow the instructions in “Upgrading the 
Windows Vibe Software” on page 201.

Upgrading the Windows Vibe Software
Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 3.4 system.
2 Stop Vibe.

See “Stopping Vibe as an Application” on page 89.
3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.
4 Copy the installer.xml file from the directory where the Vibe 3.4 Installation program is 

located to the directory where you have extracted the Vibe 4 software.
The installer.xml file provides default values when you run the Vibe 3.4 Installation 
program.

5 Obtain a new license key from the location where you downloaded the Vibe 4 software, then 
place it in the same directory with the Vibe software. (The Vibe installation program does not 
start without a license file in the same directory.) Rename the license to license-key.xml. 
Vibe 4 requires an updated license. If you use a license from a previous version, not all features 
are available.

6 Make sure that your server platform meets the requirements outlined in Part II, “System 
Requirements and Support,” on page 21.

7 Start the Vibe 4 installation program.
If you need assistance with this task, see the detailed installation instructions in “Running the 
Windows Vibe Installation Program” on page 83.

8 Accept the License Agreement, then click Next.
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Because you provided your Vibe 3.4 installer.xml file in the directory with the Vibe 4 
installation program, the Update software and settings installation option is selected by default.

9 Click Next to continue.
10 Click Yes to let the Installation program know that you have stopped Vibe.
11 Select the check box to let the installation program know that you have backed up all of your 

data, then click Next.
12 Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then 

click Next.
For more information about the differences between basic and advanced installations, see 
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on 
page 99.

13 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 4 system.

14 Click Install when you are ready to perform the upgrade.
15 Click Finish when the upgrade is complete.
16 (Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the 

3.4 cache is cleared.
17 Continue with “Upgrading the Vibe Database from 3.4 to 4” on page 202.

Upgrading the Vibe Database from 3.4 to 4

IMPORTANT: Make sure you do the following:

1. Upgrade the Vibe software (as described in “Upgrading the Windows Vibe Software” on 
page 201) before upgrading the Vibe database.

2. Because the Vibe 4 upgrade process does not update the database as part of the Vibe software 
upgrade, you must 
 Ensure that the 3.4 system is in UTF-8 format before updating the database.
 Manually update the database before you start Vibe.
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The following example outlines the process for MySQL. Refer to the documentation for your 
database type as needed.

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set 
for the Vibe 3.4 system is in UTF-8 format.
1a To view the character set format, run the following command:

SELECT default_character_set_name FROM information_schema.SCHEMATA 
S WHERE schema_name = 'sitescape';
In this command sitescape is the name of the Vibe database. Replace sitescape with 
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to 
change it:
In the following command, sitescape is the name of the Vibe database. Replace 
sitescape with the name of your database.
ALTER DATABASE sitescape CHARACTER SET utf8;

2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 sqlserver-liquibase.properties

3 In a text editor, open the properties file that corresponds with your database type and make the 
applicable changes in both the Driver and referenceDriver sections. Save and close the 
text editor when you are finished making changes.
 Change the database user name and password for accessing the database.
 (Conditional) Specify the IP address for the database if it is running on a separate server.

You need to replace localhost with the IP address of the server.
 (Optional) Change the name of the Vibe database (the default name of the Vibe database 

is sitescape, the name of the company that previously developed the Vibe software).
4 Save your changes and close the properties file.
5 In the same directory (/vibe_installation/temp-installer/db), execute the following 

commands to update the database schema:
SET PATH=C:\path_to_java_used_by_vibe\bin;%PATH% (if not already set) (the path is 
/opt/novell/teaming/jre/bin starting with Vibe 4.0.5)
manage-database.bat databaseType mark33DatabaseAsUpdated
manage-database.bat databaseType updateDatabase
Possible database types (databaseType) are mysql, oracle, or sqlserver, depending on 
your type of database.
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NOTE: You can safely ignore the following Liquibase log messages:
 Warning: modifyDataType will lose primary key/autoincrement/not null 
settings for mysql

 Any messages that contain the words info: failure or info: failed, as long as they 
are associated with a type INFO message

6 Start Vibe 4 in the same way that you have been starting Vibe 3.4.
See “Starting Vibe as an Application” on page 89.
or
See “Starting Vibe as a Windows Service” on page 88.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your existing 
Windows service configuration and re-configure Vibe as a Windows service before you can start 
Vibe. For information about how to configure Vibe as a Windows service, see “Configuring Vibe 
as a Windows Service” on page 87.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual 
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in 
“Creating the Vibe Database” on page 85.
7a Change to the db directory in the Vibe installation:

cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
 mysql-liquibase.properties
 Oracle-liquibase.properties
 sqlserver-liquibase.properties

7b In a text editor, open the database_type-liquibase.properties file that 
corresponds with your database type, then delete the password.

7c Save and close the properties file.
8 Continue with “Performing Post-Upgrade Tasks” on page 204.

Performing Post-Upgrade Tasks
After you start OpenText Vibe 4, you can access your Vibe site as usual. However, you need to reset 
some aspects of the interface before you allow users to access the upgraded site. The interface reset 
affects only those definitions and templates that are included with the Vibe product. If you have 
created custom definitions and templates, they are unaffected by the interface reset.

 “Resetting the Search Index” on page 205
 “Resetting Your Definitions” on page 206
 “Resetting the Standard Templates” on page 206
 “Re-Installing the Windows Service” on page 207
 “Updating the Server.xml File When Using Secure HTTP” on page 207
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Resetting the Search Index
In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search 
index. Until you reset the search index, the search index and the vibe server are not in a compatible 
state. The catalina.out and appserver.log files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple 
Lucene Index Servers,” on page 155.

Depending on the size of your Vibe site, this can be a very time-consuming process.

 “Resetting a Single Search Index” on page 205
 “Resetting the Search Index with Multiple Index Servers” on page 205

Resetting a Single Search Index
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log 
files:
 C:\Program Files\Novell\Teaming\apache-tomcat\logs\catalina.out
 C:\Program Files\Novell\Teaming\apache-tomcat\logs\appserver.log

Resetting the Search Index with Multiple Index Servers
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Search Index section, click Index.
4 Select Re-Index Everything.
5 Select each node that you want to re-index.
6 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.
Upgrading From Novell Vibe 3.4 to OpenText Vibe 4.0.5 or Later 205



7 After the index server has been reset, ensure that no errors are contained in the following log 
files:
 C:\Program Files\Novell\Teaming\apache-tomcat\logs\catalina.out
 C:\Program Files\Novell\Teaming\apache-tomcat\logs\appserver.log

Resetting Your Definitions
Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of 
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the 
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it. This applies 
only to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Click Select All.

You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe templates. If you have manually customized any default Vibe templates, 
back up the files you have modified before performing the interface reset. This applies only to 
default templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration 

Console icon . 
3 In the Management section, click Workspace and Folder Templates.
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4 Click Reset.
5 Click OK to confirm, then click Close.
6 Your Vibe 4 site is now ready for use.

Re-Installing the Windows Service
If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on 
page 87), you must remove the service and re-install it. This is necessary because the original service 
references an unsupported version of Tomcat.

Updating the Server.xml File When Using Secure HTTP
The server.xml Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up 
secure HTTP browser connections to the Vibe server, and if you changed the password for the 
.keystore file to something other than the default changeit, you need to update the 
server.xml file after upgrading to Vibe 4.

For information about how to update the .keystore password in the server.xml file, see “Do 
Not Change the Password for the Keystore File” in the OpenText Vibe 4.0.8 Administration Guide.
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26 26Upgrading to Novell Vibe 3.4 from Previous 
Versions

For information about how to upgrade to Vibe 3.4, see “Update” (https://www.novell.com/
documentation/vibe34/vibe34_inst/data/bj0kxa6.html) in the Vibe 3.4 Installation Guide (https://
www.novell.com/documentation/vibe34/vibe34_inst/data/bookinfo.html).
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27 27Updating the Operating System Where 
Vibe Is Running

You can update the operating system where Vibe is running.

1 Update the Linux or Windows operating system to a version that Vibe supports.
For information about which versions are supported, see “Server Operating System 
Requirements” on page 23.
For information about how to update the operating system, view the appropriate 
documentation for your operating system.
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VII VIIMigrate

 Chapter 28, “Migrating Existing Vibe 4 Data to a New Vibe 4 System,” on page 215
 Chapter 29, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 223
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28 28Migrating Existing Vibe 4 Data to a New 
Vibe 4 System

IMPORTANT: The term “data migration” as used in this section, is essentially about creating a clone 
of an existing Vibe system. 

 Cross-version Migration Not Supported: Data migration between servers running different 
versions of Vibe is not supported. However, you can use data migration in conjunction with an 
upgrade (see “Data Migration and Upgrading to Vibe 4” on page 215).

 Name and Credentials Must Be the Same: The database name and the database username and 
password must be the same on the source and the target server.

This section describes how to migrate data from an existing Vibe 4 server to a new Vibe 4 server. You 
might want to do this for any of the following reasons:

 Your existing Vibe system has outgrown the server where you originally set it up.
 You want to move your existing Vibe system to a different operating system.

In this case, you can install Vibe 4 on a new server, then migrate your existing Vibe 4 data to 
your new Vibe 4 system.

 You want to preserve your old system in its current state.

NOTE: In the instructions that follow, “target server” refers to the server where you install the Vibe 4 
software, and “source server” refers to the existing server from which you are migrating Vibe data.

The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started 
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for 
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply 
these guidelines to your Oracle database migration.

 “Data Migration and Upgrading to Vibe 4” on page 215
 “Migrating Vibe Data on Linux” on page 216
 “Migrating Vibe on Windows” on page 218

Data Migration and Upgrading to Vibe 4
As stated above, data migration between servers running different versions of Vibe is not supported.

If you want to migrate data from Vibe 3.4 to a new Vibe 4 system, you must:

 Upgrade the Vibe 3.4 server to Vibe 4. 
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 Install a new Vibe 4 server
 Migrate the data from the old Vibe 4 server to the new Vibe 4 system, by using the instructions 

in the following sections.

Migrating Vibe Data on Linux
NOTE: The instructions in this section assume that your Vibe deployment uses MySQL as the 
database server. If you use another SQL database, you will need to adjust the steps to fit your 
deployment.

 “Starting and Verifying the Target Vibe Server” on page 216
 “Preparing the Source Linux Server for the Data Transfer” on page 217
 “Transferring Data from the Source Server to the Target Server” on page 217
 “Re-creating Your Source Vibe Database on the Target Server” on page 218
 “Finalizing Your New Vibe 4 Site” on page 218

Starting and Verifying the Target Vibe Server
On the target server:

1 Install the Vibe 4 software on the target server, as described in Part III, “Single-server (Basic) 
Installation,” on page 33, paying special attention to these important details:
 Set up the same Linux user to run the Vibe software that has been used to run the Vibe 

software in the source Vibe server.
 Select the same encryption algorithm for the Vibe database that was used for the source 

Vibe server. 

IMPORTANT: If the database encryption algorithms do not match between the source and 
target Vibe systems, you cannot log in to the new Vibe 4 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.
5 Rename the teaming directory to teaming_backup. In a future step, you will copy the 
teaming directory from the source server to the target server.
The location of the teaming directory varies by platform:

6 Continue with “Preparing the Source Linux Server for the Data Transfer” on page 217.

Linux: /var/opt/novell/teaming

Windows: c:\novell\teaming
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Preparing the Source Linux Server for the Data Transfer
On the source server:

1 Stop Vibe.
2 Back up your existing database:

mysqldump -uusername -ppassword sitescape > sitescape.sql
This creates a file named sitescape.sql in the directory where you executed the 
mysqldump command.

3 Ensure that you have a recent backup of your entire Vibe system.
4 Continue with “Transferring Data from the Source Server to the Target Server” on page 217.

Transferring Data from the Source Server to the Target Server
On the source server:

1 Mount the target server to the source server so that data can be copied from one server to the 
other.

2 In a terminal window on the source server, become the Linux user that runs the Vibe software. 
3 Copy the database backup of your existing Vibe database (sitescape.sql file) that you 

created in Step 2 in “Preparing the Source Linux Server for the Data Transfer” on page 217 to a 
convenient temporary location on the target server.

4 Copy the entire data area from /var/opt/novell/teaming on the source server to the same 
location on the target server.

5 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacerts file to the 
same location on the target server.

6 Edit the /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF/classes/
config/ssf-ext.properties file on the target server to include the same content as the 
corresponding file on the source server, as follows:
6a Make sure that the user.pwdenc.default=PROPERTY-VALUE values are the same in 

the ssf-ext.properties files on both servers.
6b Copy the following property values in the ssf-ext.properties file on the source server 

and replace the corresponding property values on the target server with the source server 
values. 

NOTE: We recommending pasting to avoid typing errors.

 database.password=PROPERTY-VALUE

 mail.SiteScape.out.password=PROPERTY-VALUE

 smtp.service.keystore.password=PROPERTY-VALUE

 kablink.encryption.key=PROPERTY-VALUE

 kablink.encryption.key.initial=PROPERTY-VALUE

6c Save the modified ssf-ext.properties file on the target server.
7 Continue with “Re-creating Your Source Vibe Database on the Target Server” on page 218.
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Re-creating Your Source Vibe Database on the Target Server
On the target server:

1 Remove the empty Vibe database that was created when you installed the Vibe 4 software:

mysql>drop database sitescape;
2 Change to the directory where you copied the sitescape.sql file in Step 3 in “Transferring 

Data from the Source Server to the Target Server” on page 217.
3 Create an empty database called sitescape:

mysql -uusername -ppassword -e "create database sitescape character set 
utf8"

4 Manually re-create the Vibe database with the data that you copied from the source server:

mysql -uusername -ppassword sitescape < sitescape.sql

Finalizing Your New Vibe 4 Site
1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 81.
2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in 

the  OpenText Vibe 4.0.8 Administration Guide.
Your Vibe site should now function just as it did on the original source server.

Migrating Vibe on Windows
NOTE: The instructions in this section assume that your Vibe deployment uses MS SQL as the 
database server. If you use another SQL database, you will need to adjust the steps to fit your 
deployment.

 “Preparing the Target Windows Server” on page 218
 “Preparing the Source Windows Server” on page 219
 “Transferring Data from the Source Server to the Target Server” on page 219
 “Importing the Database to the Target Server” on page 220
 “Finalizing Your New Vibe 4 Site” on page 221

Preparing the Target Windows Server
On the target server:

1 Install the Vibe 4 software, as described in Part III, “Single-server (Basic) Installation,” on 
page 33.

IMPORTANT: Select the same encryption algorithm for the Vibe 4 database that you selected 
for the source Vibe server. If the database encryption algorithms do not match between the 
source and target systems, you cannot log in to the new Vibe 4 site.
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2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.
5 Rename the teaming directory to teaming_backup. In a future step you will copy the 
teaming directory from the source server to the target server.
The location of the teaming directory varies by platform:

6 Continue with “Preparing the Source Windows Server” on page 219.

Preparing the Source Windows Server
On the source server:

1 Stop Vibe.
2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing 
database (named sitescape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.

This creates a file named sitescape.bak in the following directory:

c:\Program Files\Microsoft SQL Server\MSSQL\Backup
3 Ensure that you have a recent backup of your entire system.
4 Continue with “Transferring Data from the Source Server to the Target Server” on page 219.

Transferring Data from the Source Server to the Target Server
On the source server:

1 Map a drive from the target server to the source server so that data can be copied from one 
server to the other.

2 Copy your existing software extensions to the target server:

Beginning with Vibe 3, the extensions directory now contains kablink and liferay.com 
directories.

3 Delete the empty kablink directory.
4 Delete or rename the following directories to make room for the corresponding directories that 

you are copying from the source server:

Linux: /var/opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

From: c:\home\icecoredata\extensions
To: c:\novell\teaming\extensions
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c:\novell\teaming
c:\novell\teaming\lucene
c:\novell\teaming\extensions

5 Copy the entire data area from c:\novell\teaming on the source server to the same 
location on the target server.

6 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacerts file to the 
same location on the target server.

7 Edit the C:\Program Files\Novell\Teaming\apache-tomcat\webapps\ssf\WEB-
INF\classes\config\ssf-ext.properties file on the target server to include the same 
content as the corresponding file on the source server, as follows:
7a Make sure that the user.pwdenc.default=PROPERTY-VALUE values are the same in 

the ssf-ext.properties files on both servers.
7b Copy the following property values in the ssf-ext.properties file on the source server 

and replace the corresponding property values on the target server with the source server 
values. 

NOTE: We recommending pasting to avoid typing errors.

 database.password=PROPERTY-VALUE

 mail.SiteScape.out.password=PROPERTY-VALUE

 smtp.service.keystore.password=PROPERTY-VALUE

 kablink.encryption.key=PROPERTY-VALUE

 kablink.encryption.key.initial=PROPERTY-VALUE

7c Save the modified ssf-ext.properties file on the target server.
8 Continue with “Importing the Database to the Target Server” on page 220.

Importing the Database to the Target Server
On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe 
database (named sitescape) that was created when you installed the Vibe 4 software, then 
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click 
Tasks > Restore.

3 In the To database field, specify sitescape.
4 In the From device field, browse to and select the sitescape.bak file that you transferred to 

the target server.
5 Set other restore options as desired, then click OK.

This creates the sitescape database in the following directory on the target server:

c:\Program Files\Microsoft SQL Server\MSSQL
Backed-up data from the source database is imported into the database for your new Vibe 4 
system.
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Finalizing Your New Vibe 4 Site
1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 81.
2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in 

the  OpenText Vibe 4.0.8 Administration Guide.
Your Vibe site should now function just as it did on the original source server.
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29 29Migrating from SiteScape Forum or Other 
Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging 
process. To make the job easier, see the OpenText Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming_Migration_Flyer_en.pdf)
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VIII VIIIAppendixes

 Appendix A, “Sizing and Performance Considerations,” on page 227
 Appendix B, “Memcached Caching with Vibe,” on page 235
 Appendix C, “Using MySQL 8 and Later with Vibe,” on page 241
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A ASizing and Performance 
Considerations

Because of the wide variety of ways you can use Vibe, the recommendations given in this section are 
only guidelines. 

The hardware configuration that you set up for your OpenText Vibe site should be based on the 
following considerations:

 Number of active users that the Vibe site must support: Users who have accounts in the Vibe 
system but do not log in to the system should not be considered in this number. For example, if 
there are 1,000 users in the Vibe system but only 300 access the system on a regular basis, the 
number of active users is 300.

 Content the users will add: The type of content that is shared and stored on your Vibe site. The 
number of active users in the system is a good indicator of what the hardware configuration of 
your system should be, but you should also keep in mind that the type of content that is shared 
and stored on your Vibe site has a significant effect on the amount of disk space and memory 
that is required. 
For example, your users might add the following types of content:
 Multimedia documents, such as CAD and PowerPoint documents (requires the most 

system resources)
 Other documents, such as text documents and photos
 Vibe entries that do not contain attachments, such as blog entries and discussion entries 

(requires the least amount of system resources)

For example, if you have a Vibe installation with only 400 active users, but those users often upload 
and share CAD files, you might want to configure a dedicated SQL server where those files can be 
stored. In addition, provide a larger CPU, increased memory, and a larger Java heap to more 
efficiently upload and search for the files.

Server machines can be physical or virtual.

 “Configuration Based on Installation Size” on page 228
 “Test Installation” on page 229
 “Small Installation” on page 229
 “Medium Installation” on page 230
 “Large Installation” on page 231
 “Very Large Installation” on page 233
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Configuration Based on Installation Size
The following table shows the recommended hardware configuration based on the size of the Vibe 
installation. For more detailed information about each type of installation, click the installation size 
in the column header.

Test Installation

Test Installation Small 
Installation

Medium 
Installation

Large 
Installation

Very Large 
Installation

Single Server 
Only 

X X

Database 
Server 

X

Vibe Desktop 
Server 

X X

Vibe Add-In or 
WebDAV Server 

Lucene Index 
Server 

X

File Repository X X

Multiple Vibe 
(Tomcat) 
Servers 

X X

Multiple Lucene 
Servers 

X

Multiple 
Database 
Servers 

X X

Multiple Vibe 
Desktop 
Servers 

X

Multiple Vibe 
Add-In Servers 

X

Tomcat
Lucene Index
SQL Database
File System
Vibe Desktop
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This deployment is suitable for a single-person evaluation or minimal usage by a small group.

For more information about installing a basic, single-server Vibe site, see Part III, “Single-server 
(Basic) Installation,” on page 33.

You can perform a Basic installation to set up a single-server configuration, as described in 
Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on page 41 and Chapter 11, “Installing 
and Setting Up a Basic Vibe Site,” on page 71.

Small Installation

This deployment is suitable for a workgroup, department, or small company. All components are on 
a single server but are running typical memory allocations. If Vibe Desktop is being used with more 
than 100 active users, it must be running on one or more separate Vibe (Tomcat) servers.

For more information about installing a basic, single-server Vibe site, see Part III, “Single-server 
(Basic) Installation,” on page 33.

Vibe Components CPU Memory Java Heap

1 dedicated Vibe (Tomcat) server with:

 Lucene
 SQL
 File System
 Vibe Desktop
 Vibe Add-In

3Ghz x64, single-core or 
dual-core

4–8 GB 2–6 GB

Vibe Components CPU Memory Java Heap

Multiple Vibe servers:

 1 dedicated Vibe (Tomcat) server 
with SQL and file system

 1 dedicated Vibe (Tomcat) server 
with Vibe Desktop for 100 or fewer 
active users; 2 dedicated Vibe 
(Tomcat) servers with Vibe Desktop 
for more than 100 active users

3Ghz x64, dual-core or 
quad-core

4–8 GB 2–6 GB

Tomcat
Lucene Index
SQL Database
File System

Tomcat
(for Vibe Desktop
if more than 100
active users)
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For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how 
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File 
Access and Editing for Vibe Users” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration 
Guide.

You can perform a Basic installation to set up a single-server configuration, as described in 
Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on page 41 and Chapter 11, “Installing 
and Setting Up a Basic Vibe Site,” on page 71.

Medium Installation

This deployment is suitable for a medium-to-large business. The database server is separate, to 
increase the amount of parallel processing in the system. The database can be a single server or a 
cluster of database servers. More memory is also allocated to the Vibe server. If Vibe Desktop is 
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat) 
servers.

For information on how to create a separate Vibe database, follow the instructions specific to your 
database type, as described in Chapter 19, “Creating the Vibe Database on a Separate Server,” on 
page 135.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how 
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File 
Access and Editing for Vibe Users” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration 
Guide.

Vibe Components CPU Memory Java Heap

Multiple Vibe servers:

 1 dedicated Vibe (Tomcat) server 
with file system

 1 or more dedicated SQL servers
 2 dedicated Lucene servers
 2 or more dedicated Vibe (Tomcat) 

servers with Vibe Desktop

3Ghz x64 quad-core 4–8 GB 6 GB

Tomcat
Lucene Index
File System

Tomcat
(for Vibe Desktop)

Tomcat
(for Vibe Desktop
if more than 100
active users)
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You can perform a Basic installation to set up a multiple-server configuration (as described in 
Chapter 8, “Planning a Basic (Single-server) Vibe Installation,” on page 41 and Chapter 11, “Installing 
and Setting Up a Basic Vibe Site,” on page 71); however, the separate database must be created 
manually and in advance of performing the installation, as described in Chapter 19, “Creating the 
Vibe Database on a Separate Server,” on page 135.

Large Installation

This deployment is suitable for a large business. This deployment uses load balancing across all 
servers. The database server is separate, to increase the amount of parallel processing in the system. 
The index server is separate, to allow the application to better utilize the physical memory that is 
allocated. The file system is separate, and a SAN file system is recommended. The memory 
utilization of the index server is proportional to the index size, which is directly related to the 
number and size of documents and entries that are stored. As the number and size of documents 
and entries that are stored increases, you should increase the amount of memory accordingly. If 
Vibe Desktop is being used with more than 100 active users, it must be running on multiple separate 
Vibe (Tomcat) servers.

For more information on load balancing, see “Configuring a Web Application to Provide High 
Availability Functionality for Your Vibe Site” on page 151.

Vibe Components CPU Memory Java Heap

Multiple Vibe servers:

 3–5 dedicated Vibe (Tomcat) 
servers

 2 dedicated Lucene servers
 2 dedicated SQL servers
 1 dedicated file system server (SAN 

is recommended)
 2 or more dedicated Vibe (Tomcat) 

servers with Vibe Desktop

3Ghz x64 quad-core or 8-
core

4–8 GB 6 GB

TomcatTomcat
(for Vibe Desktop)

File System Lucene Index

SQL database
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For information on how to create a separate Vibe database, follow the instructions specific to your 
database type, as described in Chapter 19, “Creating the Vibe Database on a Separate Server,” on 
page 135.

For information on how to create a separate index server, see Chapter 20, “Installing the Lucene 
Index Server on a Separate Server,” on page 143.

For more information on how to create a separate file system server, see “Vibe File Repository 
Considerations” on page 147.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how 
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File 
Access and Editing for Vibe Users” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration 
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more 
information, see Part IV, “Advanced Installation and Reconfiguration,” on page 97.

Very Large Installation

This deployment is suitable for a large business. This deployment uses load balancing across all 
servers. The database server is separate, to increase the amount of parallel processing in the system. 
The index server is separate, to allow the application to better utilize the physical memory that is 
allocated. The file system is separate, and a SAN file system is recommended. The memory 
utilization of the index server is proportional to the index size, which is directly related to the 
number and size of documents and entries that are stored. As the number and size of documents 

TomcatTomcat
(for Vibe Desktop)

File System Lucene Index

SQL database
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and entries that are stored increases, you should increase the amount of memory accordingly. If 
Vibe Desktop is being used with more than 100 active users, it must be running on multiple separate 
Vibe (Tomcat) servers.

For more information on load balancing, see “Configuring a Web Application to Provide High 
Availability Functionality for Your Vibe Site” on page 151.

For information on how to create a separate Vibe database, follow the instructions specific to your 
database type, as described in Chapter 19, “Creating the Vibe Database on a Separate Server,” on 
page 135.

For information on how to create a separate index server, see Chapter 20, “Installing the Lucene 
Index Server on a Separate Server,” on page 143.

For more information on how to create a separate file system server, see “Vibe File Repository 
Considerations” on page 147.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how 
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File 
Access and Editing for Vibe Users” in “VibeSite Setup” in the  OpenText Vibe 4.0.8 Administration 
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more 
information, see Part IV, “Advanced Installation and Reconfiguration,” on page 97.

Vibe Components CPU Memory Java Heap

Multiple Vibe servers:

 4–8 dedicated Vibe (Tomcat) 
servers

 2 dedicated Lucene servers
 2 dedicated SQL servers
 1 dedicated file system server (SAN 

is recommended)
 2 or more dedicated Vibe (Tomcat) 

servers with Vibe Desktop

3Ghz x64 quad-core or 8-
core

4–8 GB 6 GB
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B BMemcached Caching with Vibe

Vibe contains two caching options for the hibernate caching provider: ehcache and memcached. For 
more information about ehcache, see Ehcache (http://ehcache.sourceforge.net).

 “About Memcached” on page 235
 “Downloading and Installing Memcached” on page 235
 “Configuring Memcached” on page 236
 “Securing Memcached” on page 237
 “Configuring Memcached in the Vibe Installation Program” on page 238
 “Memcached Logging” on page 238

About Memcached
Memcached is a high-performance, distributed memory object caching system used by a number of 
large Internet sites such as Wikipedia, Flickr, Twitter, and Youtube, as well as enterprise systems.

 “Advantages for Using Memcached” on page 235
 “Hardware Requirements and Configurations” on page 235

Advantages for Using Memcached
Memcached offers the following advantages over other caching systems:

 Better utilization of memory resources from the server farm.
 No replication (and therefore no overhead involved in replication). This results in a reduction of 

60 or more threads per Vibe node in a two-node cluster.
 The number of servers and the size of data scale together.
 Scales out much better than replication-based cluster cache.

Hardware Requirements and Configurations
Vibe supports memcached only on the SUSE Linux operating system.

Downloading and Installing Memcached
NOTE: You should run memcached only on a SUSE Linux operating system. 64-bit is recommended.

Memcached is included with the SUSE Linux Enterprise High Availability Extension. You simply need 
to install it on the server where the Lucene search index is running as you would any other Linux 
package.
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If you do not have the SUSE Linux Enterprise High Availability Extension, you can download and 
install memcached by completing the following steps on the Lucene search index server:

1 Navigate to the openSUSE Software Download page (http://software.opensuse.org).
2 In the Search field, type memcached, then click Search.
3 Download the RPM file after it is returned in the search results.
4 Install the downloaded RPM file.
5 Repeat Step 1 through Step 4 on the Lucene search index server.
6 Continue with “Configuring Memcached” on page 236.

Configuring Memcached
After you have downloaded and installed memcached on the server where the Lucene search index 
is running, as described in “Downloading and Installing Memcached” on page 235, you need to 
configure it on each node.

You configure memcached by adding the desired switches to the MEMCACHED_PARAMS variable.

1 Navigate to the etc/sysconfig directory.
2 Open the memcached file in a text editor.
3 Uncomment the MEMCACHED_PARAMS variable and add any switches that you feel are 

appropriate. When you uncomment the MEMCACHED_PARAMS variable, the following switches 
are already present:
 -d: Runs as a daemon. This is recommended.
 -l: Determines the interface to listen on. The default value is the localhost. You should 

either delete this switch with its default address (this is recommended for a simple setup) 
or change the default address to the address that you want memcached to listen on. For 
example, -l 172.17.2.3.

To see a complete list of switches that are available with memcached, type memcached -h 
from the command line of a machine where memcached is installed.

4 (Recommended) Increase the maximum memory to use for items to 1024 MB. You do this by 
adding the -m switch to the MEMCACHED_PARAMS variable. For example:

-m 1024
5 (Recommended) You should configure memcached to start automatically each time you reboot 

the server where the Lucene search index is running. To configure memcached to start 
automatically, enter the following command from the command line:

chkconfig --add memcached
To verify that automatic startup is enabled, enter the following command from the command 
line:

chkconfig memcached
6 Validate that memcached is running from the local server by typing the following command:

netstat -ap|grep memcached
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7 After you have verified that memcached is running on the local server, log in to a remote server, 
then validate that memcached is running to ensure that no networking problems exist:
7a From the command line of a remote server, make a network connection to the server 

where memcached is running. For example, you can use the telnet command.

telnet 172.17.2.3 11211
7b Type a simple memcached command, such as stats and stats settings.
7c After you have verified that memcached is running as expected, type quit to exit telnet.

Following is an example of what you see:

07309:~/Desktop # telnet xxx.xxx.xxx.xx 11211
Trying xxx.xxx.xxx.xx...
Connected to xxx.xxx.xxx.xx.
Escape character is '^]'.
stats
STAT pid 2486
STAT uptime 313
STAT time 1334337169
STAT version 1.2.6
STAT pointer_size 64
STAT rusage_user 0.028001
STAT rusage_system 0.000000
STAT curr_items 10
STAT total_items 17
STAT bytes 7971
STAT curr_connections 4
STAT total_connections 6
STAT connection_structures 5
STAT cmd_get 79
STAT cmd_set 17
STAT get_hits 62
STAT get_misses 17
STAT evictions 0
STAT bytes_read 14249
STAT bytes_written 67674
STAT limit_maxbytes 67108864
STAT threads 1
END
quit
Connection closed by foreign host.
07309:~/Desktop #

8 Continue with “Configuring Memcached in the Vibe Installation Program” on page 238.

Securing Memcached
Memcached was not designed for authentication and is protected only by firewalls and similar 
mechanisms.

Viable options include the following:

 Set up an SSL tunnel between memcached and instances of Tomcat.
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 Use SASL for authentication.
 Use the Lucene server’s firewall to allow access only from the Vibe servers that run Vibe 

Tomcat.
For example:

1. At the terminal prompt on the Lucene server, run the following command for each Vibe 
server that needs access:
iptables -A INPUT -s ip_of_allowed_server -p tcp --dport 11211 -j 
ACCEPT Where ip_of_allowed_server is the IP address of one of the Vibe servers needing 
access.
For example:
iptables -A INPUT -s 192.168.1.61 -p tcp --dport 11211 -j ACCEPT

2. Repeat Step 1 until all of the Vibe servers that need access are allowed to communicate 
through the Lucene server’s firewall.

3. Run the following command to block access by all other servers:
iptables -A INPUT -s 0.0.0.0/0 -p tcp --dport 11211 -j DROP

Configuring Memcached in the Vibe Installation Program
After you have installed and configured memcached, you need to configure the Vibe installation 
program to use memcached as the hibernate caching provider. For more information, see “Running 
the Linux Vibe Installation Program” on page 72.

Memcached Logging
To trace activities on the Vibe server that are related to memcached:

1 Navigate to the following directory: /opt/novell/teaming/luceneserver/
indexserver/lib

2 Open the log4j2.properties file in a text editor.
3 Uncomment the following lines in the log4j2.properties file:
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## Tracing of memcached
#logger.net_spy_memcached.name=net.spy.memcached
#logger.net_spy_memcached.level=DEBUG

#logger.net_rubyeye_xmemcached.name=net.rubyeye.xmemcached
#logger.net_rubyeye_xmemcached.level=DEBUG

#logger.com_googlecode_hibernate_memcached.name=com.googlecode.hiberna
te.memcached
#logger.com_googlecode_hibernate_memcached.level=DEBUG

#logger.com_novell_teaming_memcached.name=com.novell.teaming.memcached
#logger.com_novell_teaming_memcached.level=DEBUG

#logger.com_novell_teaming_hibernate_memcached.name=com.novell.teaming
.hibernate.memcached
#logger.com_novell_teaming_hibernate_memcached.level=DEBUG

#logger.com_novell_teaming_cache_memcached.name=com.novell.teaming.cac
he.memcached
#logger.com_novell_teaming_cache_memcached.level=DEBUG

4 Save and close the log4j2.properties file.
5 Restart the Vibe server.
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C CUsing MySQL 8 and Later with Vibe

MySQL 8 and later has password complexity enabled by default, which Vibe doesn’t support. 

The sections that follow replace Step 7 in “Configuring MySQL/MariaDB” on page 64 and provide 
basic help for disabling password complexity and setting a non-complex password. 

For complete MySQL information, including download and installation instructions, see the MySQL 
web site (https://www.mysql.com/).

Disabling Password Complexity in MySQL 8
On the server running MySQL 8, do the following:

1 Access a terminal prompt as the root user and enter the commands in the following steps.
2 View the temporary MySQL root password that the installation process set in the mysqld.log 

file, by entering the following command:
grep 'temporary password' /var/log/mysql/mysqld.log

3 Log in to MySQL.
mysql -uroot -ptemporary-password
where temporary-password is the password obtained in Step 2.

4 Change the system-generated temporary password to another password that satisfies the 
password-complexity requirements, such as MyNewPass4!.
ALTER USER 'root'@'localhost' IDENTIFIED BY 'MyNewPass4!';

5 Remove the password-complexity requirement.
UNINSTALL COMPONENT 'file://component_validate_password';

6 Change the password to a non-complex password.
ALTER USER 'root'@'localhost' IDENTIFIED BY 'new-password';

7 Change the MySQL Native Password as well.
ALTER USER 'root'@'localhost' IDENTIFIED WITH mysql_native_password BY 
'new-password';

Adding Access to a Separate MySQL 8 Database
If your MySQL 8 database is on a separate server from Vibe, you must also do the following:

1 Add access to the Database using the following commands:
CREATE USER 'root'@'%' IDENTIFIED BY 'new-password';
GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' WITH GRANT OPTION;
ALTER USER 'root'@'%' IDENTIFIED WITH mysql_native_password BY 'new-
password';
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Where to Go from Here
When you complete the application instructions in this section, continue with “Learning More about 
MySQL/MariaDB” on page 65.
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